Reinventing the Tattoo

Guy Aitchison
Part I
A History of Change

Despite its powerful potential, the art of tattooing really took a long time to find its place in the world. Hidden away in geographically isolated subcultures, tattooing idled away quietly for millennia, unaware of the wealth of artistic richness awaiting it just outside of its cultural isolation. Its almost mystical allure beckoned to travelers and traders, yet its taboo qualities and slightly intimidating methods were enough to keep it hidden away from all but the most daring for quite some time.

Eventually, Globalization won out over stagnation and tattooing found its way to the Western World, where a few innovators found ways of using electricity to drive a needle fast enough that it could be used as a pen. Within mere decades, they ironed out this process to an extent that images could be tattooed into the skin with great subtlety and accuracy.

Although there were precious few practitioners at the time that had any kind of artistic background before becoming tattooists, the few that did helped to formulate the essential principles of placement on the body, flow of design, etc. that the rest of the tattooists at the time adopted into the basic look of their work. The core of these design principles was largely borrowed from classic tattooing styles long in use in Japan and the Pacific islands, but to the tattooists of the Western World, these were new ideas. It was the beginning of a long process of discovery.

Several generations passed, and the craft was refined to the point where there were enough attractively tattooed people walking around in the world to support a number of publications which featured the latest styles in skin art. Inevitably, these magazines and books ended up in the hands of a more and more diverse assortment of artists, inspiring them and enabling many new styles of art to make their way onto skin. These innovators were able to meet and exchange ideas and techniques at tattoo conventions, which at this stage were becoming large and well-organized events.

Tattooing has become a full-fledged artistic medium, plugged into the Global Database and being applied with an endless variety of sophisticated techniques. Nurtured in an environment of economic prosperity, combined with the freedom of expression and a thriving subculture, tattooing has been experiencing what
is possibly one of the fastest and most explosive artistic renaissances in history. As we continue to mix and match our arts and technologies at a faster and faster pace, it is not difficult to envision even more exciting and innovative developments in the near future.

Currently, the state of the art of tattooing is such that basically any image can be tattooed on skin with almost photographic realism. Although these techniques are used mostly for portraits and wildlife tattoos, they can be applied to any kind of image. One of the few real limitations we’re facing now is in our understanding of what exactly makes a tattoo design successful, of what combination of elements will have the greatest visual impact while having the most flattering effect on the body that wears it.

With the wide variety of different styles being explored, it shouldn’t be hard for us to understand these limitations and use them to our advantage. Each style of tattooing has some particular artistic direction that it explores more closely than the other styles. Japanese tattooing has always been about flow and placement on the body. Traditional American tattooing explores the language of The Line, seeking ways of saying the most with the least. Tribal tattooing simplifies the equation and zeroes in on positive/negative relationships, that balance between the tattoo and the skin in between. Biomechanical and Organic tattooing place heavy emphasis on the illusion of depth in the design and placement. Black and grey tattooing explores the subtleties of the whole range from dark to light.

With the tattoo profession being gradually taken over by experienced artists, we’re seeing many modern illustrative styles being tattooed, from comic book art to futuristic computer-generated designs. Many classic painters, such as Van Gogh and Dali, are being painstakingly interpreted on skin alongside modern masters such as Alex Grey and H.R. Giger. In less than a century, tattooing has evolved to encompass every conceivable style of art.

Much of this was made possible by the technical evolution of the tattooing process. Before electricity, the ink had to be literally hammered in, leaving little opportunity for precision or subtlety. With the invention of the electric tattoo machine, all of the things we see in skin today were made possible.

If we look at enough books of tattoos in the early part of the century, we’ll occasionally see a portrait done with fine lines and delicate shading. This wasn’t the normal way of doing things at the time, though, and most of the work you see from back then is somewhat rough. A lot of this can be blamed on the art form’s ghetto status, which scared away most of the promising artists who may have otherwise been
attracted to it. This made it hard to get real-art prices for tattoos, which meant that pure quantity was the only way to keep a tattoo shop running. FAST was the name of the game, which kept the work simple and crude.

The new artistic ideal of slowing down and working more carefully has helped bring about all kinds of developments in machines, pigments, tubes and all sorts of other tattooing essentials. The modern tattoo machine, although basically unchanged for over 100 years, has been refined in many aspects and now can be tuned to puncture the skin in exactly the desired way. Ergonomics, the science of making equipment that fits the user, is now taken into consideration in everything from machine weight and the shape of the tube grip to modern massage tables and adjustable chairs, making both tattooist and client more comfortable.

Pigments have also evolved in exciting ways. Almost every color imaginable is now available from many different suppliers using numerous different kinds of pigment, many of them tried-and-true in skin for decades, others brand-new on the market, promising but without those years of having been used and proven. Many of these new pigments are thinner and much easier to use than traditional flake powder pigments, which not only make the job easier but also make possible sharper detail and more control over sublety. We use all these different pigments to mix our own custom colors, which make each artist’s palette unique.

Now that we have a limitless range of styles and designs to choose from and sophisticated equipment and pigments to apply them with, all we need is a better way of transferring our designs. In the old days we used acetate stencils, which made a very crude impression on the skin which could easily be wiped off prematurely. The breakthrough to using hectograph stencils solved many of these problems, making possible more sophisticated designs, including tattoos that take hours just for the outline. In the future we may see non-toxic, alcohol-soluble inkjet stencils in full color, allowing for an even broader tattoo vocabulary and easier, more intuitive ways of handling familiar tattoo subjects.

Despite all of these exhilarating developments, tattooing is not yet out of the ghetto. Popular culture has been painting an ugly and simple-minded picture of the craft for such a long time now that it’s become hard for the public to accept a new, improved tattoo trade. Unfortunately, this reputation is not totally undeserved, and the bad examples stand out much more than the good ones. If we want the reputation of tattooing to be cleared of this burden and truly embraced as a fine art, we need to accept the responsibility of not living down to these expectations, either artistically or
ethically, and encouraging an environment of growth and change amongst ourselves and other artists.

Many tattooists who have been established for a few years, especially those that own shops, are often somewhat cautious of accepting new ways of doing things. These artists often feel that what they know was learned through years of struggle, and they feel justified in not taking change lightly. Tattooists in this position are likely to have apprentices, who they will pass down their experiences to, for better or for worse. In many cases, these artists will have a very rigid method and will make the beginning artist’s use of that method one of the conditions of the apprenticeship.

Generally, this kind of method will have ironclad rules that must be followed, or it’s the End Of The World. Some of these rules may be helpful in keeping a new tattooist out of trouble for the first few weeks, but they stop being useful as the apprentice gains more experience, eventually becoming a burden. Some ancient wisdom says, ‘know the rules, so you can break them properly’. Anyone who really has a feel for what they’re doing doesn’t need rules to guide them; they just follow their intuition, letting experience be their guide.

An example of this is the ‘liner’ and ‘shader’ misunderstanding. We are normally taught that our small round needle groups are for lining and our larger rounds and magnums for shading and coloring. We are also shown a few basic movements of the hand which are kind of the Approved Tattoo Motions. Within this simple way of seeing it are the ingredients for clean outlines and shading, but nothing fancy or subtle. Often, this ‘approved’ way of applying the tattoo is so rigid that even an artist experienced in other mediums, and quite good at them, can never quite get the hang of tattooing. Many times you’ll meet a very talented individual who does beautiful work in pencil or paint, yet their tattooing is merely average, showing none of the fire that they demonstrate in their other chosen medium.

When a painter is using a variety of different sized paintbrushes, they are unlikely to think of the small brushes as ‘liners’ and the large ones as ‘shaders’. These names will only limit what the artist feels they can do with each tool. Instead, they are simply the ‘small brushes’ and the ‘large brushes’, and they are used interchangeably as the job requires. In this same manner, I encourage you to think of your needle groups as brushes, and refer to them by their description, not their traditional name. For instance, I normally use a three, a five round and a 7 magnum; I refer to them not as liners and shaders but as the three, the five and the mag, and I’ll switch freely between them while I work, just as I would with brushes. Nice and simple, and I’m not subliminally convincing myself that I’m only allowed to make lines with the three.

Another example of a tattoo technique myth is the notion that you must finish the
black first, then work the darkest colors, moving your way through the medium and light colors, finally finishing with the yellow and white. Common wisdom says that you can stain a fresh area of light color by spilling or wiping a dark color over it, so by working from dark to light, there's no risk of that happening. But does it need to be that ironclad?

My experience is that we can work the colors in whatever order we like, provided we're conscious not to stain the lighter colors. This is done by keeping the light colors protected with petroleum jelly and wiping the fresh dark colors away from the light ones that are already in the skin. It's easiest to move in a general dark-to-light direction, but we should give ourselves the flexibility to work with whatever colors we need to at any time. I often continue to work with black after many of the dark and medium colors have been put in. As long as we're aware that staining can happen and we do what's needed to prevent it, we have no need for these ironclad rules.

Now that I've started debunking much of what you've been taught, I think it's important for me to point out that nothing I have to say in this book is necessarily true, either. Just like all the stuff you've heard from other artists, these words are merely ideas to consider while doing your next tattoo. Don't be fooled by dogmatic systems of doing things; it's up to you to find the truth out for yourself, and to always be flexible when it comes to what you believe can and can't be done. Once you have the basic feel for the process, you need to begin questioning what you know and exploring what might be possible.

Throughout this book will be numerous illustrations and photos. In the interest of being able to print many photos yet keep the printing cost-effective, all photos in the main body of the text are in black and white. All illustrations and photos are identified by three digits: for example, Fig. 6.1.C. The first number indicates which part of the book, the middle number means which chapter in that part, and the last number means which illustration in that chapter. In this case, that would mean Part VI, Chapter 1, third illustration. Although most pictures are right on the page where they're discussed, occasionally you'll be referred back to a previous photo or illustration. Hopefully this system will make them easier to find.

Some of the Figure numbers are printed in boldface. This means that there's a color version of that photo in Appendix E. The picture is also in black and white on the same page as the text, for your convenience. But many of the images in the book really require color to get the point across.

For those of you with Internet access, all of these images are available in color at
our website, www.hyperspacestudios.com. There is a gallery there dedicated specifically to support for this book. Just click on the figure number, and it will come up in full color to supplement the B&W version in the book.

In the next part of this text, Part II, we'll be discussing a few important basic design ideas such as Flow and Fit on the body, Positive and Negative relationships, and the many kinds of Contrast, not only of dark and light but also of warm and cool, focus and out-of-focus, smooth and rough, flow and antiflow, and contrast of subjects.

We'll discuss Priority in a design, where we decide which parts of a design are the most important, and use graphic tricks to give them emphasis. We'll talk about Reserve, where we choose elements to withhold from the background so we can use them in the foreground, such as certain colors or white highlights. If we use every element in every part of a design, it can be hard to read, but if we Reserve some elements for only the foreground and others for only the background, the different layers of the design will be visually distinct from each other.

Next, we'll go on to talk a bit about the use of lines in a tattoo, and the distinction between a line and an edge. This includes a discussion of line weight and ways of building up lines; we'll also cover the techniques of greylining, bloodlining and lining in color. Just as important is when not to use lines, and how to execute a line-free tattoo. We'll also talk about the simulation of depth, texture and luminosity, which can give a tattoo extra dimension and life.

In Part III of the book, we'll discuss the idea of working in a second artistic medium, such as watercolors or oil paints, since having a second medium seems to keep the mind more limber and offers more technical freedom in tattooing. We will describe a number of mediums in some detail, compare them with the technical aspects of tattooing, and follow through with a brief oil painting tutorial.

Next, in Part IV we'll talk about using reference photos, both with tattooing and with our second medium, as a way of broadening your vocabulary and empowering our vision. We'll go into how to find the appropriate reference and how to photograph it and prepare it for the tattoo or painting. We'll then move on to making our own reference models and using computer tools to aid in the creation of our designs.

In Part V, we go into much more detail about using the computer for design and archiving purposes. We begin with a description of the hardware and what it costs, and what software to use. We'll then do a quick Photoshop tutorial, where we'll scan a couple of photos, resize them, crop them, balance their color, and lay them out on a page for printing purposes. We then use these same methods for more
sophisticated design manipulation, including the use of the models we built in Part IV. We describe how to transfer a design directly from your computer’s memory banks onto a hectograph stencil.

In Part VI of the book we’ll talk more specifically about tattooing technique, beginning with a chapter on Stenciling and Freehanding, then moving on to the various needle groups and their pros and cons. After that we’ll talk about machine setup a bit, stuff like power, stroke and spring tension, and how these things affect the ‘slap’ of the machine. An ideal setup should allow for more airbrush-like layering with the magnum and more pencil-like freedom with the rounds.

Next, we’ll talk about the Stretch; how experienced tattooists may tend to neglect the stretch almost as badly as a novice, and how we should feel the vibration of the needle striking the skin with our stretching hand. The more clearly we can feel it, the better our stretch is and the more ideal the penetration of the needle will be. Even though this is entry-level stuff that we pick up on the first day of our apprenticeships, it’s a thing that we always must remain conscious of, no matter how experienced we are, since it affects the outcome of a tattoo at least as much as the machines or the pigments.

A favorite topic of mine is Tightening, the act of going back into a piece with a small round needle group after finishing work with a larger group. This is a way of filling in corners, sharpening edges, adding detail, and cleaning up rough areas. Although this stage isn’t essential to being able to call a tattoo finished, I feel that it is not only an important step in giving our work a technical polish, but also one of the most fun parts of the job. We’ll discuss switching between machines often the way a painter might switch between brushes, and some of the new power units available that make this process easier.

Next we’ll talk about client comfort and why it’s advantageous to both us and our clients that they be comfortable. This is accomplished through body position, lighting, entertainment and atmosphere; also important is our style of body contact and handling of them, how we wipe them clean, and the way we handle the mental and emotional aspects of their comfort. We now have a few topical numbing gels available to us, which can make quite a difference if we use them carefully, so we’ll talk about these substances too.

Part VII will show a number of pieces in progress at various stages. We’ll talk about each stage and how we accomplished it, using which materials and techniques. We’ll use this opportunity to show examples of the many points we’ve discussed in action, and what makes the designs work. Finally, in Part VIII we’ll review many of the most frequently asked questions I get asked at seminars or over email, and hopefully debunk a few more tattoo myths.
It's not unusual for clients to request window-type designs, especially temple windows, stained glass windows and the like. The window is a great metaphor that can describe an opening to an inner world, making for a powerful element in the graphic language. Unfortunately, the average window design is locked into the Antiflow grid, making it appear awkward on the body.

In (Fig 2.1.L) I am asked to place a window at the top of the shoulder, which is a very natural place for someone to request such a thing. A window with straight sides would distort terribly here, looking different from front and back, appearing asymmetrical from a side view, and distorting even more with the normal movements of the arm. A good tattoo design should read well regardless of the position the body is in- one trademark of an Antiflow design is that the piece will look best when the wearer is standing in a stiff, military-like position, while not looking so hot when the collector is relaxed or in motion.

To accommodate this, we eliminate all straight lines from the design, replacing them instead with curving arcs. This way, the viewer is much less likely to notice that the piece doesn't look symmetrical. To further compensate, we use an asymmetrical design inside the window, and asymmetrical vines to either side of it which weave back and forth in front of the window, taking even more attention away from the structure. The finished result is one that has enough visual cues in the window's shape to be accepted by the viewer as symmetrical, while using several good tricks to distract from the fact that it isn't really a true mirror image.
Using these basic guidelines, it’s not hard to avoid the pitfalls of stiff or awkward designs. With a little consciousness applied to this idea, an artist’s vocabulary can be trained to automatically avoid stiff and unnatural flow in their compositions. Ultimately, though, the fit of a piece is something to be determined by the client. It must feel right to them, especially when it comes to the neckline/wrist/ankle interface between the tattoo and the skin, the weight and density of the piece, and the use of un tattooed skin in the design.

The comfort of the fit has the same kind of significance as the fit of an article of clothing; the person wearing it will naturally feel whether it sits right on the body, if it cuts across a body part in a way that’s uncomfortable visually, if it’s bottom heavy, or if it’s boxy where it needs to be curvy. The client’s intuitive feelings on the matter should NEVER come second to the tattooist’s ideas about what’s right. Although we can make suggestions and offer feedback, only they can truly know whether it fits them or not.

Regardless of how perfect the subject matter or color scheme is, regardless of how many grueling hours we may spend tweaking the details and refining the edges, regardless of who we are and how far our client has travelled to see us— the fit of the piece will ultimately determine whether the client is happy or not, and thus whether or not the piece is a success.
PART II

Design

2.1) Flow and Fit

When considering a new tattoo design, it's normal enough for client and artist alike to first consider the subject matter as being of primary importance. After this is decided, the layout and color scheme are worked out alongside the rest of the details. This approach tends to neglect the true importance of the flow and fit of the design, which is why it's not unusual to see a technically beautiful tattoo that doesn't flatter the body the way that it should.

The truth is, the flow and fit of a tattoo on the client's body can be as important, if not more important, than the actual subject matter of the piece. No matter how simple or trivial an idea for a design is, if it flatters the body, the client will most likely grow old happily with it. On the other hand, tattoo collectors I've spoken to who have the most serious issues with their tattoos almost always complain about it being too stiff, too dark, too high up, or cutting across a body part in a way that feels awkward to them; the complaint is rarely about the subject matter.

In a real sense, the flow and fit ARE part of the subject matter, since they determine so much about how a tattoo conveys its basic message. In fact, there are numerous styles of tattooing, most notably tribal and biomechanical, where the flow and fit are primary elements of the design. A poorly designed tribal tattoo, no matter how sharply executed, will always look awkward, while a good tribal design will look nice even if the points are dull and the edges a little wiggly; if the fit and flow are striking enough, these other weaknesses are scarcely noticed.

Here are some examples of tattoos where the flow and fit are the most important elements of the design. In the (Fig. 2.1 A) we have a strongly contrasting design with a smooth, simple flow. The light and dark areas are kept large enough that the flow of the design is clearly readable, even from a distance. Smaller details in the design are given less contrast than the larger shapes, as not to clutter the larger forms and distract from the strong flow. A heavy black shadow is placed under the large foreground shape, both giving it depth and supporting the readability of its flow. This piece is one that has always brought a strong response from people flipping through my portfolio, despite its apparent lack of subject matter.
In (Fig. 2.1.B) is a whole-arm design. A sleeve is always an exciting project for a tattooist; it’s even less common to get such a request from a female client. I believe that the feminine form calls for a lighter overall look, so we use plenty of open skin in the water to keep the tattoo from becoming too heavy. The water is used as an opportunity for flow, and cascades up and down the natural curves of the arm. The remaining elements in the design are brightly colored; if we had left areas of open skin in the hand and flames along with all the skin in the water, the piece would have appeared washy and insubstantial. Although the client already has a couple small tattoos on her forearm, we are able to incorporate them into the overall design in such a way that the entire arm still appears as one piece.

Next, in (Fig. 2.1.C), is a much larger tattoo covering a whole leg. With work of this scale, it’s of utmost importance that the flow of the body is not obstructed and the entire design remains in motion. You can see how the big curving spirals are placed on the largest bulges in the muscle structure, and the organic environment surrounding it takes advantage of the natural layout of the knee, ankle, and other parts of the leg. Just being shiny and colorful is not enough; flow is truly the key.
A good rule of thumb when designing fluid tattoos is the *Golden S-Curve Rule*, which basically accepts that the human body is made of curving, fluid forms that seem to follow an S-curve flow. The arms are not cylinders, for instance, and a rigid symmetrical design placed on an arm will look awkward, its symmetry struggling for dominance with the natural asymmetry of the arm. A circular design placed on the deltoid will tend to look egg-shaped, while that same design placed in the center of the chest or back could potentially fit quite nicely.
In (Fig. 2.1.D) we have a tree design, which follows the basic S-curve of the arm. It would have been easy to make the tree point straight up and down, as many real trees do, but this would have made the arm appear rigid. Since the tree is made of flowing organic shapes, it will wear nicely no matter what position the arm is in, and will look especially good while it is in motion. To make the most of the natural musculature, we place a strong curve of lower trunk along the bottom of the bicep, then follow through up the tricep and behind the deltoid, opening into the airiness of the branch structure at the top of the arm. Individual branches are placed where they take the most advantage of bulges and indentations. To balance out the heavy mass of the tree, we use light atmospheric affects in the background.

In (Fig. 2.1.E) we have a tattoo with many small elements, which can lead to clutter if we aren't careful. Since the movement of a design is especially important in a large tattoo such as a sleeve, we have to consider the flow first and foremost when creating the composition.

To start, we take an accurate tracing of her arm by wrapping tracing paper around it and marking the elbow, inner elbow, top of the shoulder (including marks where we have to overlap the paper to get it to wrap tightly), front and back armpit, and any visible muscle structure, such as where the deltoid ends and the tricep begins. After fixing the tracing down to a drawing board and placing a clean sheet of tracing paper over it, we experiment with the flow of the windy streamers that blow through the design. When we're happy with this aspect of the layout, we proceed to find homes for the remaining elements, which don't need to be in any particular position, as long as they look good. In this way, we're sure to have a flow we can be happy with, which would have been much harder to accomplish if we had laid out the fruits and vegetables first and then added the wind as an afterthought.

In (Fig. 2.1.F), we use several layers of S-curved elements to create a sense of depth. The central coil is the tightest, cleanest and most prominent curve in the design. The fact that it's clean and smooth helps us get away without using a black outline. The large fleshy pod thing is composed of a number of long flowing

Fig. 2.1.E

Fig. 2.1.F
S-curves, all which compliment the flow of the inner coil. The zipper things follow another curve, and the points of the teeth describe yet another. The twisty organic stuff and the bottom of the pod are large and readable, sitting on parts of the arm which take full advantage of its natural anatomy to strengthen the depth effect.

Part of the fun with the flow in this design are all the repetitions and graduations going on. The various teeth, spines and zipper flaps all follow the clean S-curves of the design, and they graduate as they repeat - that is, each one gets a little bigger until we get to the outer part of the curve, then smaller as we approach the other end of it. In the central coil, the spines get bigger and bigger until they culminate as the biggest, shiniest and brightest one at the coil’s tip. All of this rhythmic motion keeps the viewer’s eye zooming around the design, giving it life and energy.

These kind of repeated patterns are created using a careful construction drawing (Fig. 2.1.G). We start with long clean arcs, just to make sure our points flow the right way. Then we lay out the repetitions and graduations, spacing the peaks and valleys of the teeth in an even increasing and decreasing rhythm. The long clean
arcs make for a good skeleton on which to build our details, ensuring that we get the spacing and proportions of the details consistent and flowing the right way.

When we're happy with the whole layout, we begin adding detail, but if we start with detail before the layout is finalized, we may end up putting a lot of effort into an area of detail that we later end up having to erase and redraw a quarter inch over.

You can see in (Fig. 2.1.I) how the S-curving layout moves freely over the body, obstructing nothing, while the rigid gridlike layout tends to clamp down on and confine the body, especially on the feminine form. For future reference, we'll refer to these different modes of design logic as Flow and Antiflow. This does not necessarily mean to eliminate all evidence of Antiflow from our designs, however; it simply is a call to take it into account.

Flow and Antiflow can be balanced as contrasting design elements, the same way as light and dark can. There are styles of full-body tribal tattooing done in certain South Pacific islands (Fig. 2.1.H) that make use of a gridlike layout on the body, although there are plenty of carefully placed curves in these designs to offset the rigidness. The resulting look is very striking, although definitely a masculine look.
These principles can be used in more illustrative types of tattooing, as well. In (Fig 2.1.J), we have a design that calls for a rigid architectural form to be placed at the top of a shoulder. If we were to design the temple larger and place in the center of the arm with nothing breaking through it, we would have quite a stiff and awkward tattoo, which would distort in all kinds of strange ways when the collector moved his arm. To avoid this problem, we place the architectural form in the background and put an S-curving tree in the foreground. The tree is made to stand out by giving it a strong outline and sharp contrast, while the temple is rendered with less contrast and no outline. The temple ends up small enough and broken in enough places by foreground elements that the overall look has none of the awkwardness that a purely Antiflow design would have on this body part.

In (Fig 2.1.K) we have another architectural element, this time broken in the foreground by flowing water. Try picturing how the design would look if the columns on either side were continued onto the outside of the arm instead of disappearing behind water. You can well imagine how they could create a visual corset, restricting flow through the arm and making the piece appear rigid and confining. We end up using just the right amount of the window structure in the design to get its point across without taking over the arm with Antiflow.
2.2) Positive / Negative Relationships

When we see a tattoo, especially from a distance or in low light, the first thing we notice is that tattoo's silhouettes. The silhouette is essentially the relationship of the dark areas against the lighter and un-tattooed areas, including the surrounding un-tattooed skin. A strong silhouette will reveal clearly the flow and fit of the design, as well as the identity of the different elements in the subject matter. It will give the piece strength not only from a distance, but also through decades of aging and settling. A clear silhouette is at least as crucial to the success of a piece as its flow and fit.

Fig. 2.2.A

The silhouette is determined by the use of tattooed vs non-tattooed skin in the piece, the use of light vs dark tones, and the incorporation of a clearly readable flow with large, open areas of dark and light. Not only should the tattoo have a clear and pleasing relationship with the surrounding skin, but the elements within it should contrast each other so that they don't run together and create chaos. We avoid this problem by paying close attention to our positive/negative relationships.
You've probably heard the term 'negative space', which refers to un-tattooed areas of skin flowing through a design, such as the wind effect in the fruit-and-vegetable sleeve we were discussing earlier. Negative space is often used as a way of introducing flow into a design that is otherwise not very fluid, and is normally used in a way that takes the flow of that body part into account. We'll take this description a step further by describing all light-colored shapes and areas as Negative, and dark ones as Positive.

A Positive/ Negative Relationship is a relative thing involving two adjoining shapes, such as a figure in the foreground and a forest in the background. If the figure is mostly light colors and the forest is mostly dark, we say that the figure has a negative on positive relationship, or Neg on Pos (Fig. 2.2.A). However, if the same figure is colored darker and the forest is rendered in lighter tones, we'll say that the figure has a positive on negative relationship, or Pos on Neg (Fig. 2.2.B). As long as the relationship between these two elements is either neg on pos or pos on neg, the design will be clearly readable. But if we color the figure dark over a dark background we'll get a Pos on Pos relationship, which makes for a dark, dense and less readable tattoo.

Similarly, a Neg on Neg relationship often will look weak and underdeveloped, also detracting from the clarity of the piece. Using an outline to separate foreground from background can be helpful, but without a clear pos/neg relationship, the piece is likely to look washed out and potentially hard to read. Since the outline alone doesn't give the piece clarity from across the street, the strength of the silhouette is of great importance.

Tribal tattooing is the simplest example of a pos on neg relationship. Since its interaction with the skin is so simple, either solid black or no pigment at all, its silhouette will be the most easily readable of any style of design. We give up
some of this instant readability when we use more complex design motifs, but we always want to consider the silhouette and keep it as simple and clear as possible, regardless of subject.

In (Fig. 2.2.C), we have an example of a simple pos on neg relationship, where the entire design is contained inside its outlines and no background is used. A dark atmospheric background would have given the spine a neg on pos relationship, pushing it into the foreground, but the atmospheric background would then create a pos on neg relationship with the skin around it, making it look like a big bruise or forcing us to work out some clever way of breaking it off. By using a simple pos on neg relationship, the overall flow of the spine is bold and clearly readable, despite the wealth of detail in the rendering.

In (Fig. 2.2.D) we have a more complex pos on neg relationship, where the butterfly is done in darker tones, silhouetting it against the stained glass and light rays behind it. We use no color in the background immediately behind the butterfly, which would confuse the pos on neg relationship and made it hard to read; instead, we let
the background colors get softer and drop out to skin and white around the edge of the butterfly. No dark colors or black are used in the window area, allowing those dark tones in the butterfly to leap out. To create further separation, we’ve added light rays radiating from behind the butterfly, which creates a luminous layer between the strongly contrasting foreground shape and the soft window area behind it.

Negative on positive relationships are just as strong and clear as pos on neg ones, although with different effect and feeling. A neg on pos foreground shape will jump forward from its darker background in a way that is often more effective in creating an illusion of depth than a pos on neg relationship. In (Fig. 2.2.E) we have a clear and simple example of neg on pos, with heavy shadows pushing the hook forward and making it clearly readable; details within this shape are kept simple and light, as not to compromise the strength of its neg on pos relationship. In any areas where the background isn’t significantly darker than the foreground, a bold black outline ensures the clarity.

We have a different example of neg on pos relationships with (Fig. 2.2.F). Since this shape is complex and subtle at the same time, we wanted to keep its pos/neg relationships simple, opting for a strong neg on pos situation using mostly yellow and white within the flying shape, keeping its details small and light. Then, the corona of fire around it, which has its own neg on pos relationship with the predominantly dark background, fades to dark red around the negative silhouette of the flying shape. This clearly defined relationship allows us to complete this shape without an outline, which would have compromised the look that we were trying to achieve.
In (Fig. 2.2.G), we have many examples of pos/neg relationships. The flower, on a whole, has a clear neg on pos relationship with its background. Each petal, in turn, has a neg on pos relationship with the other petals that it overlaps, until you get to the smallest, innermost ring of petals, which have a pos on neg relationship with the glow around the central gemstone. The gemstone also has a clear pos on neg relationship with that glow, making it stand out clearly. Wherever possible, we avoid pos on pos/ neg on neg relationships, keeping the piece readable. With the larger petals, this readability is assisted by a strong outline.

An object and its background can also have more complex pos/neg relationships. With (Fig. 2.2.H), we have a piece where we weren't comfortable with a simple pos on neg relationship, which would have meant an overall too-dark appearance for the foreground shapes, or neg on pos, which probably would have made the whole piece too dense. Instead, we opted for a dynamic pos/neg relationship, where the undersides of forms in the foreground are shaded dark, creating a pos on neg relationship,
and the upper sides of these forms are highlit in light colors and a darker background pulled behind them, giving these upper parts a clear neg on pos readability. Without that background, these highlit areas would have had a neg on neg relationship, making the piece look unfinished.

To make this dynamic relationship possible, the background needs to take into account the needs of the foreground. First, we finish the black and darker colors in the foreground shape, and finish making all decisions about its shading. The background is then applied using mostly medium and light tones. This color is pulled up against the outline of the highlit upper parts of the foreground shape, establishing a strong neg on pos relationship, with the darkest tones closest to the outline. In other parts of the background, the color is applied lighter and lighter as we get closer to the shaded underparts of the piece, leaving them a strong pos on neg. Throughout this process, the background is kept smooth and simple in such a way that doesn’t compete with the foreground.

In (Fig. 2.2.I), we have the same figure in the woods we saw earlier, except this time we’re using a dynamic pos/neg relationship. The upper parts of the figure, which are lit
brightly by the sun above, look bright because of the deep tones immediately behind them. The undersides of each major shape are then brought to a deep shadow against the edge; wherever this happens, the background is made to drop out, allowing the deep tones in the figure to stand bold and clear. The light and dark areas of the background are made to merge smoothly together, drawing attention away from the fluctuations in value, keeping the figure focused and in the foreground.

In Salvador Dali's *Atomic Leta* (I'd show you, but I don't have the legal rights— if you don't already own a Dali book, you need one!) we have a masterful example of a dynamic pos/neg relationship. In the foreground is a nude figure floating in space, lit with a strong, bright light source, giving her some brightly lit areas and some areas in dark shadow. Behind the figure is a blue lagoon, rendered in mostly simple, flat tones as not to compete with the foreground. As this blue field gets closer to the brightly lit parts of the figure, it gets darker; by the time it disappears behind the figure, it's about twice as dark as the surrounding ambient blue. Similarly, the blue areas that disappear behind the heavily shaded parts of the figure fade to a lighter blue, strengthening these areas' pos on neg relationship. The resulting
2.3) Contrast

Contrast is what makes different parts of a design stand out from each other. Whenever two elements are different from each other in any way, they will contrast each other visually. One of the goals of the artist is to make use of contrast in just the right way to make the statement they are after; sometimes bold contrast is just the right tool, making the message scream out in every way possible, where other times subtlety is the key.

To make our statement we have a variety of different aspects of a design to contrast against each other: dark and light, warm and cool, focus and out-of-focus, smooth and rough, flow and antiflow, and even subject matter can be used as contrasting elements to establish a Dynamic Range and maximize a design.

The most basic element of contrast is Value, or the contrast of dark and light. The more dynamic range an individual design element has within it, the more it will jump forward, just as an element with less range will tend to fall into the background. For the purpose of this discussion, we’ll refer to white as zero and black as 100; all other colors and tones are in between.

For example, let’s flip back to the shoulder design with the tree and the temple in (Fig. 2.1.J). The tree, which needs to jump forward as much as possible without the assistance of bright colors, uses the full value range, all the way from the black outline and details to the white highlights, giving it a total dynamic value range of 100. The temple in the background, on the other hand, is rendered using no outline, grey wash instead of black, and no colors darker than 60. No white highlights are used in it either, knocking its dynamic range down another five points or so to a total of about 55, compared to the 100 of the tree. This way, it’s clearly in the distance, the same way that mountain ranges in real life appear to have less and less contrast as they get further away.

We use similar contrast methods in (Fig. 2.3.A). The foreground shapes, which need to stand out, are given a bold outline and a value range of 100, using plenty of black and deep

Fig. 2.3.A
textured shapes are much cooler than the lavender cools on the undersides of the smooth stuff, keeping them distinct from each other. Simulated shadows are cast by the smooth struts as they pass over the bumpy background, spelling out for the eye exactly what simulated distance there is between them. The knuckles are rendered in such a way that the parts that will naturally heal light are meant to be light in the design, anyway.

(Fig. 2.3.N) is seething with texture from top to bottom. We are able to get away with this, however, through our use of large areas of dark, where the textured bumps are all in shadow with no colors lighter than 50, and large areas of light, where the bumps are of all light colors, with the shading going no darker than 50. The resulting piece has a readily readable overall silhouette. Waves crash in from the sides following strong flowing movements, described in a clean neg-on-pos relationship.
The textures in the face are contrasted by the smooth and shiny crown, which is otherwise essentially the same color scheme, as if the elements through the years have tarnished them equally. The clean movement of the edge of the crown helps to make it distinct from the stony texture of the face. The eyes, on the other hand, are given an entirely different texture in a completely different color scheme. The tiny spots in the eyes bring focus to them, while the big clear white highlights make them appear smooth and wet.

I've only scratched the surface of the world of textures here; we also have leafy textures and viny textures, fleshy textures and hairy textures, scaly and finny textures, fiery and watery textures, just for starters. Each have their own attributes, their own distinct silhouettes, and their own complementary opposites. All of them can add visual excitement to a tattoo.
colors to compliment the yellow and white highlights. The background is kept much softer with a total range of about 35. Wherever possible we give the foreground shapes a clear pos on neg relationship on their undersides and a neg on pos one on the top parts; anywhere we can't do this, the black outline picks up the tab.

Colors have contrast too. In art school lingo, we have our warm colors and our cool colors; warm colors consist of the yellows, oranges and reds, which are normally associated with fire and heat, plus the yellow greens and redder purples. Cools consist of blues and blue greens, normally associated with water and ice, plus the bluest purples. Warm and cool colors contrast each other naturally; warm and cool relationships of neighboring design elements need to be considered in the same way that pos/ neg relationships do.

On Appendix E we have a Color Wheel, which artists and teachers have used for many years to help themselves and their students understand color relationships better. Circling around the wheel is the full spectrum of colors in their natural order. When we draw a line straight through the center of the wheel, the two ends of the line will point to the two colors opposite each other.

Whenever two colors are exactly opposite on the color wheel, they are known as Complementary Colors. When two colors are complementary, they have the maximum contrast of color available in the whole color wheel, so that when these colors are used in neighboring design elements, they pop out from each other. These pairs of color include blue vs orange, purple vs yellow, and red vs green.

In (Fig. 2.3.B) we have a simple and effective use of complementary colors. The water is done in blue with tiny amounts of blue-green; the koi is colored in bright orange and yellow. The orange naturally jumps forward from the blue, making it distinct and 3-dimensional. It seems that warm colors appear to jump forward from cool colors more so than the other way around; a blue foreground object with fire behind it may be less 3D than

Fig. 2.3.B
the warm-on-cool relationship of this carp design. (This is only my own superstition, by the way—both approaches are valid!) But in general, we can say that warm colors tend to jump forward, while cool colors drop back.

We can use this kind of relationship not only between a foreground object and its background, but between the upper side of an object and its lower side, or the inside of an object and its outside edges. In (Fig. 2.3.C) we have a brightly colored lizard with an organic environment around it. We color the upper surfaces of the lizard in oranges, yellows and reds, which are the warmest colors, and color its undersides in blues and purples, causing these areas to drop back and curve away, giving its overall form more dimension. The organic background objects are colored green on the top and blue on the bottom, making it appear 3-dimensional, but no yellow and white are used, giving it less color and value range than the lizard and keeping the different elements from competing.

Look closely at how the tail contrasts the background. The black outline and shading plus the white highlights in the tail give it a value range of 100; the primary blue vs the bright yellow and orange give it the full color range, also 100. So if we add up the color and value contrast in the tail, we’ve got a dynamic range of 200. On the other hand, the elements behind the tail neither rise to the zero of white or sink to the depths of black; their value range is around 60. The green and blue are warm and cool compared to each other, but still have no more contrast than about 40 (if a trip halfway around the color wheel is 100, a trip a quarter of the way around is 50, and so on). This gives the background a dynamic range of 100, or about half that of the tail.

If we glance back to (Fig. 2.3.B), we see how this trick is used in a similar way to give the koi depth. Although pink is a warmer color than the blue water surrounding the fish, it is a cooler color than the oranges and yellows in the center of the koi; by using it around the edges of this foreground object, it causes those edges to drop
back, giving the whole form a sense of curvature and dimension. If we had used blue for this part of the job, it would have caused the edges of the fish to merge with the background, and robbed it of some of its clarity. Pink is also used around the edge of the lizard's eye, to a similar effect.

The tree in (Fig. 2.1.D) uses a similar warm-on-top, cool-on-bottom logic as these, but with more subtlety. The design is meant to have a naturalistic feel to its color scheme, so we avoid using bright yellows or primary blue. Instead, we use a whole range of browns and earth tones, mixing in blues and cooler browns on the under-sides of the shapes.

One nice by-product of using contrasting colors is that not only will the different elements remain distinct from each other and show an illusion of dimension, but the overall piece ends up more visually striking.

---

When we view the world with our eyes, we focus them on whatever subject we're paying attention to. When we do this, everything else drops out of focus, becoming blurry. Similarly, when we use a camera, we focus the lens on the important central object before taking the picture; all other elements in the shot are focused to a lesser degree. There is a great metaphor here, in that what we focus on tends to be the most important, whether we're talking about a design element or an aspect of our daily lives, such as going to school or pursuing painting. With this analogy in mind, we want to use focus to bring attention to the important elements of a tattoo design.

Focus works the best when we have out-of-focus elements to contrast the sharply focused ones. In (Fig. 2.3.D - 2.3.E), we have two very similar shots of the same subject, with one of the shots all in focus, the other only focusing on the foreground element, allowing the other objects in the picture to blur. The one that's all in focus tends toward busyness, with every detail in the shot having an equal amount of detail, competing with the central object. The other one, although compositionally almost identical, is much more clearly readable, with the less important elements being allowed to drop out of focus.

We achieve focus and out-of-focus effects by using sharp edges vs fuzzy edges, high contrast vs low contrast and sharp detail vs no detail. I've been practicing focus tricks as much as possible in my paintings. In (Fig. 2.4.A) we have a relatively simple composition with only parts of it in sharp focus. We achieve this by first photographing the object, then duplicating the image on canvas, using the photo as a guide. We use a projector to trace the photo onto the canvas with colored pencil,
then keep the photo taped up to the easel so we can refer to it continuously as we
paint. One thing that seems to help the effect more than anything else is to use differ-
ent sized brushes. In the focused areas, we use the smallest brushes, naturally cre-
ating the tightest detail. As we move outward into less focused areas, we switch to
larger and larger brushes. In these blurry areas, we refrain from using any small
brushes at all, as not to spoil the effect.

Let's look at a closeup shot of the tree piece we discussed earlier and zoom in on the branch-
es, where you'll see an example of the use of focus (Fig. 2.3.F). The smallest twigs of the
branches, instead of getting tinier and tinier like hair (and creating a messy look), are rendered
with a 7 mag, using loose looping movements to create soft edges. A five round is then used to
unite the soft twigs with their more focused branches. In a few places, out-of-focus twigs are
made to pass behind the focused branches in
front of them, creating depth while still keeping the upper part of the design light and minimal, as per the client’s request.

In (Fig. 2.3.G) we have another example of the use of focus. The edges of the important shapes are given sharp definition and strong value contrast, while the simple areas of the face and most of the background are given less contrast and softer edges. We use a 7 mag for most of these softer areas and most of the facial features, using light, looping movements to keep the edges soft. Then we switch to a 5 round to sharpen the edges of the rays and add detail to the facial features, giving the most value range to the eyes, nose and mouth, creating the sharpest focus there and making the features stand out from the rest of the design.

There are also many examples of atmospheric effects in this book which are kept out of focus with blurry edges to help emphasize the main subject of the piece. The wind on the fruit and vegetable sleeve is an example of an unfocused element passing in front of focused ones; the atmosphere behind the trees in both (Fig. 2.1.D) and (Fig. 2.1.J) show the focused element in front of the blurry background. Both strategies have their time and place.

Textures are also good tools to express contrast; objects with different textures will stand out from each other as surely as if they were different colors. A smooth, shiny object will stand out in a bumpy, pitted environment; similarly, a rough, bumpy object will leap forward from a smooth, shiny background. Smooth and rough elements can also be balanced equally, as in (Fig. 2.3.H). Other textures besides smooth and bumpy exist as well, such as the repeated patterns in biomech designs or the veiny patterns in the red cabbage on that fruit-and-vegetable sleeve. With a little imagination, we can concoct a whole spectrum of different textures to play against each other.
If we want textures to really contrast each other, they each need to have a different basic silhouette—when we blur our eyes and look at them, their differences should be clearly visible. Smooth textures are more open and have less detail; they will contrast a bumpy, more detailed texture in a similar sense that an out-of-focus area will contrast a focused object. Although bumpy organic textures and biomechanical textures may have similar amounts of detail to each other, the detail is organized so differently in these two subjects that their silhouettes are distinctly different, the one being fluid and random, the other being more rigid and repetitive. That veiny pattern on the cabbage has yet another distinctly different silhouette. However, the difference in contrast between textures is always greater if one of them is smooth and open, the other tight and detailed.

The range of contrast between different textures will have a lot to do with how great the difference there is in the amount of detail in one texture vs the other. If we were to make a texture wheel similar to our color wheel, the most densely detailed texture would be opposite the smoothest texture, with a whole range of density of detail in between (Fig. 2.3.I). This represents yet another dynamic range of 100 to add to the ranges of value, color and focus.

In (Fig. 2.3.J) we have a simple tattoo with a single foreground object and a background texture. The shell in the foreground is smooth and shiny, so it contrasts the bumpy texture in the background. We made it appear slick and shiny by giving it a sharp, clean curving black outline and a long, smooth white highlight down the center. In real life, smooth shiny objects will often show highlights like these. We put a polka-dot pattern in the shell to make it more interesting, but kept the edges of the spots soft and out of focus, as not to compete with the smoothness of the white highlights. Smaller, sharper white highlights are put in the bumpy ridge spiralling around the crown of the shell to make it appear glossier.
Between its black outlines and white highlights, the shell has a dynamic value range of 100, while the bumpy background was kept subdued to around 60. The range of colors is at least another 60, plus another 80 for the difference in textures, totalling a dynamic 200.

(Fig. 2.3.K) is another example of smooth vs bumpy; in this case there are several holes in the smooth foreground skull, revealing areas of bumpy pattern through them. The bumpy pattern was given a radiating flow which continues from one hole to the next, giving this background continuity. We used green in the bumpy pattern and orange in the skull to separate them from each other.
In (Fig. 2.3.L) we have several different textures. The petals of the lotus are smooth and shiny, with warms on their upper areas and cools underneath to give them form and volume. The gemstone in the center is sharp and faceted, made all of straight lines and angular corners; these features contrast the smooth gradations and flowing arcs of the petals. A glow around the tip of the gemstone brings the point forward, while the directional movement of the rays brings more attention to it. The leaves in the background are made of long, simple arcs that fit the shoulder nicely; the pattern inside them is small and random, complementing the simplicity of the outline of the leaves and contrasting the textures of the flower petals and the gemstone.

In (Fig. 2.3.M) is a piece with two distinctly contrasting textures, smooth and rough. I tried to give these different elements 50-50 priority, letting them share the hand equally. The smooth stuff is given clean, sharp black outlines and long, clear highlights which stand out resolutely in front of the chaotic texture in the green stuff. Both textures use the warm above/cool below logic, but the blue-green cools on the
As we talked about earlier, flow and antiflow can be used as contrasting design elements, potentially giving us another dynamic range of 100 on top of all the others. Subject matter can be used as a contrasting element as well, giving us a total dynamic potential of 600 if we choose to use all of these elements. Let's look back at the water sleeve with the hand in (Fig. 2.1.B). For starters, the water is kept to less than 40 on the value scale while the hand uses the full range of 100, separating them by 60 points. Their color schemes are strongly contrasting complementary colors, using the whole range of 100- we're now up to 160.

The edges of the water are slightly less focused than the edges of the black outlines and the flames, dropping back another 10 points or so; a detailed frothy texture is wrapped around the bottom of the wrist, contrasting the simple openness of the wrist and hand for another 35 points. Finally, there's a strong contrast of subject matter here- what could be more opposite than fire and water? - bringing us up to around 300, a potent dynamic range.

If we move to the inner part of the arm, shown in (Fig. 2.1.K), we lose a small amount of range in the subject matter department, but not much- water and architecture contrast each other quite a bit subject-wise, so let's knock it down to 275. On the other hand, we now have a potent flow-antiflow juxtaposition going on here, adding another 75 points and bringing us up to 350. As the collector moves her arm around, we see many contrasting elements, but even a brief glimpse of the gridlike architecture between the crashing waves jumps out and demands a closer look.

Honestly, I don't go through my tattoos rating their dynamic range point-by-point; this rating system is really just a tool for discussing and understanding the use of dynamic range, a way of illustrating how these things can add up. We have a wide variety of graphic tools at our disposal, including countless examples that I haven't listed here; one of the great pleasures of tattoo design is in finding ways of combining these tools for different effects. The Dynamic Range is a way of measuring in our minds the kind of effect we're achieving, whether it be powerful or subtle.

2.4) Priority

When we create a complex tattoo design, such as a scene, we have the added challenge of keeping the tattoo from becoming chaotic and hard to read. No matter how large the area of skin is, too many competing elements can spell disaster for a composition. Narrowing down the number of elements sometimes can help, but this isn't always appropriate for telling the graphic story the right way; sometimes we just can't avoid a certain amount of complexity.
The trick is to have all of our elements working in harmony, not in competition. To accomplish this, we must first ask ourselves which design elements are the most important in the composition, then the order of importance of the remaining elements. By doing this, we are assigning priority to each element, which will help us make decisions about how to approach each part; the top-priority elements will be made to stand out the most, while other elements will demand less attention and drop back.

There are many ways of expressing priority; perhaps the oldest and most commonly used of these is the outline. The thickness of the line is a simple and effective way of assigning priority, where the object with the boldest line will stand out the most. Less important elements get a thinner line, and background detail has no black lining at all. Bold lines need to be used carefully; if too many elements have fat lines, they stop being an effective way of assigning priority and we can get a cluttered look.

Similarly, a lot of small detail with black lines can get pretty dense and messy, clogging up the design and threatening to close up with age. With just the right balance of fat, medium and thin lines, a tattoo should begin reading clearly before any shading or color is even applied. There will be a more detailed discussion on lining and rendering details without lines in chapter 2.6.

The techniques we talked about in the section on dynamic range are all effective ways of assigning priority; the most important elements get the greatest use of dynamic range, while the background is the most subdued. (Fig. 2.4.A) uses many of these tricks. The features in the face have the greatest range of contrast, with sharp details of black and white right next to each other. The rest of the body has less value contrast, the background even less. The eyes are very contrasting, with sharp white highlights interacting with the black pupils. The white highlights in the face and body are softer-edged and contrast their surrounding colors less, commanding less attention than the eyes.

The cool green of the eyes contrasts the surrounding orange by 100 points, giving it the maximum color contrast on top of having the maximum value contrast. Color also brings the cat forward from the background, a strong warm-on-cool complement. A pink edge on the undersides of the legs, body and cheeks makes these areas curve back from the warmer orange on the upper sides of these shapes.

Directional design elements, such as light rays, also direct the attention of the viewer's eye, giving priority to whatever shape these elements point in towards. The background around the cat has radiating rays of blue and green pointing in towards it; we also use rays for this purpose in (Fig. 2.3.L) and (Fig. 2.2.D). Other
elements direct attention too; the whiskers and the stripes on the forehead bring attention to the center of the face. Another radiating shape, the starburst medallion, balances out the face and adds character to the cat, while still having less range of color than the face.

The outline around the periphery of the cat is the thickest, making it clean and readable against all the active movement of the background. This outline is made shaggy, like a fur coat, by zig-zagging a 3 or 5 round needle group back and forth in a scribbling rhythm as we move along the stencil (Fig. 2.4.B). Lines around the medallion, eyes and mouth are almost as thick, giving these features priority. No lines or black are used in the background or the stripes, since this would clutter the design and make it appear dark.

In (Fig. 2.4.C), the story that this tattoo tells calls for a whole crowd of characters, which could easily become chaotic. We have a whole scene going on with many elements: the main figure, the cave environment, the shackles, the gate, the archway and its contents, the fire, and dozens of little fellers in armor, waving weapons around. Consideration of priority in this piece is super important.
The figure is obviously the most important element in the design, so we make it as large as we can without crowding the details above and below it or losing the figure as it wraps around the arm. It is given the fattest outline in the whole tattoo, plus long flowing black hair, which reads in a similar graphic way to the boldness of the outline. We also give it the full value range, using large flowing areas of white alongside heavily contrasting areas of dark color and black shading which we can clearly read, even with our eyes blurred. This strong, clear, contrasting readability is a great way to give this element priority.
A row of light rays streaks between the figure and the background, lifting the figure even more to the forefront. The rays are simple and open, mostly untattooed skin; a fringe of more untattooed skin traces most of the way around the outside of the figure as well. Since untattooed skin reflects light differently than tattooed skin, it is important when defining the silhouette of a design; this fringe of skin around the figure adds to its readability. Because of this reflective quality, the rays and the outline of the figure are clearly readable from a distance, giving the design a distinct direction despite all of its detail.

The rays converge in the top of an archway. Since the rays are such a dominant directional element in the design, they bring a lot of attention to this archway, giving it second priority. This is just as well, since the arch is indeed of secondary importance, since it is where the figure is going. We keep the details inside the arch under 60% contrast, so that they drop back, but still use bright oranges and yellows, to contrast the surrounding stone and make the arch appear to glow.

On the back of the hand is a pair of shackles. The fact that the figure is leaving them behind is clear in the figure's body language, but the largest ray of light lands on them, bringing attention to them. Between the use of the ray and the placement on the hand, we give this element in the story a clear third priority, even though the shackles are graphically simple.

The small figures are an important part of the story but a big risk of clutter; we address this by making them swarm in several simple movements across the arm. By overlapping them in these simple movements and coloring them all the same, we merge them into a few directional shapes, controlling the chaos. Bright yellow and orange flames are used between these movements to contrast them and give them more overall clarity; the flames are done with no outline, as not to compete with other things and keep them from closing up.

Almost any design with more than one element needs to have the priority of its elements considered; it's a simple step which can mean the difference between creating a strong design, or a tattoo that looks well-rendered up close, but like a third-degree burn from a distance.
2.5) Reserve

When defining priority, we use our tools in each design element to a greater or lesser degree, depending on the importance of that object. We can also hold back a few tricks, using some for only the background, and holding others in reserve for only the foreground. If each element has something that the other elements don’t have, all elements will be more distinct; if we reserve the brightest colors and most eye-popping textures for the most important object, it will have top priority.

Let’s consider a hypothetical tattoo both with and without the use of reserve. We’ve all seen this hypothetical tattoo; dozens of artists have done and published something along these lines. I’m talking about your basic carp-and-water design, with all the design elements where they should be: good flow of the carp, good color contrast from the warms in the fish to the cools in the water, nice crashing finger waves in a good layout for the body part, maybe a couple of cherry blossoms in a different color than the carp. Now what will make or break this design is the use of white.

Big shiny white highlights look great in a carp tattoo; if used in the right places they will make the fish look glossy and 3-dimensional. Unfortunately, many artists don’t stop there, and continue to put white highlights in the water as well. Considering the waves individually, it might make sense to do this, since it helps to establish the depth of the waves by using the whole value range. However, this ends up cancelling out the white in the carp, reducing its priority. White highlights contribute the most to a design when we use them selectively, instead of all over. The same goes for color, texture or any other design tool.

(Fig. 2.5.A) is a simple example
of the use of reserve; bright yellow and orange are used in the upper coil only; nowhere else gets warmer than a lime green. This yellow and orange is placed in front of an area of primary blue, bringing its color range to 100, while the rest of the design has less range. We also reserve our biggest, smoothest white highlight for the most prominent part of the coil. Shadows under the points lift them up. Finally, the fattest line is reserved for the around the orange coil, while all other lines are thinner.

(Fig. 2.5.B) is a similar composition, but much more complex. We have two different basic elements, an organic element and a crystalline element, which weave around and between each other. With all of these different movements going on, it's important to keep the elements separate and readable.

Since the two elements are of essentially equal priority, the goal is to separate them by making them as different as possible, rather than making one more important than the other. For starters, we reserve all black, including bold outlines, for the organic stuff; the crystal structure has no black and no outlines. All greens and blues are used in the organic environment, with none of either in the crystal. Similarly, all reds, oranges and pinks are found in the crystal only.

Although there are some small white highlights layered on top of the organic stuff to sharpen the texture, all true white is in the crystal; these highlights and always rendered in sharp, clear areas, as opposed to the bumpy and minimal way the white is used in the green. Last but not least, the angular, shiny crystal facets contrast the
bumpiness of the organic stuff; just blur your eyes and you'll see a difference in the silhouettes of these two textures.

(Fig. 2.5.C) has a few major design elements which need to interact constructively. This client has requested a lava lamp, which we make flowing and organic instead of the straight, rigid way that lava lamps really are. The curve of this shape follows the natural curve of the arm and is reinforced by giving it a strong, clean black outline and bringing heavy black shading and dark color behind it, giving it a strong neg on pos relationship. For this shape we have reserved primary yellow and bright orange; although you'll find hints of these colors elsewhere in the design, only the lava lamp has any strong concentrations of it. We also give it the biggest, cleanest white highlights which jump forward from the smaller and softer highlights in the rest of the tattoo.

To make it appear as if behind glass, we use no outline on the globular lava, which would make it compete with the lamp itself. Instead, the lava is given strong priority
by reserving primary red for it. The fleshy areas to the right of the lava lamp use magentas and pinks, but little or no primary red, which is a stronger color than magenta. We avoid bringing the background orange right up to the lava, since that would decrease their pos on neg strength; we leave a fringe of bright yellow around the lava wherever possible. The lava jumps out from the orange and yellow areas behind it partly because of the bright blue on the underside of each glob, which contrasts the bright warm colors and gives each glob more dimension.

We use the warm/cool thing to create depth throughout the design. The edges of the lava lamp are colored pink, which is cooler than yellow and orange, causing the edges to curve back. The fleshy stuff is lit up by the lava lamp, so all of the fleshy details pointing towards the lamp are bright warms, while the areas pointing away are in blues and purples. The ribs on the right of the design are also lit by the lava lamp, using the warm/cool logic.

For the ribs we have reserved brown, which is not as bright a color as the orange in the lamp but is unique in the design, making it stand out. The flow of the ribs is considered carefully as not to become chaotic; the ridges and details on each rib are repeated in the others, unifying them as a continuous field of simple, readable movement.

There are many graphic tools to potentially hold in reserve, but it seems as if the most important are: black outlines and black shading, which have the deepest value available; colors, particularly the brightest primaries; white highlights; especially large, sharp, clear ones; untextured skin, which balances out the rendered areas; texture or fine detail, which we use in the top priority object but much less everywhere else. The strengths and benefits of each of these tools are most effective when we use careful reserve, giving each tool a chance to be noticed in the overall scheme of the tattoo.

2.6) Lines and Edges

When we look at a photograph or the world around us, we see that in real life there are no outlines. An outline is a graphic tool that was created to make the shape it describes stand out more than it would in real life. In tattoo design, this kind of exaggeration is often necessary for the sake of clarity and readability, so we often use outlines to strengthen our designs.

In real life, the edge of a shape has no thickness at all; the shape ends at its
Bloodlines are very versatile; we can color or shade right up to them, then sharpen their edges with the same hand movements that we would use to sharpen the edge of a bold line (Fig. 2.6.T). One concern of mine is that the holes poked in the skin during the bloodlining stage will make it harder to create a truly sharp edge there, possibly affecting healing. I also wonder if a bloodline could be stained by wiping dark pigments over it, causing it to heal with a faint afterimage, potentially in an inopportune place. This may be Guy's Superstition, but I usually only use bloodlines for design elements with soft edges; for sharp-edged details I try to use black lines, grey lines, or color lines.

Greylining is a way of making a light line that can be made to disappear as the piece is shaded and colored, turning it into an edge. A grey line is done with grey wash, so we can make the wash as light or as dark as we want, depending on our needs. We might be doing a large, multiple-session tattoo that incorporates a soft smoke effect; where we would have used a bloodline if it was a single-session piece, we instead use a very light grey wash. The line will still be there when it heals, but will be light enough to hide underneath the soft shading and color that we'll put around the smoke later.

Other features in a design might be greylined in more medium tones, which will give the edges of those shapes more sharpness than a bloodline would. In (Fig. 2.6.U) we have a
healed first session, where we had used a three to greyline the facets and other details, then a five round to line the central figure and build up those lines. Switching back to the three, we continue with detail in the character’s ornamentation, and perfect the bold lines around the hands and other places.

In the next session, we shade the facets with a 7 mag (Fig. 2.6.V), working with very diluted washes and using quick oval movements, then dipping into a stronger wash and using smaller ovals as we come closer to the edge that we’re pulling the shading up against. We then sharpen the edges with the three (Fig. 2.6.W), using a slightly stronger wash to make the edge crisper. Healed, the grey loses about 40% of its darkness, which is normal, along with all of the red (Fig. 2.6.X).

![Fig. 2.6.V](image)

![Fig. 2.6.W](image)

![Fig. 2.6.X](image)

We continue this process with the deep colors (Fig. 2.6.Y), starting with deep oranges and reds, then greens, taking care not to overlap the two colors too much, which would make brown. We handle most of the tightening with the five, which saves time and helps smoothness, then switch to the three to sharpen the edges and corners (fig. 2.6.Z), placing small amounts of dark purple in key spots for emphasis. In the finished piece, you can see how the edges of the facets healed sharp, yet softer than the black peripheral outline of the figure (Fig. 2.6.ZA). By avoiding a black line and keeping the value below 60%, we are able to fully realize the background, while still not competing for importance with the figure.

If we go back to (Fig. 2.1.J), we see a healed photo showing some areas that were lined with straight black, others that were greylined and colored. It’s easy to see how the different darknesses of lines complement each other.
Sometimes we have a shape that we want sharp colored edges on, without black or grey muddying the color. If we’re careful, we can do this by actually lining with color. That way, we can bring the color of the shape right up to the color line, making it disappear and become the edge instead of a line.

There are some limitations to this, since colored pigments are a different consistency than black. Some modern colors are a thinner consistency than the traditional flake-powder pigments, making them easier to line with. Many tattooists are using liquid dispersion colors such as Starbrite to supplement their palettes (see Appendix A). These colors are almost as easy to line with as black. In general, though, color is less reliable to line with and seems more susceptible to dropouts and blowouts than black is. However, this is hardly a problem if the line is going to be incorporated into an edge.

For the piece in (Fig. 2.6.ZB), we commit the stencil for the central shape with Starbrite pink, which is easy to line with and light enough to allow for adjustments. We bloodline the rays radiating from it and use a heavy black line around the cave features. With organic fat black lines, we can often skip the first stage of making a quick pass over the stencil before building up the line; instead we build as we go, working in small overlapping ovals (Fig. 2.6.ZC). We do the final refinement of the edges with the quick skating motions, still leaving many of the bumps and wiggles as
part of the finished look (Fig. 2.6.ZD). We try not to let this be an excuse to work too fast, causing the line to heal too light, or fuzzy around the edges.

This method of building black lines is not recommended for clean arcs and precise edges, since it’s harder to control than building along a first-pass line. But for organic outlines, it can save a little time and possibly give the line more character.

After finishing all the lining and coloring the deep tones and cools, we pull pink and lavender up against the pink edge of the geometric shape, first using the magnum, then tightening it with the five. We handle the orange gradations inside this shape in the same way, roughing it in with the mag, then refining it with the five. Before switching to yellow and white, we make a final tightening pass with the three, adding dark orange and red. By moving in light skating motions along the edge, then pulling the color away from the edge and into the shape with inward-moving strokes, we make the color line disappear altogether (Fig. 2.6.ZE). Finally, we add yellow and white, first using the five, then the three.
Committing the stencil to skin using a three or five seems a natural enough way to begin a tattoo, especially since we almost all begin our careers being taught the basic assumption that we have to outline a design first before we can get on with the more exciting parts.

Many tattooists are now challenging this basic assumption, laying the stencil and going straight in with a magnum. Some are finding that this works not only for soft and out-of-focus effects, but for precise detail as well. A few tattooists are known for doing realistic portraits without anything except for a magnum. Working this way, a tattoo can be approached in terms of forms and edges, rather than lines (remember, in photos of real life, there are no outlines!) Using just the mag, sharp and soft edges can be applied almost simultaneously.

Although the magnum is an extremely versatile tool, there are some things that are better done with a small round, such as sharp lines. Fine-tuning of arcs and details can be hard to do with a magnum, which can get cumbersome at times. Personally, I like to work interchangeably between the magnum and the small rounds. These days, I commit my stencil to skin partly with a magnum, partly with a three or five, switching back and forth between machines as many as five or six times before finishing the first pass over the stencil. By that stage, the soft edges are soft, the sharp edges are sharp, the lines are crisp and bold, and important small details are in place.

Working this way can be easier using stencils that are different from the standard linear stencil by showing not only lines, but positive and negative areas as well. We put these shaded areas in a stencil mainly in places where we intend to begin with the magnum (Fig. 2.6.ZF). Eventually, perhaps we can become less dependent on lines this way and use them more selectively, which can only make them more effective.
edge, and the background begins. An outline differs from this because it has a thickness, like a thin black tribal shape; it has two edges with a thin area of black between them. We usually keep our lines crisp and smooth, so it’s like having a thin tribal design reinforcing our composition.

(Fig. 2.6.A) shows two different versions of the same image, one with an outline, the other without. The image with the outline immediately has more impact and boldness, while the other one has more subtlety and realism. In both cases we are avoiding pos/pos and neg/neg relationships with the background; however, in the image without the line, much more attention must be paid to keeping these pos/neg relationships as readable as possible. In the upper parts of the head where we have a neg on pos relationship, we pull the deep tones of the background right up against the edge of the face, taking care to develop the edge into a clean and readable one. On the bottom parts of the chin, where the fur is in shadow, we shade the fur in deep tones and build it out to the edge, making the pos on neg relationship optimal. When we use an outline, we can be looser about developing our edges, and not lose all of our readability.

In the most basic kind of tattooing, all outlines are created equal. Lining is done with a single pass with the same needle group, using black. Often tattoos done this way are cluttered and busy, while at the same time not being strong enough. With only one type of line quality, a design needs to be very simple and economical to avoid these pitfalls. With more complex designs, different line qualities are important to keep the complexity from becoming chaos.

In most of the more complex designs in this book, we use a number of different weights of line in conjunction with details that have no lines. If we go back to (Fig. 2.3.B) you’ll see how we gave the carp a simple, clean, fat black outline all the way around its outside, including the fins and whiskers. This is called a peripheral outline, since it defines the periphery of the shape, giving it clarity. We avoid using bold line in any of the details inside the carp, which would have competed with the peripheral outline and cancelled out its effectiveness. The smaller details, such as gills and the
spines inside the fins, are given an thin black outline, while the scales and eye bulges are done with a grey wash line.

Outside the carp, the water is given no line at all, which makes the fish appear to be in more focus by comparison. To do this, we first finish the black and grey lines in the fish then skip the lining stage in the water, going right into this part of the stencil with a 7 magnum. After getting the blues roughed in, we switch back to a 5 round and sharpen the edges in key places while leaving them softer in others. This is an example of using focus to assign priority; line quality is the key to creating these focal effects.

In (Fig. 2.6.B), line quality is essential to the design's success. The peripheral line is thick and clean, separating foreground from background. The many details in the legs and body are given line weight according to how important they are, with many of the smallest details outlined in grey. The background is done without any lines at all, or even any black; that is all reserved for the droid, giving it top priority.

There are many ways of tattooing lines of different weight, some ways being better than others. The first thing that might occur to us would be to use thicker needle groups such as 14 rounds for the fat lines, and smaller needle groups for thinner lines. One of the drawbacks to this is that we need a different needle group for each line weight, limiting us from exploring the whole range of thicknesses. The other major problem with this is that heavy lines done this way usually aren't very high-quality lines.
The quality of a line is determined by the sharpness of its edges, the consistency of its thickness, and the depth and evenness of its black. When a line is put in with a single pass of a large needle group, it's kind of like using spray paint; pigment will be concentrated in the center of the line, since more needles pass through the center than the edges, while the edges end up being softer. Moreover, a single-pass line of any weight will tend to have blow-outs and drop-outs in the normal course of its healing. The best remedy for this is to use a smaller needle group, and build up our line.

In (Fig. 2.6.C - 2.6.D) we see examples of lines done both ways. The one on the left is a tattoo on my own leg that was done around eight years ago by a skilled tattooist, using a single-pass line technique. The other one I did almost eleven years ago, using the types of line building methods described here. The difference in quality between these lines is pronounced; the built-up line is much cleaner and more consistent. In fact, this difference was visible long before all these years had passed.

The simplest way to do this is to make a first pass over our stencil with the needle group of our choice, usually a five round (Fig. 2.6.E). Then, once the whole stencil is committed to skin, we make a second pass, this time moving in small overlapping ovals to bulk out the line and establish its edges (Fig. 2.6.F). Finally, we do a quick third pass, working in short straight zips through the skin, skating along the edge to smooth it out and make it crisp.
along both edges, anywhere that the looping ovals haven't already accomplished that (Fig. 2.6.G).

Part of the beauty of this method is that, while a single-pass line is always going to be flawed, we can adjust and perfect that line in the second and third passes. In (Fig. 2.6.H) we have a stencil of a clean arc, and a line where the first pass with the five round actually ended up. Even with lots of experience, this margin for error is relatively normal and usually accepted. In (Fig. 2.6.I) we see the second pass, where we use the opportunity to build the line outward in some places and inward in others, bringing us closer to the clean arc that we want. Finally, in (Fig. 2.6.J) we skate along the edge in short straight strokes, sharpening the edges and refining the arc to a point where we're satisfied.

It's a common assumption that the best needle groups are the tightest ones. This isn't necessarily true. After much experimentation, I had slowly acquired the habit of using loose 5 rounds for building my lines, such as in (Fig. 2.6.K). After years of working this way, I began using needles made by someone new, whose idea of a 'loose five' was much tighter than even my definition of a tight one! (Fig. 2.6.L) I noticed immediately how much harder it was to sculpt lines with these rounds; they took much longer to build up, and didn't look as dark as they should have. Worse still, clients started coming back with poorly healed linework.
After switching back to a much looser five, things returned to normal and building lines stopped being a struggle. There are a few reasons for this. First, a looser five will cover more ground in less time. Second, since the holes we're poking are farther apart, the skin takes less of a beating and we're able to work the line longer without trauma. Finally, a good separation between needles means better capillary action, delivering more ink down into the holes we're poking and actually making the line darker.

Part of the reason the skin gets traumatized with the tight five is that the group is tight enough that it stops being a group of five needles and becomes one big nasty one. With such a big and ragged point, the machine is less able to punch it through the skin, so it spends much of its effort bouncing around near the surface, tearing as it goes. You'll notice that with a too-tight needle group, you need to stretch harder and bear down more; this is a sure sign that you need more space between your needles. If we need a tight five, it's best it's tightened with moderation (Fig. 2.6.M)

If we want to build up a line and a loose five is just too big, we switch to a loose three. This group can be used to make lines of any thickness, although it takes longer to make really fat lines and can cause raised, slightly scarred lines if we run it too fast to make up for its small size. I usually use a three to build up lines in smaller details, such as the hydraulics in the probe droid's legs. For bigger lines, a five round is a good all-purpose tool. For gigantic quarter-inch lines, there's no reason not to put them in with the magnum and then sharpen the edges with a three or five if necessary.

The one method of building lines that I would not recommend is to use a small group to outline both edges, then switch to a large
group to fill in the gap (Fig. 2.6.N). There's a few problems with this. First of all, the outlines for the edges will have all the normal wiggles and imperfections that single-pass lines have; we lose out on the opportunity for refining our arcs, as we discussed earlier. Second, it's hard to make these lines truly parallel, so even with a steady hand we'll end up with inconsistent line weight. Another problem is that we have the normal pitfall we run into when filling a small space with a large needle group— it's hard to get the black in right up to the line without accidentally going over it. Fat lines done this way usually don't look that great.

A good way to practice technique for building lines is to use black colored pencil on illustration board (if you're coloring these drawings, put the color in first and do the outline last, since it's easy to disrupt a carefully built-up line while coloring, and black will get smeared into your light colors- kind of like the tattoo staining problem, but in reverse). Make a first pass with the black colored pencil, just as you would with a tattoo. Then, go back and use the hand movements we discussed earlier to build up the lines. While doing this, try other hand movements and find what feels the most natural; you'll probably find that you work best with a wide variety of hand movements, rather than sticking to a formula. Freedom is the key.

When translating these hand movements back to your tattooing, the trick is to get your equipment to work like a colored pencil. First, you want a long stroke on your machine, with a gap of at least the thickness of a nickel between your points (or between your point and your bare spring—two points aren't necessary). Next, give your spring the bare minimum tension you can get away with; with the machine at rest it should just barely be in contact with the point. This will cause it to run softly, allowing you to work the line several times without digging a trench.

The machine I use to drive my threes with has even less spring tension than this; I actually have to give it a little flick of the wrist to get it to start. I've incorporated this 'flick' movement into my work habits, so it's not an inconvenience, and the machine runs even softer. Superstition? Perhaps, but it seems to work.

Next, you'll want to work with as little power as you can get away with. When starting a tattoo or switching machines at any point in the tattoo, start with the power knob tuned too low, and slowly turn it up until it feels right. If you need to add a little more power while you're tattooing, feel free at any time, especially while working tougher skin areas. But always be prepared to shave a little power off, especially in areas of softer skin like the inner arm. After a bit of experience, you'll habitually use the right amount of power, but in the meantime, it's better to have too little than too much, and we can control it more with the power lower.
You'll want plenty of needle hanging out of the end of the tube. I was originally taught to only have as much needle hanging out as I plan on burying in the skin, and to use the tip of the tube as a kind of 'depth guide'. This is a crude and inaccurate way of lining. After observing other artists at conventions, I began using more and more needle, until finally at this point, where I use so much needle that it doesn’t even retract all the way in the tube, despite the long stroke. (We want our needles to come as close as possible to retracting completely, since they load up with pigment better that way).

At first I was afraid of burying the needle and damaging someone, but quickly outgrew that fear. I found that as long as I kept my power low and was conscious of my stretch, it seemed that the needle would automatically puncture just to the right depth before retracting. This is a result of the long, low-tension stroke striking skin that’s tight enough.

The main advantage of the long exposed needle is visibility. When we can see the points of our needles, we can control them better, especially while building arcs or other precise operations. Having a lot of needle hanging out is one way to improve visibility; another important way is to have a good bevel on the tube. In (Fig. 2.6.O) we have the side view of a tube tip for a five round, which is beveled at a 45 degree angle. This improves visibility dramatically without affecting ink flow.

Most commercially available round tubes don’t come pre-beveled; you’ll need to do that yourself. Get a small-tooth metal file, something around 8 inches long and 3/4 inch wide, and a small round needle file, which are usually about a quarter inch wide at their handle and taper to a point; make sure you find one with a point small enough to fit into your round tubes. If you have trouble finding needle files, try Sears.

Next, clamp the larger file onto a workbench and hold the tube as shown (Fig. 2.6.P). Bring the point down onto the file and pull it toward you in slow, measured strokes (Fig. 2.6.Q). After every three or four strokes, check your bevel and make sure you’re not going further than necessary.
When you’re happy with your bevel, round down the point of it with a couple of light passes over the file, so that it won’t be dangerously sharp (Fig. 2.6.R). Finally, insert the needle file and twist it back and forth a few times to clean out any burrs inside the tube (Fig. 2.6.S). Rinse with a fast-running faucet to ensure there are no steel filings hiding in the tube, waiting to be driven into someone’s skin.

Between the spring tension and stroke, the low power level and the long, visible needle, you should be able to work with your smaller needle groups freely and intuitively, the way you would use a pencil. Building clean lines and edges is an easy job with a pencil, and can be with a tattoo machine as well.

Tuning our machines to work like pencils is especially helpful when working with design elements that don’t have any lines. If we don’t want a black line in a given design element, we ask ourselves what is appropriate: a bloodline, a grey line, a color line, or to go into the stencil with the magnum and shade or color an area without any lines at all.

We make bloodlines by tattooing with only clean water in our tubes. Lines done this way will commit the stencil to skin for the duration of a session, but will heal out and disappear when they’re no longer needed. Bloodlines are great for things like smoke and wind, any elements that will have soft edges. They can be done quickly and cause very little trauma. When we first put them in, we may not see anything, especially if our stencil is dark. But if we keep track of which ones we’ve done by working systematically from one end of the tattoo to the other, we can avoid doing any of them twice. Eventually, as the bloodlines redden and the stencil fades, they will become clearly readable.
2.7) Depth

A strong illusion of depth can have a powerful impact. If it's done convincingly enough, this illusion can move the viewer into seeing beyond the skin and into the vision of the design. I've noticed that when people are paging through my portfolio at conventions, their strongest reactions are to the pieces that convey the most depth; those pieces just seem to have a little extra grab.

Depth is an important tool for keeping complex tattoo designs clear and readable. With many elements interacting, a foreground/middleground/background relationship can help keep the design from getting cluttered; instead of cramming the different design elements into the tattoo side-by-side, we can overlap them, with top priority elements in the foreground.

(Fig. 2.7.A) is an example of such a complex design. To tell the story, we need the well, complete with crank and bucket; the candleholder, pitcher and cups; two cushions next to each other with Persian designs on them; the temple and palm trees, then the whole sunset sky, including full moon and flying crane. Not to mention the butterflies, a good mood element but a potential clutterer.

I normally avoid this many elements in a tattoo, but I like the kind of atmosphere that those elements invoke, and feel that it can be done if we balance them carefully enough. Since the well is the most important item, we make it as tall as possible without going into the armpit, which would distort it. We give the well the full value range, using large areas of black and plenty of white.
highlights. The wooden parts of the well have a clean black outline and a large, clearly readable dark area at the top which leaps out from the sky. We use the white highlights to create two textures, wood and stone, which help bring it into focus.

Most other elements have less contrast, particularly in the background. Where the shaded parts of the stone in the well threaten to create a pos on pos relationship we let the background drop out to a lighter value, making the black in the well jump forward. In a way, this is a similar strategy to (Fig. 2.1.J), where less value range is used in the background.

Another strategy we use to convey depth is by using perspective. The structure of the well gives us an opportunity to use this important graphic tool. The design has four circles in it, viewed at an angle, so they appear as ovals (Fig. 2.7.B). You’ll notice how the ovals appear flatter when they’re closer to eye level and more circular the further down they are. In (Fig. 2.7.C) you can see how the ovals become more circular above eye level as well. This characteristic of circles and perspective is evident in real life; just look at a drinking glass in real life and move it up and down, paying attention to how the ovals change. In (Fig. 2.7.D) is a drawing of a castle using these principles.

The low circular wall in the tattoo is designed in such a way as to come both in front of and behind the well, adding to the sense of depth already established by the well’s perspective. We also employ the candle holder as a strong light source.
to play over the texture of the stones and cast a shadow on the wall, which helps to establish the wall and the well’s relative positions in space.

The cushions are of fairly high priority, so we give them a clean black peripheral outline and make them as large as we can, using almost the whole width of the design. They are in perspective (Fig. 2.7.E), which adds to the sense of space. The designs on these cushions are in the same perspective as the cushions are—this is super important (Fig. 2.7.F). We use a wide range of bright colors in their patterns, which pops them forward from the simpler color scheme of the stone, but still use warm colors on the edges of the pillows that face the light source, and cool colors on the edges facing away.

Although the sunset is complex, which conveys a sense of vastness (as opposed to a simpler sunset, which may have made the sky look smaller) we keep its value range around 60, even less range as we get closer to the well. We use no true white in the sky, which would have competed with the well; instead we reserve it for the moon and the crane. We give the crane no outline, keeping it in the distance, but use a crisp black line around the butterflies to pop them forward.

Back in (Fig. 2.1.F), we use light and shadow as a tool to express depth. We make the tip of the coil the light source, so that all surfaces of objects facing the coil are lit up by it, while the surfaces facing away are in shadow. The dark tones in the underside of the coil, the outsides of the big curvy zipper-flap things and the shading under the repeated row of teeth strongly contrast the soft, luminous colors used in the coil and the inside surfaces of the pod. Shadows cast from two of the teeth onto a nearby branch also add significantly to the sense of depth.

As long as we’re discussing this piece, I’d like to mention another superstition of mine. I’ve noticed that when I look at many heavily tattooed people’s sleeves, the top of the forearm is usually the densest and least readable part of the arm. Often this is because this spot gets tattooed with a cheezy skull or something when the person is
sixteen, then covered up when they are twenty-one, then fixed again five years later. But even when the area is tattooed for the first time, it seems that it is more prone to looking dense than most other parts of the arm. I think this is largely because this part of the arm is the hairiest, darkest and most leathery part, which sees the most sun. That's a lot of factors working against the tattoo.

I usually try to make up for this by making that part of the design more open and clear than the rest of the sleeve, making sure to use some long, smooth arcs and light colors. I seem to have had some success in honoring this superstition. Anyway, that's another small thing to consider, next time the situation arises.

*Cast shadows* are a fantastic depth tool, as demonstrated earlier in (Fig. 2.1.A, Fig. 2.2.E, Fig. 2.3.M). This kind of shadow really shows the viewer the apparent distance between the object casting the shadow and the surface the shadow has landed on. (Fig. 2.7.G) is another example of the use of cast shadows; you can see how the shadows cast by the ribs follow the contour of the bumps that they are cast on, which helps to show the curvature and volume of the bumps as well as the amount of space between the bumps and the ribs.

(Fig. 2.7.H) uses many depth tricks. For starters, the way the piece is laid out on the arm takes the most advantage of the natural bulges and dips in the arm, with the fullest shapes sitting on the roundest part of the deltoid and filling out the bicep. We do our best to make the most of the natural S-curve of the arm. We give these largest forms a clear warm on top/cool below color logic, which creates a greater sense of volume. Next, we give each of these shapes a clear neg on pos relationship, which can be very effective in bringing shapes to the foreground.
The smooth shiny shapes fused to these organic parts also help to describe the depth of the design. Since these shapes are structured, we can use that structure to show depth. For instance, the row of spines embedded in the coil on the deltoid help to show how thick that coil is; the way the organic stuff is rendered around these spines shows how they’re embedded into the coil. You can get an idea of how to construct these kinds of shapes in (Fig. 2.7.I).

In (Fig. 2.7.J) we have a similar composition in terms of how we lay out the largest forms. This time the whole foreground area is shiny, making it jump out from the darker and rougher background. A strong clear peripheral outline helps it to stand out even more.
The fine lines inside the main body of the coil help to describe the depth of the form in the same way that the spines do in (Fig. 2.7.I). These lines show how thick the coil is, plus which parts are concave and which are convex. When lines are placed on a shape in such a way as to describe the form, we call them *contour lines*. Many of the coil shapes in this book, such as (Fig. 2.3.H) rely on contour lines to describe their form. In (Fig. 2.7.K) we have two very similar shapes, one of them that relies on shading alone to convey its depth, and another that uses contour lines, to a much greater effect.

---

Fig. 2.7.J

---

Fig. 2.7.K
One of my favorite tricks for creating depth is the 3-Dimensional Figure 8, or 3DF8. This happens when we follow all the way through with the S-curve (Fig. 2.7.L). This type of flow fits very appropriately over large body parts, such as sleeves (Fig. 2.7.M).

In (Fig. 2.7.N) is a biomech design using this type of layout; (Fig. 2.7.O) is a more traditional dragon design that expresses depth this way. In each of these designs, the top priority element flows through the foreground, curves up over the top of the arm, then passes behind the foreground object, flowing in the opposite direction. When the foreground and background flow in opposite directions like this, they will stand out from each other more.
Fig. 2.7.P is a good example of this. The basic 3DF8 is plain to see. The part of the figure 8 that passes behind is much darker than the foreground shape, contributing even more to the sense of depth. In addition, the background is rough while the foreground is smooth, giving them distinctly different texture silhouettes. For good measure, the teeth on the foreground shape are designed to show depth and contour, kind of like the spines on (Fig. 2.7.I).

(Fig. 2.1.A) makes strong use of this layout principle; so does (Fig. 2.5.B). In both cases, the foreground elements follow the arm's natural S-curve, then follow through into the 3-D figure 8. This movement is not necessarily followed all the way through in every part of the tattoo; the important part is that the foreground elements flow along the S-curve and the elements passing behind them flow in the opposite direction.

(Fig. 2.7.Q) is a complex abstract design that follows the basic 3DF8 plan that we illustrated in (Fig. 2.7.M). In this example, the flow/counterflow elements are used only in select parts of the design, such as the shoulder cap. However, this is enough to suggest the volume of the space to the viewer. This piece is a major cover-up over a laser-lightened area; to make it fit best, we first plan it in a sketchbook (Fig. 2.7.R), then draw it on the arm with Sharpie pens. As of this writing, it is unfinished.

This 3DF8 thing may be another one of my superstitions, but I'll bring it up again anyway when we discuss certain designs later in the book. I believe it is a universal design principle. Even if we don't think about it consciously, just in the act of using the S-curve and flowing the background elements in the opposite direction from the foreground, we'll have a 3DF8.

Whether we're using depth to add readability to a design, give it more visual punch, or create an optical illusion, we're sure to make it a more exciting tattoo. We have many tricks at our disposal for achieving this, which can be mixed and matched as we please to try to optimize an effect. If we want the maximum visual impact possible, we can try to stack our tricks all up at once. These tools include the use of dynamic range to pull an object forward, the use of priority lines, light and shadow, especially cast shadows, and of course the placement on the body and the layout of the design elements such as the 3DF8 strategy.
2.8) Lighting and Luminosity

Like depth, luminosity is a great effect in a tattoo that has a strong visual impact and brings life to the piece. We can use lighting effects to simulate convincing texture on the skin, create a realistic illusion of depth, or bring attention to an important element. We can use it as language, as well—a holy light, coming from above, a sinister light, coming from below, or a transcendental light, coming from within. Good lighting effects will add readability to a piece and help to balance its light and dark areas, keeping the design from getting too dense or too wishy-washy.

We have a few tools at our disposal for simulating luminosity. For starters, we have our use of color and value contrast, where we reserve the lightest colors and white for the light source, while saving the darkest tones for the shadows. We also have the surfaces and objects within the composition, and how the light plays over them, including cast shadows and other shading effects. We can place the objects within a design in just such a way that they describe the lighting situation in a way that’s the easiest to read.

Another important luminosity tool is light rays, such as the big open ones in (Fig. 2.4.C) and the smaller ones in (Fig. 2.3.L). Light rays are not only effective in suggesting the strength and direction of a light source, but when used just right will invoke a sense of beauty and awe; when we’re outdoors and we see light rays breaking through the clouds, it can take our breath away. Last but not least, light rays are a great directional element which can be used to focus the viewer’s attention or to pass between layers in the design, separating them.

(Fig. 2.8.A) uses all of these tools to convey luminosity. The background
and the parts of the figure facing away from the light source are in deep, cool colors which stringly contrast the bright yellows and whites of the light source. Next, we make the character’s skin textured, and then light and shade the curves and bumps in the texture so that all the parts facing the coil are lit the brightest. This is especially fun with the face, which we light clearly from below. We then place the hands in such a way that only a thin edge facing the light is lit, while the rest of each hand is silhouetted in shadow.

If you’re ever unsure about the way light should play over an object, try to simulate it in real life and then translate what you see into the tattoo design. In this case, you could stand in front of a mirror with a small lamp and hold your hands around it to see what they look like. You can move your hands around and see what difference a slightly different angle of lighting makes. If you want, you can even snap a couple of photos of your hands in these lighting conditions, and refer to those photos while drawing the design.

We also use rays in this design, which adds to the glow and helps create a relationship with the objects around the rays. You’ll notice how the rays pass in front of the legs, but behind the hands, describing those relationships.

The glowing shape in the center has a light pos on neg relationship with the glow around it, kind of like the gem in (Fig. 2.2.G). This gives the shape strong clarity, especially with the use of a white outline around its outside. Other tattoos in this chapter use a neg on pos relationship for their glowing shapes; I can’t honestly say at this point if one way is better that the other, and under which circumstances. This is a complex question which I don’t have a theory or even a superstition for, so it’s better if we’re prepared for either way, pos on neg or neg on pos.

(Fig. 2.8.B) is an example of a neg on pos glowing shape. We still have the rays, but this time we fade the rays to a medium pink as we come up against the outer edge of the glowing
shape, kind of like how we did in (Fig. 2.6.ZB). Then we play the light over the surrounding surfaces, which are structured and faceted as opposed to the organic surface of the figure. The chrome petals are facing out from the light source, so we only see yellow highlights along their uppermost edges. The petals visible on the far side of the flower are catching the light full-force, so they're colored mostly yellow.

(Fig. 2.8.C) is an example of a pos on neg glowing shape. To keep it luminous, we use dark red only near the outermost edges; in a few places we even use dark purple with a loose three to sharpen those outer edges a little more. We leave the rest of the shape very light, especially the center, and try to leave many of the facets simple and open, giving them a silhouette that stands out from the background. We add to this sense of luminosity by bringing a foreground organic element in front of it; this element is strongly silhouetted and not only contrasts the center of the glowing shape by 100 value points but also contrasts the hot yellows and oranges with rich blues for another 100 points, making it really stand out.

This foreground element serves the additional purpose of breaking across a rigid symmetrical geometric shape that
we’re trying to tattoo on a lumpy, organic asymmetrical body part. This makes stenciling much easier, since it gives us a margin for error in the geometric shape; we can hide stencil fold-overs inside this shape—no one will ever know the difference!

(Fig. 2.8.D) is a simple neg on pos glowing shape laid out in a 3DF8 design. We bring several organic shapes in front of the glowing thing, silhouetting them darkly. Apart from the outline, these shapes have some of the only black in the tattoo; the rest is shaded with color. Other shapes pass behind the glowing shape and are lit up by it. By showing both kinds of relationships, both in front of and behind the light source, we increase the effect of the luminosity and help to show all of the objects’ relative positions in space.

There are many uses for these basic lighting tricks in more illustrative tattoos as well. Luminosity is always a potent and attractive effect for bringing life and dimension to a tattoo whether we’re doing a dragon lit by a pearl, a kid in a sandbox lit by a sunset, or a mutant root system lit by an ectoplasmatic egg. Whether it be wild or mild, when we’re using good lighting tricks, our tattooing will never be mundane.

---

**Part II  Review Questions**

1.) Why are flow and fit important?

2.) Can the flow and fit of a design be an important aspect of its subject matter?

3.) What kind of movement fits the most naturally on the body?

4.) Where are the best parts of the body for symmetrical designs?

5.) How do we take a tracing?

6.) What is the purpose of a construction drawing?

7.) If dark is the opposite of light, what is the opposite of flow?

8.) What is a tattoo’s silhouette?

9.) Does ‘Pos on Neg’ refer to a light shape on a dark background, or a dark shape on a light background?

10.) Are positive and negative relationships determined by the relationship along the edge of a shape, or the average overall weight of the design elements?

11.) What kind of pos/neg relationships are likely to be the least readable?
12.) What is a dynamic pos/neg relationship?

13.) What does it mean to use the full value range?

14.) Do we want more dynamic range in the foreground or in the background?

15.) What six factors are responsible for the dynamic range? Can you think of any others not mentioned in this book?

16.) What kind of colors have the most contrast with each other?

17.) What's a good way to use warm and cool colors to give a rounded object a sense of volume?

18.) What elements do we use to achieve focus and out-of-focus effects?

19.) Whether in painting or tattooing, what tool do we use for rendering an out of focus area, and what tool do we use for the focused ones?

20.) What will determine the amount of contrast between two textures to the greatest extent?

21.) Why do we need to give our different design elements an order of priority?

22.) What are some effective tools for assigning priority?

23.) What are some graphic elements that we can hold in reserve?

24.) What is the difference between a line and an edge?

25.) What are three factors that determine the quality of a line?

26.) What are some good ways of building up a line?

27.) What is a great way to practice building up lines and developing our technique?

28.) How can we set up our machines to make them work in such a way that we can use them like colored pencils?

29.) What are two things we can do to improve our visibility situation while lining, besides having good lighting?

30.) What types of needle groups can be used for lines?

31.) What are some good graphic tricks for conveying depth?

32.) In what way are contour lines different from peripheral lines?

33.) What are some of the most effective tricks for conveying lighting and luminosity?
Part III
Working in a Second Medium

3.1) A Broader Perspective

These days, many of the artists attracted to becoming tattooists already have some kind of art background. Some were comic artists, others commercial artists. Some are art school graduates, others art school dropouts- and many, like myself, have no formal training but had always done art to some capacity, such as punk rock fliers, custom leather jacket decoration or album cover art. There are also tattooists who had little or no real experience in any artistic medium before apprenticing, but were sufficiently interested in the craft to really put in the hours and do the homework, racking up a good deal of experience in a short time. The one thing that almost all tattooists have in common is that skin art is just about the only kind of art they do.

It's easy enough to understand how a beginning tattooist needs to wear blinders and shut out pretty much everything else while they focus on tattooing's steep learning curve. There are just so many things to learn and only 24 hours in a day; I remember walking home from work those first few weeks in a state of shock. It's extremely rare to meet a tattooist in their first two years working in any other artistic medium, and we can hardly fault them for it. But there does come that time when we're comfortable enough with the basic tattoo process that we may have room in our brains for a little more. At this point it's time to broaden our horizons by working in a second artistic medium.

There are many reasons for this. For starters, we have a freedom in drawing or painting that we don't have in tattooing; we can work with whatever subject we want, at whatever size, in whatever color scheme without someone else's requirements to limit us. While we're working on our personal projects, we have no one else's expectations to live up to, so we can focus on exactly what we're trying to accomplish without each stroke of the pencil or brush being burdened with Duty or Obligation. We even have the freedom to leave a project forever unfinished, if that suits us, and move on to something more promising- but if we did this to our tattoo clients, our careers would not last long.

Another big advantage to working in a second medium is that we can work as many consecutive hours for as many days or weeks as we wish without the client running out of money or passing out. This is an opportunity to really 'get into' our
subject, and I believe that one of the greatest experiences an artist can have is to become fully immersed in a project. Not that we can’t get into a tattoo project, but we really can only immerse ourselves in it for so long before the client has to go home.

Personal projects are a chance to get familiar with an unfamiliar subject matter, or even just a broaden our perspective on a familiar one. It can facilitate free experimentation without the risk, allowing us to expand our vocabularies with our successes without burdening anyone else with our failures.

Although we want to get proficient in our second medium for its own sake, our real goal is to nurture a relationship between our two media where they benefit each other. Tattooing has many benefits that are not to be found in most other mediums: the immediacy and urgency of the project, where we have little choice but to sit down and finish it, regardless of what mood we’re in or what’s on TV; the incredible precision possible with needles, and the ingenuity that’s been invested into fine-tuning the whole tattoo setup; and of course the client relationship, which is the fire behind the whole thing- the idea, the canvas, and the purpose for the tattoo to exist at all.

When we have a second medium, we bring with us all the things we’ve learned about design layout and fluid composition, all of the precision and steady-handedness, and the whole vocabulary of design ideas that tattooing has offered us. From our second medium we bring back to tattooing our new-found freedoms, our fine-tuned experimental successes, and the suprises that our personal energy introduces when we let it run unchained, exploring what it pleases.

Each medium has its own unique approaches and methods, some of them similar to tattooing technique and others that are quite different. Drawing with ink and/or colored pencil is closely related to tattooing in its hand movements, from making lines to rendering gradations. Painting is very similar to tattooing in that they both have palettes of wet colors laid out that we can dip into and mix on our brush or in our tube; I have found that painting has given me greater freedom with my color use when I tattoo. Sculpting gives us a better understanding of the 3-dimensional form, both of the body itself and of dimensional effects that we create in the skin.

Regardless of what we choose, working in a second medium is sure to open our eyes to new possibilities, teach our hands a new variety of movements, broaden our graphic vocabulary in unexpected ways and give us more artistic freedom in general.
3.2) Examples of Other Media

There are countless different artistic media available to us, each with their own unique strengths and weaknesses, both visually and in terms of user-friendliness. All of them are satisfying in their own ways, but for the purpose of this book we'll try to stick to those which have a close enough relationship to tattooing for them to be of some benefit to our tattoo technique.

Colored pencils are already a part of most tattooists' lives, and those of us that have tried them have no doubt noticed how similar working with them is to tattooing. When sharp, they are like a tight three; after working with a sharp pencil for a minute or two, its point becomes more like a loose five, and can be used for both detail and larger gradations. As it gets duller, it becomes similar to a magnum; you can even purchase 1/4" colored pencil sticks for laying down large areas. Colored pencils are great for flash, T-shirt designs and any other work that requires a tight, refined look, but can also be used for looser, more abstract art.

One major difference between colored pencils and tattooing is that, while we work from dark to light to avoid staining while tattooing, it is the other way around with colored pencils. If we have an area of dark purple or black pencil already laid down and bring yellow right up into it, some of that dark pigment is picked up by the point of the pencil and smeared into the field of yellow. To avoid this, we work in a general light-to-dark direction, although we always give ourselves the freedom to do what we need to do; sometimes this kind of smearing can be used as a desirable blending effect.

If you're serious about colored pencils, I recommend Berol Prismacolors, both in pencil and in stick form; they are softer and lay down nicer and with less effort than harder pencils. They are easy to blend by layering over each other, and with a little practice we can achieve smooth gradations.

We can also use an oil painting medium called Liquin and a paintbrush to blend the colors (try this on a small experimental piece first, not something you've labored on!!) For the first few seconds after applying the Liquin with a soft brush, we're only able to blend the loose crumbs of color on the paper's surface. Then, the Liquin works its way into the deeper color and allows us to move it around too. After 15 or 20 seconds, it will have softened the color all the way to the paper, allowing us to lift the color but making it hard to blend. With this short of a time window, we only want to wet down a small area of our piece at a time.

I also recommend using a slightly rough illustration board instead of paper, which gets crumpled and dogeared. If we use a board larger than the art project we're doing, we've got an area to get tape marks and thumbprints all over. If it's
too smooth, it won’t accept the color well; if it’s too rough, there will be deep pits in
the paper we can’t fill with the pencil, leaving thousands of tiny white marks through-
out our otherwise smooth gradations.

Colored pencils can be hard on the hands, since we need to bear down on the
board to get good color saturation. I actually find that working with pencils of any kind
is far rougher on my poor little hands than using tattoo equipment, so if wear-and-tear
of the hands and wrists is a factor in your life, you may want to consider a different
medium.

There are a wide variety of stick-type media, such as pastels, cray-pas, Conte
crayons and charcoal. These media can be satisfying for anyone feeling the need to
work large, especially after all the tiny precision of tattooing. They are great for filling
large areas and creating long, smooth gradations. Although they have fewer parallels
to tattooing than colored pencils do, they allow us a lot of freedom and can give our
intuition a chance to loosen up.

Pastels are similar to colored pencils, but are bigger and softer. They can be lay-
ered more than colored pencil and allow us to place light-colored highlights on top of
dark colors. Pastels are usually oil-based and can be blended with fingers, paper
towels, Q-tips or blending stumps, but are hard to erase or lift up. Because they’re
big and soft, it’s more difficult to create sharp edges or precise detail with them,
although there are some companies marketing thin pastels that look sort of like fat
colored pencils, with a core of pastel stuff inside a wooden pencil.

Cray-pas are kind of a cross between pastels and Crayola crayons; they are waxi-
er than pastels and have a different feel to them. Some brands come extra fat, over
an inch in diameter. They can be fun to work with, especially if we don’t want precise
detail to even be an option.

Charcoal is a good classic medium for doing large drawings. We can lay down
heavy blacks with charcoal, then use a variety of tools to create long, smooth blends
and gradations. Charcoal can be sharpened more easily than pastels and can be
used for fairly precise detail. It can be erased and lifted, allowing us to create subtle
or sharp highlighting effects after we’ve already laid down the charcoal. Art supply
stores carry electric erasers, which we can use to draw precise white highlights in a
charcoal drawing.

Conte crayons are a bit like charcoal but slightly waxier and richer. They are avail-
able in a variety of colors, but most of us are familiar with the well-known reddish
earth tones they are commonly used in. Conte crayons are great for portraits, giving
us a classic-looking sepia tone. They don’t lift as readily as charcoal, and can be
sharpened almost as much as a colored pencil. Since the sticks they come in have a
square cross-section, we can use the square corners as sharp points, without having
to use a pencil sharpener.

Admittedly, I haven’t had much experience in any of these stick media, but I have
watched other artists around me do some very fun, interesting and exciting things with
them.

Ink Wash and Watercolor are two other mediums that have classically been used
by tattooists through the ages. Most old flash was done this way, in a technique
known as ‘spit shading’, although these media are appropriate for anything from land-
scapes to portraits.

Watercolors can be very bright and luminous. Unlike most other media, watercolor-
s rely on the reflectivity of the white paper to provide this luminosity. To do this,
these colors must be very translucent, basically just staining the paper; they can only
be layered to a limited extent without getting a muddy look or shredding the paper.

The key to using watercolors is to wet down the paper before adding the color. To
have the most control over the color, we only wet the paper in the area we’re about to
work. Let’s say that we’re painting a landscape and we’re ready to paint a rock in the
scene. We begin by using a clean brush to fill the rock in with clear water in a thin,
even coat. Next, we drop a small amount of color into the part of the rock that’s going
to be the darkest. The drop of color will spread quickly through the thin pool of water,
but will stop dead at the dry paper, creating a clean edge. Then, while it’s wet, we
use a dry brush to move the color around in that pool, having an amazing amount of
control over the subtleties. As long as the area is wet, we can keep dropping in color
and moving it around, provided we’re conscious not to shred the paper.

Ink wash is basically like watercolors, but without the color. It is a good medium
that allows for deep blacks and smooth gradations, allowing us easy access to the
whole value range. With a little practice, we can get these effects quickly and almost
effortlessly.

Quill pens come in many sizes and are a classic method of doing lines in ink.
Thin brushes are good too, but require more control and give a less consistent line
(which can be desirable too, depending on the circumstances). We can use these pens for the black inks, or for the many vibrant colored inks available. For colored inks I recommend Dr. Martens (not to be confused with a popular line of boots!)

Once an ink and watercolor piece is finished, we also have the option of working over it with colored pencil, either for finishing touches of for a whole extra layer of detail. Since watercolor is so great for filling large areas, we can spare our hands the stress and do the big chunks of color this way, then switch to colored pencils to add detail and character.

Nowadays many artists, including tattooists, have begun using computers as an artistic outlet. There is some debate over the legitimacy of digital art, but many artists feel that any tool that allows them to accomplish more with their lives is a legitimate tool. In my own experience, it has been an important and valuable tool that gets almost daily use in my life as an artist.

Using a computer, we can develop an image from scratch, either in a painting program like Adobe Illustrator or a 3-D modeling program like Bryce 3D. Or, we can import an existing image from a photo or drawing and then customize it in Adobe Photoshop, which is quite possibly the most important image manipulation tool ever invented.

Computers are great for cleaning up our portfolios and making our presentation slicker in general. In addition, we can use them for tattoo design and stencil preparation, as we'll discuss in Part V. There are countless things we can do with them, once we get past that steep learning curve.

When we look at a manual for a new program, our eyes glaze over and our thoughts drift to simpler, nicer things. It can be like sitting in a classroom under buzzing fluorescent lights, looking at a textbook on Classic Latin 101. The people who write these manuals have a bad habit of assuming you’re in on their lingo, and it’s easy to get discouraged when we don’t comprehend everything we’re reading.

My recommendation is to go into the learning experience with a specific goal in mind, some type of project that the program is appropriate for. While you read the introduction and the first few chapters, take organized notes, keeping track of which tools and menus pertain to your project. Then, refer to the index to look up answers for specific questions. Usually, you can figure it out this way. If not, there's always Tech Support, or late-night frantic phone calls to computer-savvy friends of yours.
By having a modest project as a goal, you can get functional in the program without memorizing the whole 300-page manual. Soon you'll be able to find your way around in that program well enough to try other things, keeping the manual at your side for those tricky parts. In a short time, you can lose the manual altogether, and I would have to say from experience that the more programs you've learned, the easier it gets to learn other new programs.

Using a computer is very different from tattooing in terms of the technical side; in a few clicks of the mouse you can totally transform a mundane image into a dazzling kaleidoscope of color and texture, while a tattoo must be done slowly, one tiny piece at a time. Digital art won't necessarily teach us new hand motions or ways of blending colors, like the more hands-on media. On the other hand, it has so much to offer to our graphic vocabulary that it's a hard medium to ignore. We'll go into this subject in a fair amount of detail later on in the book.

Of all the artistic media available outside of tattooing, painting is perhaps my favorite and has taught me the most. Working with brushes is similar to using tattoo equipment, but with a whole extra degree of flexibility and intuitiveness. Using paint, we can lay down color in great quantities, or in minuscule amounts; and we can do it quickly over a large area if we want, or labor for months on something tiny if we so choose. Unlike most other media, we can easily lay light colors over dark colors, a freedom we definitely don't have in tattooing.

The two major types of painting we'll discuss here are Oil Painting and Acrylic Painting. Both are common ways to work and are readily available almost anywhere that sells art supplies. Oil and acrylic have similar texture, similar opacity and translucency and use similar pigments. The major difference between their chemistries is in their drying time.

Since acrylic paints are water-based, they dry quickly. If we work in thin enough layers, it can dry almost instantly. This can be very advantageous for layering color, but makes it harder to blend different colors together and get smooth gradations. It can be great for very precise or detailed work, since we can rest our hand right on the canvas and get right into it. Many famous artists, such as Todd Schorr, use acrylic paint and get beautiful, detailed, vibrant results.

If I were to try to articulate my preference for oil paint, I don't know if I could make a very convincing case. I do prefer the workability of a medium that stays wet longer,
since it's so much easier to get good blends. But I'm sure that if I worked regularly in acrylic, I would eventually find ways of doing these things. I also like the glossy finish the oils dry to, but this can also be achieved using acrylic gloss medium. I feel like the pigments themselves are richer, purer and more vibrant than acrylics, which tend to look more plasticky; but this may easily be more superstition of mine, as evidenced by the rich and vibrant colors in Schorr's work. But nonetheless, I continue to prefer oil paints.

Oils have been around much longer than acrylics and have a rich history of centuries worth of trial-and-error. There are many secret formulas and recipes for the ultimate oil painting medium, but I usually try to keep my procedure as simple as possible so I can concentrate on putting the paint down. However, since acrylics have their own strengths, I sometimes take advantage of these by doing an acrylic underpainting before applying the oils. This can make it a little easier and faster for me to render the first pass on complex geometric shapes or other things that require a lot of precision. When I do this, I try to keep the layer as thin and washy as possible, as not to create a thick plastic layer that the oils might be reluctant to bind to.

Many folks I've spoken to have no problem with acrylics, but find the whole idea of oils intimidating. Admittedly, I once felt that way myself. But at this point I have firmly concluded that it is not any harder than any other medium, and has so many great features as to make learning it very worthwhile.

3.3) Oil Painting: A Brief Tutorial

One of the first temptations when we pick up oil painting is to go large. Why not, when it's so easy to cover a whole big canvas in a single session? From this perspective, 'small' might be a 2x3 foot canvas. Let's redefine small as tattoo-sized, 8''x10'' or even smaller, like 3''x4''. From the tattoo-sized perspective, 2'x3' is quite large, backpiece sized.

The fact is, we can learn just as much from a small painting as we can from a large one, but without the big time commitment. If we need to do a given number of paintings to work through a particular problem with our work, such as getting the lighting right in a certain texture, we can do a whole series in just a few weeks if they're small, but could spend two years on the same series if they were large. It's hard to try a few different ways of doing something in the same painting without it looking inconsistent; so if we need to try a lot of variations on a theme, small paintings are the way to go.
When we've done enough small paintings of a given subject matter and feel comfortable with it, we then move up to medium and large pieces in that same subject. Since we've worked through all the major questions in a smaller format, we earn the right to cruise through the big one without a care in the world. This is an ecstatic creative space, where the familiar process we've fine-tuned in the smaller paintings allows us to stop asking questions and start using our intuition; we become one with the unfolding of the vision.

To start an oil painting, we first need a design. If the painting is larger than 8”x10”, I recommend drawing it smaller on a separate sheet of paper, since the hand is better equipped for smoother motions at a smaller scale, such as 4”x5” or smaller. We then use a projector and trace the image onto the canvas. If we're basing our painting on a reference photo, we'll want to make sure it's the right proportions and is clearly readable, since vague details are hard to see through most projectors; if need be, use Photoshop to clarify any details that are hard to read.

I like to tint my canvases with a warm grey before tracing the design onto them. This makes it easier to cover the canvas in a single pass, since there won't be any annoying white flecks showing through between brushstrokes. It's also nice to be able to go both up and down in the value scale while painting; if we start with a white canvas, we can only go darker.

When the tint is dry, we secure the canvas firmly to the wall with fat masking tape or clamp it into a sturdy vertical easel. When the projection is focused and centered on it, we trace the image on with colored pencil. I usually use a purple colored pencil, which incorporates nicely into the shadows of the finished painting. I normally don't use graphite pencils for this, since they seem to muddy the oil paints, especially the light colors. If need be, colored pencils can be erased off a primed canvas with a soft kneaded eraser.

Next, we move the canvas to either an easel or a drawing board. I prefer the drawing board for paintings 8”x10” or smaller, since it allows me to get closer to the piece, plus being more comfortable in general. I like to set up my drawing board like (Fig. 3.3.A), using a cardboard frame with a lip around the back and sides. This forms a reservoir for oil paint, keeping the palette from getting too dry. I usually keep a small coconut oil filled in the petroleum jelly jar to keep the paint from drying out. The surface is covered with a sheet of white paper and the paper is pinned to the back of the board. This also helps eliminate any fly-away hairs from the paper. In most cases, I work on a black sheet of paper, which helps me to see the inverted image the same way I will see the final piece. I use a cheap sketchbook as my main guide and use a mechanical pencil to lay in the basic composition. I also use this to make sure all the angles are correct and have everything proportional. Once the basic outline is down, I put in the major darks and then the major lights, usually with a large brush.
tube with a cardboard circle taped to the bottom for a brush holder, a paper towel for wiping and a sheet of palette paper for colors, a small piece of wood (or even a pencil) taped on as a shelf for the canvas, the canvas itself, with a couple tape loops on the back to keep it from sliding around, the reference photo, if we're using one, and 7 or 8 paper towels rolled up into a curved sausage, for a comfy handrest.

I like to cover the canvas with clear linseed oil before beginning the painting. This lubricates and dilutes the paints as we go, so we don't have to dilute them on the palette and make a mess. We can apply the paint more smoothly and with greater subtlety and precision using this method; the oiled canvas becomes so receptive to the paint on the brush that we can control it with ease. We apply the oil sparingly but evenly with a wide, flat soft brush, then blot off the excess with a paper towel, so it won't run while we're trying to paint. We handle both the application of the oil and the blotting off with care, as not to smear and lighten the colored pencil drawing too much. For larger paintings, we only oil down the areas we're going to work that day.

I need to mention here that rags soaked with linseed oil can spontaneously combust in enclosed containers. It's not a bad idea to leave them out to dry for a few hours before tossing them. And yes, this has actually happened to me.

From this point on in, there's really no formula. I recommend doing multiple paintings of similar subject matter, but varying some small aspect of our approach each time. For instance, in one painting we'll put the Indian red down first, then the orange, and then blend them together; in the next one, we might put the red down, then the orange, then the yellow, and then blend it. Each will reveal something about what we're doing and where it needs to go.

Since we start with a tinted canvas, we're able to go both up and down in value. I usually start with the light colors, for the same basic reasons we start with the light colors with colored pencils; when we lay fresh yellow down next to fresh purple, the yellow becomes muddy easily, yet if we put fresh purple down next to fresh yellow, it's unlikely we'll see any color contamination at all. With a good strategy, we can finish a painting in one session without any muddiness.

After I lay down the lights, I usually skip the medium tones, which are already there in the tinting of the canvas, and lay in the deep tones and shadows. Finally, I'll put in my cools, which aren't easily contaminated by purple, even if the cools are much lighter than the purple shadows.

It's nice to use different sized brushes, small rounds and larger flats, kind of like
the tight three, loose five and different sized magnums. I prefer brushes of synthetic badger hair, both for the small rounds and for the larger brushes, a style called Filbert, which is a flat brush with slightly rounded corners, very versatile. Monarch is a good brand.

If we’re working at an easel, we’ll keep a paper towel taped up where we can easily wipe our brushes without breaking our pace. We’ll change the towel when it gets too loaded; if we don’t, it will slow us down later on.

We use the different sized brushes to create focus/out-of-focus effects, as we discussed in chapter 2.3. This will give our painting more depth and dimension. If we’re using a photo reference, it should have real life focus effects for us to try and translate into paint.

When we feel as though we’ve done all we can for the time being, we let the canvas dry for a week or two—it can be even more, depending on the climate, or possibly less. We can work on other paintings in the meantime. When it’s dry enough, we can oil it down again and repeat the process, adding depth, luminosity and detail to it. We can let it dry again, and repeat the process as many times as we wish.

If we’re oiling down the canvas for a second or third time and we notice that the oil isn’t sticking to certain colors, we can try dipping our oiling brush in turpenoid and then massaging that area of the canvas with it; that should solve the problem. If we’re done for the time being and want to speed the drying time, we can point a fan at it for a couple days.

If the drying time of oils is too agonizingly slow for us, we can try using Liquin instead. Liquin is that oil painting medium we discussed earlier in the colored pencil section. It has a similar consistency and workability to linseed oil, but dries in about three or four hours, which might be just right for our needs.

Taking on a second medium is not a small commitment, and normally means giving up something else in our lives. Most folks aren’t eager to make big changes, especially in their social lives, where there’s pressure from others to ‘hang out with the guys’ at the strip club or whatever, sometimes several nights a week. Excessive network TV programming, casual web-surfing and video games are also big time-suckers.

The thing is, if we’ve got an artistic pursuit that’s keeping us inspired, that’s worth
giving up almost anything for— that is, we find ourselves not missing the things that we’ve traded for our art.

As a gesture to ourselves, we need a dedicated art space in our home, a place where we can shut the door on the world if we need to. We want our art supplies organized and readily available. Then we deck out the walls with posters and magazine clippings of images that inspire us, including our own latest stuff, if we want. Music can be a good thing, provided it’s a good soundtrack for the art we’re trying to do— if they’re at battle with each other, it can work against us.

No artist is immune to the struggles of getting from the beginning to the end of a project. Even with small projects, but especially with large ones, we will likely experience a ‘hump’ somewhere around two-thirds of the way to completion. We may find at this stage that the piece isn’t looking the way we had envisioned, or that it had been looking pretty good for a while there, then we did something that we think took away from it. Feeling this way, it’s easy to get discouraged and think about abandoning the project.

If this feeling sets in, we have to remind ourselves that this is a normal stage for any worthwhile project; doubt will arise, and the only antidote is to have faith. We must remember why we’re doing the project, for the experience, not to get the piece in an art museum. We should keep in mind that with just a little push, we’ll soon be past that point and coasting toward completion, all the hard parts behind us. This last phase of a project can be the most fun, but must be earned by pushing through the hard parts.

You might be starting small, with little experience in any medium. I’d like to assure you that this means nothing; it doesn’t have to take you decades to even begin to taste a piece of what you’re hoping to accomplish. Because if you appreciate art, you have subject matters that interest you. If a subject interests you, you’ll explore it, eventually uncovering all kinds of suprises. Before long, without trying, you’ll find yourself on a path, and you’ll feel your momentum as you move along it. You’ll begin to be able to design projects for yourself that you know will apply all of your current strengths to your most interesting subjects.

With your strengths empowered this way and directed into a piece of art, you will create a thing of beauty.
Part III Review Questions

1.) What are some qualities of the tattoo craft that are rare in any other artistic medium?

2.) How can working in a second medium help us with our tattooing?

3.) What medium is probably the most similar to tattooing, in terms of technique?

4.) What are some of the ways that a tattooist can make use of a computer?

5.) What are some major differences between oil and acrylic painting?

6.) What are some advantages of doing small paintings?

7.) What are the reasons for tinting a canvas before starting a painting?

8.) Why would we want to begin with the light colors when oil painting?

9.) What's an example of an oil painting medium that dries fast? How about one that dries slowly? Do you know of any others not mentioned in this book?

10.) What should we do if a project seems to be getting difficult?
Part IV

Working From a Reference

4.1) Seeing the Real Thing

Regardless of what medium we're working in, we're limited by our own experience. When we choose a subject matter that interests us, our first attempts to conquer it artistically are bound to be a bit cartoony and minimalistic. The only way to avoid this is to find a similar subject that another artist has already done, and copy it. This is fine if our goal is to make art that looks like that other artist did it, but that's not very satisfying after a while. In art school, students are often instructed to set up an easel at the local art museum and copy some of the old masters; normally they will study a variety of different artist's styles this way. This can be a very helpful exercise, but ultimately the student needs to move on to create their own style.

If we're working in a new subject and need to know more about it, one key step is to work from a reference. Our references can consist of practically anything, except for perhaps someone else's tattoos. There are books available of figures in poses, flowers, animals, almost any subject we can imagine, meant specifically for the purpose of reference. Millions of copyright-free images of everything from fire effects to flamingos are available over the Internet.

We can set up objects on a table and work while looking at them, such as the classic still life paintings; we can set up a human model in the pose of our choice, play light over them to get a good interaction of light and shadow, then either work from life or take a photo and work from it. We can also set up objects in a careful arrangement of light, shadow and composition, then photograph them. If the subject isn't one we can obtain from found objects, sometimes we make our own reference material.

Working from reference has many great benefits. For starters, it offers us a chance to get more accuracy in our subjects, such as animals and human figures, which can be tricky to do without reference unless we've racked up a fair amount of experience. Honestly, there have only been a small handful of artists in history who've mastered the figure enough to get by without any reference and still fool us into not knowing the difference (and not a single one of this handful have yet picked up a tattoo machine!)
Another type of realism that references can help us with is not just in getting the anatomy and proportions of our subject right, but also mastering the light and shadow effects that can give out subject life and dimension. Any subject where we’ve got light playing over a textured surface and a potential for dynamic shadow effects, it’s helpful to use a reference where we’ve set up our subject in a controlled lighting situation and photographed it. That photo can help us not only with the proportions, light and shading, but also with focus and atmospheric effects. In an ideal situation, this can contribute to our control over the piece’s dynamic range.

Last but not least, good reference material is a way of expanding our vocabularies, not just by familiarizing us with new subjects, but showing us new and unexpected things about familiar ones. Even if we already have a stylized way of drawing the subject of our choice that we’re happy with, looking at a reference now and then always will improve our mastery of it. Once again, it’s good to know the rules, so we can break them the right way. And the more we know, the more versatile we become.

4.2) Finding or Creating Our References

For the purpose of your average-sized tattoo or a smaller painting, a found reference can do just the trick. There are countless already-existing images available, such as we discussed in the previous chapter; many are free, and some are available for a small fee. Even books that aren’t marketed specifically as artists’ reference, such as a wildlife encyclopedia or a bodybuilding magazine, can be a great source; it’s legal to use these images in a tattoo, as long as you don’t publish these found designs as t-shirts, flash or that kind of thing. For a few good books on human anatomy and websites with copyright-free images, see Appendix A.

A found reference can also be changed or manipulated, either using a computer or during the drawing process. Different found foregrounds and backgrounds can be mixed, matched and combined. During this process we need to remember not to be ruled by our reference, though, and refer to our own intuitive judgement about what looks good and what’s appropriate in a design or a given body placement.

Ideally we want to create an original piece of art that has a sense of realism, not necessarily an exact copy. Unless we’re doing a portrait or something along those lines, we want to use the reference to gain more freedom. Because when we get enough aspects of a subject accurate, we then have the freedom to interpret the rest of it however we please, and the subject still retains its identity.
toy ray gun to give the piece detail and character.

Since the finished model is of so many different materials, we paint it flat white to make it a better subject for photographing (Fig. 4.2.T). For this we use Kilz, a flat white primer-sealer that will stick to anything, including oil-based plasticene; another good brand is BIN Primer-Sealer. When using either of these products, be sure to work in a very well-ventilated space.

We then set up the model and photograph it, as we discussed in the previous section. We shoot at least 3 rolls, including some close-ups. First, we place two small flourescent units wrapped in blue Saran wrap to either side of the model, creating a clear and readable pattern of blue light and shadow on the piece. Then, while Don shoots the pictures, I hold a yellow incandescent bulb in my hand in such a way to block it from being directly visible to the lens, while still allowing it to shine freely on the model. If I don't obscure it from the camera this way, the bulb will seriously wash out the shot.

I then proceed to hold the bulb in numerous positions while he shoots pictures. I try to create good lighting for each different branch and element in the design, but I find that it isn't possible to light the whole model dynamically in one shot. So the finished picture is actually compiled from several; we use the bottom branch from one shot, the middle branch from another, and the top area of a third (Fig. 4.2.U, 4.2.V, 4.2.W). We also end up using small details from other shots; anything to maximize the lighting effect in the final image (Fig. 4.2.X).
Some subjects just aren’t going to be easily available in existing material. Even if they are, though, there comes that time in an artist’s career when it no longer feels satisfying to use found reference; we want the whole piece of art to be from our own imagination. By using our own created reference, we give the piece more of our own energy, have more control of the way it looks on skin, and give the client the pleasure of knowing that even the photo that we’re working from is an original, created just for them.

The key to creating our own references is to have a good camera and a rudimentary ability to use it. When we use the flash on the camera, we light our subject evenly, making it look flat. Even if we’ve got colored lights aimed at the subject and it looks dynamic and exciting through the lens, the flash will wash all of this out. So for starters, we need a good 35mm camera, such as any of the Canon Eos series, which allows us to turn off the flash. When we do this, the camera calculates a longer exposure to make sure the picture isn’t too dark. We also need a tripod to steady the camera while we take these long exposures— and remember, the less spent on our tripod, the less satisfied we’ll be— cheap tripods are, by definition, Cheap.

The type of lens we use depends on our subject matter. For most subjects, we’ll get by just fine with a standard lens. Sometimes, though, a subject can look much more exciting through a macro lens, which allows us to get much closer. Almost all of the tattoo reference photos we’ll discuss in this book were shot with a standard lens. Many of the paintings, however, were done from reference photos shot with a macro lens, such as (Fig. 4.2.A). If we shop around, we should be able to find a decent standard lens with macro capability— this all-purpose lens will compromise a tiny bit of its quality in being more versatile, but not by any degree that we poor tattooists will ever notice.

The lighting we use when we shoot our photo is instrumental in describing the shapes and creating the mood; it is one of the basic keys to the design. Because it’s so important, we’ll spend a little time talking about it.
First, let's imagine we have a hypothetical subject that we're going to photograph—a deer skull (Fig. 4.2.B). In a consultation with the client we've worked out the basic tattoo idea and have figured out the placement on the body, the composition, and the pos/neg relationships, and we've done a sketch (Fig. 4.2.C). We've also taken a tracing of the client's body part (Fig. 4.2D-4.2.E). The next step will be to set up the subject with the right position and lighting to try to capture the basic essence of the sketch with our actual props.

If we're going for a naturalistic look, we might as well shoot it outside in the natural light. In this case, we have the choice of ambient light, as we'll get on an overcast or hazy day, or direct sunlight, which creates stronger shadows and has different qualities at different times of the day. Most cameras deal really well with sunlight, and it's unlikely we'll even need a tripod. We simply compose our subject to our liking, focus, and shoot. I recommend shooting a variety of shots from slightly different angles, some using the autofocus, and focusing some manually. We can try moving the subject around, getting different lighting effects and variations on foreground/background relationships. It's not unreasonable to shoot a whole roll, even 2 or 3 rolls, to get the subject just right. Often we may find ourselves discovering a whole new approach after the first two rolls, and needing to run out and get more film. The more choices we have, the better.

Sometimes we want more dramatic lighting than we can get outside. To get the most control over our lighting, we need to shoot these types of shots in a controlled situation,
either in a windowless room or at night. Ideally, we want a good working surface, about countertop height, and access to electricity. We also want at least 5 or 6 feet of space in front of the table or counter for us to maneuver our tripod (Fig. 4.2.F).

We can use whatever we want for lights, depending on the look we're going for. Brighter lights mean shorter exposures, but if we've got a good tripod, that shouldn't matter. I've used regular incandescent bulbs including those colored party bulbs. I also regularly use cheap $6.00 18" flourescent tube lights wrapped in colored Reynolds Wrap, about a half a roll of colored wrap per unit. For a more intense light, we can use halogen lights, including the inexpensive garage models, as long as we're careful not to burn ourselves, since those suckers get HOT. I've used cobalt glass dinner plates as color filters for these; it makes for a more satisfying blue than we'll get from the flourescent units, but less convenient.
For our hypothetical deer skull, we’ve opted for a simple blue/yellow combo. Since these colors are so different, the opposition of them as light sources really helps describe the shape, clearly and dramatically. Plus, once we’ve taken the photos in these basic colors, we can always change the color however we want in Photoshop.

Our next step is to place the skull on the counter, possibly on a book or something to raise it up, then lock the camera onto the tripod and aim it at the skull, getting as close as we can without cropping the composition (Fig. 4.2.G). While looking through the lens, we move the skull around until it’s composed in the camera the same way as it is in the sketch. Once we’ve accomplished that, we then move the lights around, looking for the most dynamic combination (Fig. 4.2.H, 4.2.I, 4.2.J).

Sometimes it’s helpful to have an assistant for this part, since it’s not always possible to get the lamps exactly where we want them just by propping them up; often we need a person holding them and moving them for us to really get it right. This is the
time to start burning film like mad; the more lighting variations, the better. When we’re using two different light sources, it’s nice to have a distinct area of shadow between the different colors, rather than letting them mix (Fig. 4.2.K). This way, we won’t get confused as easily while we’re trying to render the tattoo.

We can control our depth of field by adjusting the *f-stop*. This is a control on the lens itself, usually in the form of a rotatable ring with numbers on it. Each lens is different, but the numbers are usually from 4-22, or thereabouts. If we use the lowest number, we’ll get the shortest exposure but the narrowest depth of field—that is, the fewest number of elements will actually be in focus (Fig. 4.2.L). Using the highest *f*-stop, we’ll have much more of the photo in focus, but it requires a longer exposure. For these higher-numbered *f*-stops, we always want to use a tripod, even in good lighting.

After we’ve shot to our heart’s content,
it's time to develop the shots (or download them, depending on the camera) then sift through them, narrowing them down to our favorite one. Sometimes we'll like one part of a shot, but not like the rest, and like most of another shot, but not that one part if we want, we can combine these parts in Photoshop, as we'll discuss later, and still make it look like a single consistent image.

Finally, we size the image to match the tracing, then stencil it. This part is made much easier using a computer, but can be done with a copy machine or a projector. In a later section, we'll discuss different ways of stenciling that may be helpful when rendering a photographic image on skin.

For some types of images, we'll never find what we're looking for at any store, in the woods, or even in a junkyard. At times like these, we can build our subject from scratch in the form of a model, then take photos of it. The model can be made of any malleable material, but my own experience is in using plasticene, which is a kind of modeling clay that stays wet indefinitely.

There are many brands of plasticene available, each with its own properties. Just for its texture and workability, I prefer Venus clay (see Appendix A). It comes in a greenish-grey color, and is by far the smoothest and easiest to work with. Sometimes, though, it's nice to use a white plasticene for the purpose of lighting effects, and although there are several decent brands of white plasticene, none have the beautiful creamy texture of Venus clay.

Before we build anything, we need a solid idea of what we'll be doing; even a relatively simple sketch can be enough to guide us. It will keep us from having to make major decisions on the fly, which is much trickier in the 3-D world than it is on paper. If we're making this model for a tattoo design, we should have a good tracing. For the model we're discussing in this chapter, which is a design for a collarbone-to-knee area, we take a tracing, make a small sketch of the design idea, then transfer that sketch to the tracing itself (Fig. 4.2.M), trying to place each part of the design the best we can for each body part. We then mark a ruler on each side of the design.

In this case, the plan is for my client and I to collaborate on the model, then for me to tattoo it on him. The client in question, tattooist Don McDonald from Pittsburg, Pa., is already familiar with this type of graphic language, making the collaboration appropriate.

After taking the tracing, we go to the workshop and build a box to house our model, which we are building life-sized. This box serves as support and protection for the model, and makes it portable. We then mark rulers on either side of the box to correspond to the rulers on the tracing and full-sized sketch.
If we’re building anything larger than a couple inches, we’ll need to support the clay to keep it from sagging. For smaller models we can use wire or pipe cleaners. For larger ones, I prefer soft copper refrigeration hose, which comes in many different gauges, each with a different stiffness. For a large model, we start with this hose as a skeleton (Fig. 4.2.N), then bulk it out with aluminum foil, scrunching it and packing it tightly into the shape we want (Fig. 4.2.O). It’s best if the surface of the foil is as scrunchy and wrinkly as possible, which will hold onto the clay better. After this, we want to apply a 1/4” skin of plasticene, which we can then build detail onto.

To apply the skin, we cut the clay into thin slices, like cheese, then lay them over the foil and smear their edges together to make them a continuous skin. This might take a bit of fingerwork, since the clay may be reluctant to stick to the foil, but eventually we get the hang of it. This process is easier if the clay is warm; we can heat it by laying the thin slices in direct sunlight, or we can use a space heater and blow hot air on the slices— but if we do this, we have to be sure to do it in a well-ventilated area, since this kind of heating will cause the clay to make noxious fumes.

You’ll notice that the skin of our model is all different colors of plasticene (Fig. 4.2.P). This is because we’re building a large model and want to save the clean white clay for the surface details, so for the skin we use clay recycled from older models. I’ve saved a few of the models I’ve done, but I’d run out of room if I kept them all, so I usually reprocess the clay into the next project. Some of the clay in this model has seen 4 or 5 different projects.
After finishing the skin, the real fun begins when we start adding details (Fig. 4.2.Q, 4.2.R, 4.2.S). Some of the detailing we do with clay, while many of the parts are from the hardware store or cannibalized off a defunct moped. We use different thicknesses of flexible hose, plastic model parts, gears, part of a carburetor, and a sawn-apart
When we are done doing our thing in Photoshop, we print the image life-sized. Since our printer can only handle 11"x17", we cut the image into smaller pieces, print them, and then tape them together. From this full-sized print we make a stencil, using a technique we'll discuss later in Chapter 5.3. The rest is history.

4.3) Doing a Tattoo From a Model

Working with models not only can expand our vocabularies and give our work greater realism, but also will present us with new challenges to overcome. How exactly does an artist use such a thing for a tattoo design? Many of us have done portraits from photos, which is certainly helpful practice for this kind of thing, whether on paper or on skin. This kind of work teaches us to translate a full color or greyscale image down to a simple stencil or tracing, then re-translate it back into a complete image. Although simple in principle, this is actually wide and unexplored territory. I've tried a few different methods myself, which I'll share with you here.

One of the keys to success here is to work with familiar subject matter, at least at first. This way, even if part of the photo is hard to read or we can't make heads or tails of part of our stencil, we can still 'wing it' through these parts, drawing from what we already know of that subject. Once we have a sure-fire method for working from models, we can move on to less familiar subjects.

In (Fig. 4.3.A) we have a rough model of a biomech skull. I built this model with Aaron Cain; we were both quite familiar with this subject. As with the Don McDonald model, we pooled our efforts to not only create a unique hybrid piece of art, but also to make quick work of it (this model took a day, including hardware store trip, moped...
To make the image fit the forearm, we first trace his arm and scan the tracing, making a life-size template. We then use Photoshop to resize and alter the painting, to get the best fit inside this template (Fig. 4.3.V). To make it fit, we change some proportions and move some tentacles. When this is finished, we convert the image to black and white and print it. We draw on this printout, changing some details while reinforcing others. When this is finished, we run a stencil of it (Fig. 4.3.W).

Since we have made the design fit so carefully using our tracing and template, it only takes a couple of tries to get the stencil on right (Fig. 4.3.X). Since it's a familiar subject and we have a clear photo to work from, we don't have to fear getting
lost; nonetheless, we still go around the arm with a marker, clarifying shapes until we know there won’t be any mysteries later. Some of the shapes use a traditional line stencil, but all of the texture is mapped out in positive/ negative areas in the stencil.

This is a good example of a tattoo where we switch between a three, five and magnum many times during the process of initially committing the stencil to skin. We do our best to make the most of the focus and out-of-focus effects, using the different sized needle groups for the different levels of focus. For the most part, we begin with medium tones to block in the basic image, then move down to dark colors and black where needed; I’ve found that it’s easy to use too much black if we lay down a complete foundation with it first before moving on to the color.

The finished piece is a pretty accurate version of the painting (Fig. 4.3.Y). Although we have no choice but to simplify much of its detail, we are able to, in three sessions, capture the basic essence of the huge 62”x78” original.

I have more examples of created references and different stenciling techniques to show you, but since they rely heavily on the use of a computer, it’s probably best if we first familiarize ourselves with Photoshop. In this next chapter we’ll talk about computer basics, do a couple Photoshop exercises, and then discuss ways of using these 21st century tools to expand our vocabularies.
Part IV Review Questions

1.) What are some good reasons to work from a reference, either for tattooing or for other media?

2.) When creating a reference model, what is one of the most important elements, which will affect the appearance of the entire piece?

3.) Why don’t we want to use the flash on our camera while shooting reference photos with customized lighting effects?

4.) What does it mean to use a lower-numbered f-stop? How will this affect our picture?
5.) Why is plasticene great for making reference models?

6.) What makes a good flexible skeleton material for larger plasticene models?

7.) Why do we want to make our aluminum foil innards as scrunchy as possible?

8.) Why do we often want to paint our model flat white before photographing it? What is a good product for this purpose?

9.) Under what circumstances would we want to make our final reference image out of several different photographs?

10.) Why is the traditional line-type stencil sometimes inappropriate for an intricate shaded design?

11.) What's a good reason to use different colored markers while freehanding? What order do we use them in?

12.) What is another style of hectograph stencil besides the traditional line stencil? Can you think of any other ways of doing this?
cannibalization, etc., while the McDonald model took three days). This first photo is of the unpainted piece.

In (Fig. 4.3.B) we've hit the model with Kilz, lighted it, and taken the photo. This particular model is much simpler than the first one we discussed, and although we shoot a whole roll of film with minor variations in lighting, we are able to choose only one photo from the batch, instead of combining several. We only use Photoshop to blow it up to the size of the tracing, which could potentially be done with a copy machine (although using the computer saves us some trouble here).

My first impulse here is to trace the print on tracing paper and translate it into a series of lines, then run a stencil of this line drawing. This is one of my first model projects, so I was drawing from my previous experience, where a design is inevitably translated down to a line drawing, stenciled, then re-translated back up to its finished state. Since there is such a wealth of detail, this is quite a process.

In (Fig. 4.3.C) is the finished tattoo, which takes us ten hours. There is definitely a different quality to this piece than if I had just drawn it out of my head. Since all of the light and shading is in the right place, the lifelike dimension of the piece is uncompromised, creating a strong illusion. Even a single major area of light or shadow in the wrong place, and the illusion might falter. Photo-realism is less of an issue than strong impact, so we go ahead and give bold peripheral lines to the ribs and face, discreetly using thinner black lines where they are needed on some hoses and wires.

(Fig. 4.3.D-4.3.H) shows a similar process, where a photographic image is translated to a line stencil, then committed to skin, using black only in the peripheral lines and using grey for the rest. While referring to the photo, we carefully shade and color the textures, finally arriving at the highlights. Although the results are successful, I believe I made the process more difficult by translating to a line stencil.

We avoid using much black in the ribs, since we want a clear neg on pos relationship with the heavy shading underneath them. The dark shadows push the ribs forward; so do the heavy black dropshadows under the horn shapes. We
use a peripheral outline on the point of the horn to bring it forward even more. The ribs, on the other hand, have no lines (those thin tribal shapes we discussed earlier), but clear black edges, which fade gradually from black into the color of the back-
Black is concentrated heavily in some areas, while avoided almost completely in others, giving the piece a clear overall silhouette. White is reserved for the foreground textures, where it is used liberally; in the background, the few highlights we use are not true whites. The concentrations of detail bring focus to the bones, while the background is kept softer and simpler.

Another method I've used for transferring photos of models onto skin is to draw them directly on, also known as 'freehanding'. This is possibly an inappropriate term here, considering how time-consuming this process can be. But when it comes to sleeve designs, freehanding is very often the best way to get a good fit on the arm.

For this sleeve, we start with a model (Fig. 4.3.I) which is built life-size around a skinny wooden 'skeleton' mounted on a sturdy base. We shoot many photos from numerous angles, using minor variations of lighting to bring out the form and detail. This gives us a library of information to work with (Fig. 4.3.J-4.3.L).
We handle the sleeve in four basic sections, done in seven sessions. In four of these sessions, freehand drawing time is close to equal with actual tattooing time (Fig. 4.3.M). We draw this starting with a yellow Sharpie (which come in two different point widths). Using yellow allows us to scribble quite a bit without causing muddiness problems later in the process. We use yellow to find the best basic flow and layout, trying to fit the arm the best we can, even if it means altering what we see in the photos. The yellow marker gives the freehanding process a good foundation.

Next we draw in orange, refining what we started in yellow. At this stage we're still working out proportions and layout, so we avoid getting bogged down in detail, however inviting that may be. When
we feel the whole area is composed the way we want, we go ahead and rough in some detail. Finally, we crack out a purple pen, and finalize anything that seems to need it. We can switch back and forth between markers, like we do while tattooing, and make use of the whole range of these markers (Fig. 4.3.N).

Notice how the drawing is not all lines; we've actually shaded the whole design, approximating how we want the finished thing to look. Trying to translate this down to lines while freehanding would have made the drawing very difficult to read, possibly leading to disaster.

You'll also notice how part of the design has been stenciled. Some types of images just aren't meant to be drawn on. We can combine stenciling and freehanding to whatever extent we wish; this gives us the freedom and fluidity of freehanding plus the accuracy and reliability of a stencil.

Drawn-on tattoo designs will wipe off far quicker than hectograph stencils. This means that we need to be sure we've committed the design to skin before the marker is all gone. For a lot of this tattoo, we work with a magnum first, then follow up with a loose five. We also use a three for the whirling atom at the top and a few concentrations of fine detail elsewhere in the tattoo.
By the end of the first session, there is enough of the image in place to give us a good starting point the next time we work this area (Fig. 4.3.Q).

A second pass gives us a chance to flesh out the light colors and layer the deeper ones, watching the photos the whole time to try and keep as much realism as we can (Fig. 4.3.P). We avoid black in many large areas, concentrating it in the deepest depths between the layers of the design. Dark and light colors are then concentrated in such a way to give the whole arm a clear silhouette from a distance. Individual detail is given less value range than the larger shapes, as not to clutter the overall flow (Fig. 4.3.Q).

Down at the wrist, we've placed three ribs, giving them strong peripheral lines to pop them forward (Fig. 4.3.R). These ribs curve in a counterflow to the elements passing behind them, creating a simple 3DF8. We also give these background elements less focus by using only the magnum and avoiding bright colors or highlights. The ribs, on the other hand, have sharp details, done with a three, and sharp white highlights. A hint of yellow at the points of the ribs also helps bring them forward from the blues in the background.

By the completion of the tattoo, we've altered the look of the photos in numerous
ways, placing more importance on the flow and readability of the tattoo than on how well we've copied the photos. By acknowledging the S-curve flow of the arm and placing more priority on that then on the details, we ensure an attractive clarity, while the details offer additional reward for the viewer.

Fig. 4.3.S

For the purpose of a large painting, I spent four months building a large model in the garage, almost nine feet high (Fig. 4.3.S). During the course of this, I was asked by one of my clients if I'd be interested in tattooing it on him. The image is a good composition for a forearm, which he happened to have free. With this in mind, I finish the model and do the photo work (Fig. 4.3.T), then finally do the painting (Fig. 4.3. U). By this point I am quite familiar with the subject, and ready to tattoo it.
Part V
The Digital Tattoo

5.1) Basic Computing for Tattooists

These days we have the added capabilities of the computer to make our custom references and designs that much more to our liking. In addition, we can use them to clean up our presentations and look more professional in general. When my wife and I first bought our computer in 1999, we expected it to be useful for making our portfolios nicer and databasing our images for printing and internet use. We really had no idea how much it would empower us artistically and broaden our horizons.

A complete digital outfit for a tattooist should consist of the basic computer (Central Processing Unit, or CPU, keyboard, monitor, mouse), a scanner, a printer, and good peripheral controls, such as a trackball or graphics tablet. There are cheap entry-level machines available from brands like Hewlett-Packard or Gateway where you can pick up this whole outfit for around a grand. If it's really all you can afford, that's fine, it will do the job. But if you're a working tattooist you can probably afford something more powerful, and getting a cheap computer is kind of like using cheap tattoo machines—it can mean more work or expense later.

Many artists in all different media, myself included, seem to be happy with Macintosh computers for their artist-friendliness and powerful processors. The lowest-end Mac is the iMac, which will run you around twelve to fifteen hundred, depending on how fast and well-equipped that particular model might be. Higher-end Macs can run up to around $3500, which gives you about 20 gigabytes of hard drive (enough for one thousand 8"x10" 300 dpi images) and 256 megabytes of RAM, which should be way more than enough. Every six months or so these numbers increase, so depending on how old this book is when you read it, those figures may be way behind what's actually available for that price.

You'll also need the scanner and printer, which start at about a hundred a pop and go up from there. A high-quality standard size scanner runs around $300; a good Epson printer will run you about the same. Larger sized scanners start in the thousands, and an oversized Epson printer runs around $1200, but if you do a high volume of oversized work, it can be worth it. The iMac comes with its own
monitor, but many of the faster Macs don't; a good monitor can start at several hundred, and an oversized one (very helpful for artists!) might begin at around seven and go up to $1300 or so.

For a controller, I don't recommend a standard mouse, which can be hard on the hands and wrists and doesn't offer enough control for fine artistic work. I've had good luck with a trackball, which allows us to do everything with the fingertips, not the whole arm. Kensington makes a few good trackballs- the best ones are the ones with the biggest, heaviest ball and four buttons. We can easily reprogram these buttons so that one is for clicking, one is for double-clicking, one for dragging, and one for Slow Cursor, which gives us a much greater degree of control. Since I need to let my right hand rest as often as possible, I taught myself to use the trackball with my left hand and found that it was remarkably easy. At first I still handed the ball over to my right hand for the more precise operations, but with only a few weeks' practice I actually found myself preferring the left hand for everything computer-related.

Another good type of controller for artists is a Graphics Tablet, which works kind of like a big version of one of those electronic signature-taker things that UPS carriers use. A graphics tablet is usually around 5"x7" and has a pressure-sensitive stylus, kind of like a pen. The pad reads your movements, and the stylus reads how hard you're pressing. This can be an ideal tool for digital artists, and can run $100 and up. The Wacom Graphire is a good entry-level graphics tablet. I have observed, though, that a tablet can be hard on the wrists in the same sense that colored pencils can, since we have to bear down on the surface to make it work. For this reason, I try to supplement it with the trackball, which is more comfortable long-term.

Most Macs come with a built-in CD or DVD drive for reading information off compact disks. These drives do not write CDs, though, and you'll probably need this capability, both for long-term file storage and the ability to send disks out to other people. A CD holds 650 meg, or about 32 8"x10" 300dpi images (300 Dots Per Inch, or DPI, is a standard publishing quality resolution). Check your catalogues for prices; a good CD burner will run around $350, while the blank disks can be purchased for less than a buck apiece.

You'll get the best deal on your computer through the catalogues, such as Club Mac, Mac Warehouse or Mac Connection. If you get catalogues from several places, you can compare prices- usually they're pretty competitive with each other, price-wise. You can look them up on the web for prices too, but only of you already have a computer. Check out Appendix A for contact onto for these suppliers.

New computer users are often frustrated by the setup process. It's easy to become intimidated or confused by the newness and complexity. Just remember that
there are 11-year-olds all over the world that could do it for you in about an hour (not that this fact will necessarily make you any less frustrated!). The setup process is actually pretty simple, especially if you've got a friend or family member who's done it before. Keep in mind that this confusion is a short phase that all new users go through, and we quickly work our way past the hurdles and into being fully functional. Before we know it, we're answering questions for friends of ours who just bought their own computer; more importantly, we figure out how to answer our own questions.

There are countless graphic application programs available, each with their own unique advantages; a single person could never learn them all in a lifetime. For the purpose of us tattooists, the most important program we can learn is Adobe Photoshop. Photoshop can be used like a paint program, where we start with a blank canvas and add colors and shapes using the many tools available. But its real strength lies in its ability to import existing images and manipulate them, which is what we'll explore here.

Photoshop is not a cheap program; a full-blown package of the newest version will run you around $600. I assure you that this is worth it. However, many scanners will come with a stripped-down version of Photoshop called Photoshop LE. This has most of the basic features of full-blown Photoshop, but lacks many of the bells and whistles. We got by just fine with this version for the first eight months or so of owning our computer. If you have a registered version of Photoshop LE, you can purchase an upgrade, which will give you all of the current features for much less than the price of the full package. Like I said, you can get by alright without these, but as you get more experience, you'll want more versatility.

Photoshop has many built-in filters for focus and texture effects, but you can purchase additional filters from a variety of different companies. These programs are called plug-ins, and expand Photoshop's capabilities. Generally, the third-party plug-ins tend to be fancier and more imaginative than the built-in ones. Kises Power Tools is a leader in Photoshop plug-ins; you can look them up on the Web.

Installing programs in our computer is usually a simple matter of inserting the CD with the program on it and double-clicking on the disk icon that appears on the screen. A folder will open with several things in it, one of them called an Installer. If we double-click this icon, we will be led through a very simple set of instructions, and then asked to restart our computer. Once we have Photoshop and our scanner driver installed, we are ready to begin manipulating our image.
5.2) A Brief Photoshop Tutorial

I'll try to be quick here. Photoshop has many tools and menus, we'll only discuss the ones that we use the most in tattoo design preparation or portfolio presentation. I encourage you to explore the menus and tools and to see what you can see; it's a whole world in there.

This chapter will be the most helpful if you already have your computer, you have Photoshop installed, and you are able to experiment with the features we discuss, right there on the screen as we discuss them. If you don't have a computer yet, this section will probably be utterly mind-numbing, and I don't blame you if you want to proceed to the next chapter.

We'll start by making a simple portfolio page from 2 photos. First we place the photos in the scanner and close the lid. Then we open Photoshop; a title page will appear on the screen for a few seconds as the program opens, then vanish. We'll see a toolbar on our left, menu options in the strip along the top of the screen (File, Edit, Image, Layer, Select, Filter, View, Window, Help), a strip immediately below that with a few tool options in it (in versions 6.0 and up), and several other windows, such as the layers palette. With Photoshop running, our next step is to scan our pictures.

We go up to the File menu and then to Import; we'll get a menu of several things, including our scanner driver. This is a program which came with the scanner, and makes it communicate with Photoshop. I've been using a driver called Silverfast (which comes with many Epson scanners) with great success. We click on the scanner driver of our choice, then wait a few seconds while it opens.

One of the options will be Prescan or Preview, which we'll click first. This will bring a 72 dpi image of the scanner bed's contents up onto the screen. 72 dpi (dots per inch) is the resolution of our monitor; it's good enough for the purpose of seeing it on the screen, but not nearly adequate for printing purposes.

There will be a slide bar for choosing resolution of the final scan; for the purpose of the portfolio, we'll choose 480. There will also be a dotted-line rectangle on the screen which you can move around and change its size by grabbing, clicking and dragging its borders; this rectangle is for selecting the area of the scanner bed that we want a final high-rez scan made of. We move the borders so that they frame one of our two photos approximately how we want that picture cropped, leaving a little extra, since we'll have a more precise cropping tool in Photoshop for fine-tuning.
When we've selected our desired area, we go to the top of the screen and click on a button that looks like a little black mountain range. This will open a window that shows a larger black mountain range, called Color Space Compression. There will be three slide bar things at the bottom of the graph; ideally, the one on the left should be at the left edge of the mountain range, while the one on the right should be at its right edge (Fig. 5.2.A). When we move the slide bars back and forth, we'll see the contrast of the image in the scanner bed change. When we've got it where we want it, we click OK.

If our photos are all very similar in quality, such as brightness and contrast, we can adjust the Color Space Compression for a whole batch, and scan them all at once. This can save time, but if some of our photos are more washed out or somehow different than the others, we'll want to adjust and scan them individually. With its Color Space Compression adjusted optimally, even a low-quality photo will begin to show hope.

After Ok'ing the color levels, we click on "scan" or "scan RGB". The actual scanning process can take up to a few minutes; with some drivers we'll see a progress window showing how far along we are. When the scan is complete, the scanner driver will close, and we'll find ourselves back in Photoshop with our image in the middle of the screen, waiting for us to do our thing.

For our portfolios, the pages will be a standard 8 1/2"x11" sheet, with an 8"x10" printable area. We'll print it at 300dpi, which is photo-quality. We scanned our photos at 480 dpi so that when we blow them up to a larger size at 300 dpi, they will still be sharp. The next step is to create an 8"x10" page to place the photos on.

At the bottom of the tool bar at the left of the screen are two overlapping squares; the top one signifies foreground color, the other one is for background color. If we click in either of these boxes, a color palette comes up; we then click in the rainbow stripe to open a given color, then move the circle around in the square box to pick the shade of that color we want, then click OK. For portfolio presentation, we'll normally want either black or white, which offset the colors in the tattoo photo nicely. For our hypothetical 2-picture page, we'll use black. If we plan on filling the entire 8"x10" area with the photo or photos, there's no need to choose a background.
Next, we'll go to File> New. This will open a dialog box where we'll pick the size, resolution and background. Since we want black, and we've set the background color to black, we select Background Color. We then set the size to 8"x10" and the resolution to 300, and name the file "page 1", and click OK. A blank black rectangle pops up on the screen. If there aren't already rulers with inch markings along the top and left edges, we go to View> Show Rulers. The rulers will show the rectangle's size to be 8"x10".

The images of the two photos we've scanned will be on the screen behind the black rectangle; we can get to them by going to Window at the top of the screen, then selecting the photo files, most likely called "Untitled 1" and "Untitled 2". If these images aren't completely hidden by the black rectangle, we can simply click on the visible part to select them. Whichever one we click on will come to the foreground and be the active file.

We can make it bigger or smaller on the monitor by holding down the Apple key and pressing + or -. This changes the size of the view without changing the size or resolution of the file; we can actually zoom in quite close, or make it tiny on the screen. The magnifying glass will make the image zoom closer but leaves the window size the same; if we hold Option while using this tool, it de-magnifies.

The next step is to crop the images. There's a tool near the top left of the toolbar which looks like a weird drafting instrument, a thing with two dark diagonal lines and some handles sticking out of it. This is the crop tool. In older versions of Photoshop, it can be found by clicking and holding down the marquee tool, a rectangle of dotted lines at the tool palette's very upper left. First we select the crop tool, then we go back to our image. We start near one of the corners, click and hold the button, and drag diagonally toward the opposite corner; a rectangle will appear with 8 boxes on its sides and corners. We can grab any of these boxes and move them in or out to adjust the exact size and placement of the box.

We can also move the cursor to just outside the box; it will turn into a curved arrow. If we click and hold the button and drag back and forth, the box will tilt and rotate. Whatever angle the box might be at when we select the crop, it will automatically straighten itself out to 90 degree angles.

For the purpose of this exercise, we're going to crop them a little bit wider than we want them. This is so that after we size them to the correct height, there won't be any risk of them being too skinny. We'll fine-tune the width of the crop after we do the sizing. If we were placing two horizontal images above one another on the page, we'd do the opposite- we would crop their left and right boundaries just as we want them, but leave a little excess at the top and bottom.
When we have the crop boundary where we want it, we double-click anywhere inside it and the image will be cropped, discarding everything outside the boundary. If we decide we don’t want to use the crop tool and we haven’t double-clicked inside it yet, we click on the icon for it in the toolbar; a dialog box will appear with ‘don’t crop’ as one of the options. (In Photoshop 6.0, there are two boxes in the Options Palette with a check mark and an X, which serve this same purpose.) If we crop and then change our minds, we can go to Edit/Undo Crop. Not something we can do with a paper photo.

Undo is a very handy feature, since we’re bound to do things we don’t like to our photos. We can also undo by holding down the Apple key and hitting the Z key. In the full versions of Photoshop, we can undo many moves if we want to by using the History palette, which shows all of the moves we’ve made recently. We can click to select any of these moves as our last move, and it will discard all things we did after that fact.

When we’ve cropped them both, it’s time to size them. For this hypothetical page, we want a 1/4" black border around the images, so we size them both to 9 1/2" high. To do this, we go to Image> Image size, which will bring up a dialog box. First, we check to see that the ‘constrain proportions’ box in the lower left is checked. This means that if we double the height, it will automatically double the width too, instead of stretching it out like taffy. Next, we change the resolution to 300. Just above the resolution is the height and width in inches; we change the height to 9.5.

We then add up their total widths in our head and see how close they come to 7 1/4" total, which will fill the width of the page while leaving a 1/4" border on either side and a 1/4" gap between the two pictures. Since we left a little extra horizontal space when we were cropping earlier, it should total more than 7 1/4".

Let’s say that our imaginary files are 4 3/4" and 3 5/8" inches wide, which totals 8 3/8". To get them to add up right, we want them to be 4" and 3 1/4" wide. Since we cropped them wider than we needed, we know we can lose this amount without cutting into the image. We click on the 4 3/4" file to make it the active window, then go to Image> Canvas size. We’ll see two little slots where we can type in the height and width; we can select if we want to measure in inches, pixels, etc. (For some types of work, it’s easiest to work in pixels- but for the purpose of this page layout, we’ll use inches). We leave the height at 9 1/2", and change the width to 4".

At the bottom of the window is a thing that looks like a tic-tac-toe board. We use this to select which side to crop in from; if we click on the left, it will keep the left part of the image and cut off the chunk on the right. For this exercise, we’ll leave it where
it is, in the center, and click OK. A dialog box will pop up, letting us know that the new canvas size is smaller than the image, and that cropping will occur. We click OK.

When we've sized each image to the dimensions we want, it's time to move them to the 8"x10" black rectangle. While we're in the window for the first image, we go to Select> All. This will put a dotted line all the way around our image. Next, we go to Edit> Copy. This places a file of the selected area on the Clipboard, which is a temporary memory bank for moving images and text. Then, we click on the black rectangle to make it the active file, and click Edit> Paste. A copy of our image will appear, probably in the middle of the page. We then click on the Move Tool, an arrow at the top of the tool bar to the right of the Marquee. We use this arrow to place the image where we want on the page. We then repeat the process with the other image. The rulers at the top will guide us; we can use the magnifying glass to zoom in on the top corners of the page, and place the images with great precision.

Whenever we paste an image onto a Photoshop file, it adds another Layer to that file. Each layer can be worked on separately from the other layers. For instance, if we have a complex background instead of flat black, we can move a pasted image back and forth on top of that background without erasing any parts of the background, almost as if the top image were cut out of a separate piece of paper instead of painted on top of the background. To navigate between layers, we go to Window> Show Layers, which gives us a Layers Palette. This will show tiny mock-ups of each layer. We can click on these mock-ups to select which layer we want to work on, since only one can be active at a time.

We can also use the Move tool to select layers. For this, we go to the tool options bar at the top of the screen while we've got the Move tool selected; there will be a box we can check which says; "auto select layer". If this is checked, whenever the move tool is activated, we can select a layer by clicking on the image itself; in the case of the hypothetical page, if we click on either of the photo crops on the black page, that crop becomes the active layer, and we can move it without having to go to the Layers Palette.

In the course of making our portfolio pages, we can also use the Cloning Stamp to remove hairs or dirt from the photo. This is the tool that looks like a rubber stamp. When we move the rubber stamp to a given area of the image, we hold down the Option key and click. The stamp takes a sample of the colors and textures of that spot. Then, when we move the stamp elsewhere and click without holding Option, the stamp places that sample there. We select the size of the spot using the Brushes Palette, which we get by going to the brush box at the left of the tool options bar, or in older versions, Window/ Show Brushes.

In the brush box will be a black circle, possibly with a soft edge and possibly
with a number. Next to it will be an arrow pointing down. If we click that arrow, we will get a whole palette of brushes, where we can select any brush, then click anywhere in our image to hide the brushes palette. If we click inside the box with the black circle, we'll get a dialog box, where we can customize a brush's size, hardness, etc. We use these brushes with many tools: the airbrush, the paintbrush, the eraser, the dodge/burn tools and of course the cloning stamp.

The cloning tool is great for fixing flaws in a photo; if we have a large, dark area with an unwanted white dot in it, we use Option>Click to select a part of the dark area that's the right tone for the spot we want to fix, then stamp it over the flaw. This is better than just using the airbrush, since it records the film grain, skin texture, etc. and makes the repair job much more convincing than if we just airbrushed it out. We just need to resist the temptation to improve the tattoo.

Another indispensable Photoshop feature is the Adjust menu, with features such as Levels, Hue/Saturation, Brightness/Contrast, and Color Balance. If we want an image to have more contrast, for instance, we go to Image> Adjust> Brightness/Contrast. A window will open up with a couple of slide bars, which we move back and forth to adjust. As we do this, the image will change on the screen. When we like what we see, we hit OK to apply the change. All of the features in the Adjust menu are important; I urge you to experiment with them.

When both images are placed and we're happy with our layout, we go to Layer/ Flatten Image. This makes the whole image into one layer, which takes up way less memory. We don't want to do this until we're sure, though, since once we save a file that way, the original background is no longer continuous underneath the pictures; it's all just one image.

There it is, our first finished portfolio page. We'll save it in a folder where we can find it easily, and use a filename we can remember in case we ever have to use the Sherlock feature to find it.

Even though all we've done is a basic page layout, we're familiar with some of the essential menus and palettes and the Layering Feature, which is one of Photoshop's most important features. With this rudimentary grasp, we can proceed to more complex and exciting things.

5.3) Using Photoshop in the Design Process

Now let's use these tools to create a complex custom image, first with a painting.
in key places. After that, we fill in the rest of the medium and light blues, then move from deep green to lime green, switching between machines as we go.

With the stencil committed, we can take our time laying in the different values of warm colors in the orb, starting with light yellow-oranges and carefully working our way down to red. We exaggerate the value of some of the details from the reference image for the sake of clarity, but not without first starting lighter in value than we want. Only after two sessions have we built the reds to their full depth.

![Image](image_url)

**Fig. 5.3.K**

We reserve primary red and orange for the orb, using magentas as our warmest color in the background. We color the background using a similar strategy to the background in **(Fig. 2.8.B)**, except that this time we leave un-tattooed skin in the rays. We also reserve true white for the orb, using it only in small stipplings of detail on top of yellow and green in the organic stuff **(Fig. 5.3.K)**. Throughout this process, we continuously bear in mind the importance of giving the piece large, clear areas of dark and light for readability purposes, while still respecting the need for a certain amount of detail. The more balanced these things are, the more readable the tattoo.
We end up doing the painting of this image 8"x10", right around the actual size of the tattoo (Fig. 5.3.L). Some aspects of this image, especially the orb, are subtler in the painting than they are in the tattoo. We began this subtle on skin in
the first session, but found that it needing more contrast; it seems that we can get away with more delicate relationships in a painting than in a tattoo. Superstition? Too early to tell. Other than these subtle differences, we do pretty much exactly as we did on skin, spending approximately 10 hours on each.

These methods could easily be used with more conventional subject matter. For example, we could build a clay model of a dragon coiling around a light bulb and photograph it; we could then replace the light bulb in Photoshop with a lotus we cut out from a photo we took ourselves; we can then adjust the Hue Saturation and Brightness Contrast to make the lotus look like a light source. Or we can shoot a Bonzai tree while holding a light somewhere inside the tree, somewhere that creates the most dynamic light/shadow interaction, then replace that light in Photoshop with a glowing bird...

You get the idea. Any subject where we can benefit from having more convincing lighting, texture, focus and shadows is a good subject to try these methods in. Not that I’d discourage anyone from doing fancy geometric stuff, though.

There are many other ways besides these that we can use Photoshop to assist our design process. The piece we are about to talk about, for instance, is a much different use of the computer.

The design idea we are working with is a pair of full sleeves, each an exact mirror image of the other. The foreground for these sleeves is a tribal design, beveled instead of solid black to give it more dimension, and a kaleidoscopic computer-generated background.

A sleeve is always a challenging layout. The flow must be consistent and continuous, without becoming repetitive and redundant. Tribal design has always been largely about layout and flow, so the design process is influenced by the generations of experience in tribal design. The look we are going for, though, is to be more futuristic.

We need a way of easily exploring many layout options, so we begin by photographing his naked arms (Fig. 5.3.M). We run off many 8”x10” prints of them, then draw on the prints with pen, allowing ourselves to be loose and spontaneous (Fig. 5.3.N-5.3.S). Rather than trying to figure out every exact detail of the design, we instead find a good flow and work out our basic strategy.
When we have an essential strategy worked out, we schedule three days in a row and spend the entire first day drawing on him with marker, first with yellow, then orange, the, purple (Fig. 5.3.T). This is an all-day process, requiring a lot of erasing and redrawing. We make sure to leave a few large areas of background so we'll have enough space to put some of that kaleidoscope stuff.

When we're satisfied with the layout, we trace the design off the arm. This can be done two different ways, either by laying tracing paper over the marker drawing and tracing it, or sticking a sheet of clear contact paper over it, smoothing it down, and peeling it back off. The contact paper will pick up a very accurate impression of the marker drawing; we just stick it down to a piece of white paper and we have the whole drawing laid out before us, including cuts and folds made to wrap over the shoulder and other areas.

To make the process easier, we trace the sleeve in several sections, keeping track of what position the arm is in when we trace each part. After taping our rough tracings down to a drawing board, we lay a sheet of tracing paper over them and make clean, accurate new versions of them, using the perfection of the drawing board as an opportunity to make each progression of points even and regular, each arc smooth and as close to perfect as we're able.

We then scan these new versions, and use the Fill feature to fill it in black (Fig. 5.3.U). We do this by clicking on the Magic Wand Tool, setting its tolerance for 25 in the Options Palette, and clicking.
anywhere inside the outline. If the outline is clean and continuous and has no breaks, the Magic Wand will select only the inside of the design. Then, we go to Edit> Fill, make sure the opacity is set at 100%, then click OK.

Once we have the black design exactly how we want it, we apply a Bevel Filter, some which are built in, others available through third party software companies. I was amazed at how different the bevel looked than if I had done it using just my imagination, according to my old tried-and-true formula. These filters offered entirely new ways of handling this job, making for a whole new bevel vocabulary. And it’s really easy to do; we just set the sharpness of the bevel and the angle of the light source, then click OK (Fig. 5.3.V).

We then print out black and white life-size prints of the beveled design and run them through the stencil machine. To our confusion, nothing comes out. It turns out that we have to make photocopies of the prints first; the stencil machine is simply incapable of reading that type of inkjet print (if anyone discovers a cheap printer that stencil machines can read, I’d be curious to hear about it, so I can list it in future editions). After printing and copying them in both directions, we are ready to begin the tattoo.

The next day, after washing the marker drawing most of the way off the arm, we lay the stencils on the arm, using the faint afterimage of the marker drawing as a guide. When we are content with the basic positions, we draw on the connections between the stenciled parts and adjust any areas of the stencil that need it with Sharpie pens (Fig. 5.3.W). We outline the whole thing with a tight three, using black for the
The next step is to design the background stuff. We use Photoshop to Copy a photo of the arm with the marker drawing and Paste it onto a transparent background. We then use the Eraser to clear out everything between the tribal stuff (Fig. 5.3.ZA). After applying a Glow filter to the tribal stuff, we begin experimenting with different backgrounds.

The one we choose is geometric and clearly readable, yet intricate enough to create a vibrating effect (Fig. 5.3.ZB). Using Image>Mode>Greyscale we remove all the color, making the image black and grey. We then use the Dodge/Burn tools to bring out peripheral line and grey wash for the bevel detailing. Since the stencil shows the exact placement of all the key highlights, we make sure to mark their positions with the wash also.

On Day 3 we stencil the other arm, using the first arm as a guide. This proves to be a long process, requiring much checking and cross-checking, stenciling and erasing. After 8 hours, we match the stencil to the first arm closely enough for our satisfaction.

After 2 sessions on each arm, we have all of the black in place (Fig. 5.3.X-5.3.Z). The digital stenciling made this close match possible.
the contrast in the parts of the design that read as grey; we want them to have a clear black-and-white contrast for the stencil machine.

The Dodge/Burn tools are near the lower right of our toolbar and looks either like a black lollipop or a hand with its thumb and forefinger curved into the ‘A-OK’ sign. We use the *Burn Tool*, the one with the hand, for this job. If we don’t see the hand anywhere, we click on the black lollipop, hold the button, and wait for the hand to pop out so that we can select it.

With the Burn Tool selected, we go to the Options Palette and set it to Shadows, exposure 15%. We select a fairly large, soft-edged brush and then move it over the areas where we want the design darker. The Burn Tool will make these parts of the design darker without making the lighter areas darker too; The *Dodge Tool* will do the same thing for highlights.

When the kaleidoscope design has been reduced to a simple pos/neg design, we photocopy it and run it through the stencil machine. The resulting stencil, (Fig. 5.3.ZC), is a very accurate representation of the design— as of yet, it has not been touched by human hands. The only step left is to tattoo it. We start by using the three to fill in the stencilled areas lightly with Starbrite pink, which commits the design to skin without using any lines. We fill them in using small scribbling motions, then carefully skate along the edges, refining each little diamond shape before the stencil is completely gone.

We then layer deeper magentas, lighter pinks, white, and other colors to get it as close to the computer design as we can *(Fig. 5.3.ZD)*. This photo shows it healed, with a fresh layer of blues and whites over the black tribal areas, which had been healed several months.

In this case, many of the effects in the tattoo are designed directly in the computer, such as the bevel and the kaleidoscope design. Although ultimately it ends up being traced out by hand on the skin, the design is clearly not something that could have come about using traditional drawing processes. The computer opens up an exploration of whole new vocabularies; the digital stencil makes new techniques possible. From there, making it into a tattoo really is just a matter of working out the steps.
and then a tattoo. Both of these pieces are of a subject that’s always been a favorite of mine, the Glowing Geometric Orb in an Organic Environment. This is a type of design that uses extreme contrast of value, color, focus, surface type and subject; it’s an opportunity to really max out the dynamic range.

First, we build a paper model of a crystal orb, using a template from a hobbyist’s book on paper star-building, but adding some extra points (Fig. 5.3.A). We photograph it in even lighting, trying to get the whole thing as illuminated as possible, since it’s meant to look like a light source. We shoot a variety of angles to give ourselves plenty of choices.

Next, we build a plasticene environment to float the orb in, making it look like pitted rock, which gives the light a variety of surfaces to play over. We then surround the model with blue fluorescent units and turn on a yellow bulb in the center of the model (Fig. 5.3.B). The weird dark blob in the center of the lit-up area is a piece of paper we put there to keep the bulb from directly exposing the camera and washing out the photo.

We scan the photos separately, then clean them up using the Cloning Stamp. Then we adjust the Levels and Hue-Saturation under the Image> Adjust menu. When we are happy with the clay environment, we save it and move to the orb.

The first thing in our design concept...
10.) What is the difference between image size and canvas size?

11.) What does the cloning stamp do?

12.) What menu do we go to for adjusting the color and contrast of an image?

13.) What are some ways to erase around an image for creating transparent layers? Can you think of any that aren't discussed here?

14.) If we're going to airbrush an area where two layers overlap and we want the airbrushing to be visible in both layers, which layer should be selected in the Layers palette?

15.) If we have an image that's going to overlap parts of a second image, while at the same time being overlapped by other parts of that same second image, what are a couple different ways of handling this situation?

16.) What's a good tool for positioning, resizing and rotating a selected image? Where do we find this tool?

17.) How do we make a layer invisible without deleting it? How do we make it visible again? Can you think of any scenarios where this might be a helpful feature?

18.) How can we turn a digital image into a stencil? How do we make sure it's the right size?
opens the same dialog box we used to set the size of the black portfolio page.

The size of the new file will automatically be whatever size the contents of the clipboard are, so we don’t need to change the size; we just go to the bottom, click ‘background color’, then OK. We’ll get a black rectangle, in this case the same proportions as the orb picture. Finally, we click Edit> Paste. Our orb will appear over the black, filling the window. We now have a 2-layer file; we will use this to erase the unwanted stuff around the orb.

We do this using the Eraser tool, which looks like a white brick in the toolbar. In the Options Palette, we make sure the opacity is set to 100%. We choose from the Brushes Palette a brush size that’s appropriate for the job. In the newer versions of Photoshop, we can see how big each brush is when we move the cursor around in our image; if we’re using the eraser, airbrush, cloning stamp or Dodge/Burn tool, we’ll get a circle that moves around when we move the mouse; that circle shows our brush size.

We’ll customize a brush by double-clicking on it in the brush box. This brings up a window where we can change the diameter and hardness. For our erasing job, we want a large brush with a slightly soft edge, so we make it 150 pixels across, hardness 89%. We then proceed to erase all of the tiled floor around the orb, revealing the black layer underneath. The slightly soft brush edge is good for gliding along the edge of the star without chewing up the straightness of its edges. I’ve found that it’s easiest to get clean arcs and straight edges using a larger brush size, so we only use a smaller brush to get into the small corners where the big brush won’t reach.

Another way of clearing out the background of a straight-edged shape like this is to use the angle lasso. We select this by clicking on the lasso tool and holding the button; a strip will pop up with a couple different lasso options. In the newer versions, this tool has its own button in the Tool palette. The angle lasso is the one with the straight edges.

Then, in the Options Palette we set the feather to the desired amount, in this case 3 pixels. Then we move the cursor to one of the star’s points, click, and move to the next corner and then the next, clicking once each time. When we arrive back at the beginning, we place the cursor at the starting point and click one last time, which will start the dotted line spinning. Finally, we go to Select> Inverse, Edit> Clear. To get rid of the dotted line, we hold down the Apple key and hit D, for Deselect.

Once the whole tile floor is gone, leaving only the orb and its black background, we can place it in the clay environment. We go to Select> All, Edit> Copy. This will place the orb on the clipboard, but not the black background, since the Copy feature
will only copy one layer at a time. Next, we go back to the photo of the clay environment, and click Edit > Paste. The orb appears in the middle of the image, and we use the Move tool to place it roughly where it belongs.

Next, we go to Edit > Free Transform, which places a rectangle with boxes at the corners around the orb, much like the Cropping Tool. By grabbing the squares and moving the boundaries, we can change the size and proportions of the orb. We can also rotate the box, the same way we rotated the cropping tool, or grab anywhere inside the box and move the whole thing. Using Free Transform, we are able to put the orb right where we want it.

There are two places where the organic stuff is supposed to come in front of the orb. When we finish with the Free Transform by double-clicking inside its boundary box, we then select a small brush for the Eraser tool and carefully erase the parts of the orb which are supposed to pass behind those parts of organic stuff, revealing the stuff and bringing it to the foreground (Fig. 5.3.C).

As a final touch, we select the Airbrush tool, choose a big soft brush and set it to 5%, then click in the Foreground Color box in the Tool palette and choose a pale yellow-white. We then carefully add a glow wherever seems appropriate, using a large brush for the big soft effects and smaller brushes to hide small rough spots in the layering job. This completes the reference photo.

The painting is approx. 24"X30". We start by tinting the canvas to a 35% value of warm grey, then project the reference image onto it and trace it with a colored pencil. I've found that it's harder to trace onto darker underpainting tones, so I try to keep this color to 40% value or less for most paintings.

After that, we oil down the canvas and start with the light colors, then work our way down. With everything figured out by using the model, there's no struggle while painting, and the project is finished in less than two weeks (Fig. 5.3.D).
Now let's do a complex tattoo design using these tools. In (Fig. 5.3.E) we have a design that we've scanned from the back cover of a science magazine. In Photoshop, we use the Cloning Stamp and the Airbrush Tool to simplify it, remove some details and smooth it out. We then give it a black background and erase around it, the same way we did with the orb in the previous chapter.

Next comes a photo of our friend the paper orb, this time photographed at an angle that will make it fit right with the shape from the science magazine. That image is chosen in the first place because it's the right geometry to fit around the orb. We shoot a bunch of variations on the position of the orb, just to make sure one of them will fit right. After choosing the best one, we scan it, give it a black background, and erase around it (Fig. 5.3.F).
to fit each other just right. When we're happy with their fit, we go to Layer/ Merge Down, which makes the two halves into one layer without flattening them to the background.

Next, we click on the orb image to make it active, Select> All, Edit> Copy, go back to the black file, Edit> Paste. We use the Free Transform tool to position it and resize it to fit the science image just right. Then we use the Layers Palette to highlight the layer with the science image, go to Select> All, Edit> Copy. We then click back on the layer with the paper orb, then Edit> Paste. If necessary, we use the Move Tool to get it in exact alignment with the lower layer of the same image.

This new top layer makes the orb appear like it's inside the science image. There are five points of the orb that are covered by this top layer which shouldn't be; we use the eraser to extract them, the same way we revealed the hidden bits of foreground organic stuff in the painting in the previous chapter.

The finished orb, (Fig. 5.3.G), ends up being mathematically correct in a way that would be basically out of our reach using conventional drawing methods. It took about a full day of work at the keyboard to get the image to this point. It may be easier to build these kinds of shapes in a 3D modeling program like Bryce 3D, but that's a whole different level of computer literacy which I'm not yet prepared to offer any advice on.

Next, we build the organic environment to place the orb inside, working from a sketch and using wire, foil and plasticene. After scanning the photo of this model, we also scan a tracing of the client's chest. We copy this tracing onto the clipboard, make a new file with a black background, and paste the tracing onto it. Then we use the eraser to clear
out all the areas in the tracing where the
tattoo would go, leaving a circle for the
nipple.

We then go to the file of the model
photo, select and copy it, and go back to
the file with the tracing. Using the
Layers Palette, we select the black layer,
then go to Edit> Paste. The model photo
appears there, underneath the tracing,
about half size and at a funny angle. We
use Edit> Free Transform to make it the
right size, angle and position. When
we're happy with these things, we dou-
bleclick inside the boundary box to apply
the transformation (Fig. 5.3.I).

We save a copy of the tracing with
the photo behind it, then erase the trac-
ing layer by selecting that layer in the
Layers Palette and going to Layer>
Delete Layer. We'll keep the saved ver-
sion with the tracing up on the screen as
a guide to see how much skin we have available; in the meantime, it's easier to work
on combining the orb and the background without the tracing there. Plus, we plan on
using this image for a painting as well, so we want the composition to work within a
rectangular boundary, not just inside the shape of a chest panel.

We then copy and paste the orb, size and position it with the Transform Tool, and
use the Eraser to reveal the parts of the organic stuff that are supposed to come in
front of it. Another way we can do this is to hide the orb layer by clicking on the little
eye icon to the left of its preview in the Layers palette, then use the Lasso Tool to
carefully outline the organic branch shape where it overlaps the now invisible orb.
Next we go to Edit> Copy, then click on the orb layer's eye to make it visible again.
We select the orb layer, then Edit> Paste. Since the lasso outline is still in place, it
isn't necessary to move or adjust the new copy of the branch in any way; it simply
lands right where we want it.

The finished image is now ready for tattooing (Fig. 5.3.I).
The method we use to stencil this image is perhaps the most direct out of the methods we've explored so far. We simply print the image life-size on lightweight typing paper, lay the print over a sheet of hecto paper on a hard surface, and trace it with a ballpoint pen. This method works well on stencils for relatively flat parts of the body, but since typing paper is not as thin and crinkly as tracing paper or stencil paper, it's harder to use over the top of the shoulder and in places like that.

Fig. 5.3.J

While tracing, we make clean lines in the stencil for the orb and the peripheral lines of the organic stuff, but we scribble in pos/neg areas instead of lines to represent the textures (Fig. 5.3.J). This is far better and more intuitive than translating the shading of these textures down to a line drawing, then back up again.

In the tattoo, we line the orb with Starbrite pink using a three, bloodline the rays and smoke, then put in the black peripheral lines with a loose five, building as we go without making a first pass, but making sure to get the edges sharp, like in (Fig. 2.6.ZC-2.6.ZD). Organic, but still clean and consistent.

For the textures, we begin with a magnum using medium and then dark blues, then switch back to the five to sharpen the deep blues and bring them down to black.
Part VI

Tattooing Technique

6.1) Design Transfer: Stenciling and Freehanding

There's not much use in creating the perfect design if we can't get it onto the skin the right way. In earlier chapters we touched on a few different methods of freehanding and stenciling, although we didn't go into any detail on the specifics.

Design transfer is an art form in itself. A good stencil or freehand design will fit the body just right, contain all the necessary information in the simplest and most readable form possible, and hold up long enough for us to commit it to the skin. This isn't too terribly difficult when doing small flash tattoos, but even those need to be positioned just right. This stage is a critical interface between the finished design and a successful tattoo.

There are a number of ways of making hectograph stencils. Those of us who've worked in street shops have no doubt used the standard-issue thermal transfer unit, or Hecto Machine for short. Commonly, it's used for small and medium designs with simple line drawings prepared for the purpose of running through the machine. Most hecto paper is 8 1/2"x11", although it is possible to get 8 1/2"x14" paper. It's usually dark purple, although I've seen it in red.

In (Fig. 4.3.W) and (Fig. 5.3.ZC) we ran pos/neg stencils from black and white images. Basically, any readable image can be stenciled, whether it be lines, shaded areas, or both. We can even use a Photoshop filter to create a halftone of the image, like a newspaper photo, which will read very nicely after running through a hecto machine (Fig. 6.1.A). One tattooist I know says he did some portraits that way, and
it made the project so easy that it almost felt like he was cheating!

The black and white photos in this book are all made into halftone patterns, to help make them more reproducible using a copy machine. Normally, when we run an image with smooth gradations through a copy machine or a hecto machine, the graduated areas will tend to clump and look nasty. An image made into a halftone tends to keep its gradations much better. We do this by first sizing our image to the size we want at 300 DPI. We then go to Image> Mode> Greyscale, which removes all color and optimizes the grey fields. A dialog box asking if we want to discard the color information may come up, which we OK, which will turn the image black and grey. It may also ask if we want to flatten the layers, since we can’t make a halftone from a multi-layered file, which we also OK.

Next, we go to Image> Mode> Bitmap. A dialog box will ask the output resolution, which should be 300 DPI. The Method should be set to Halftone Screen. After OKing this another dialog box will come up, where we set the angle to 45, the shape to Diamond and the frequency to 30 (feel free to experiment with this last number—depending on your printer and your hecto machine, you may be able to use a higher number, which makes for a finer screen). The finished image will be more or less ideal for running through a hecto machine, although you may need to play with the exposure on the machine to get it just right. Keep in mind that when doing this on a computer, the halftone will look grey and indistinct due to the limitations of the monitor. By holding down the Apple key and hitting the minus sign to make the image smaller on the screen, we can see more clearly how the halftone will look when printed.

We can also create stencils by hand tracing them. This is a good system for doing designs which are too large for the hecto machine. An oversized stencil can also be accomplished by carefully taping a bunch of 8 ½”x14” hecto sheets together, but we’ll usually get a higher quality stencil if we hand trace the large stuff.

Hand tracing can also be a good final stage in a drawing. Designs for large areas like rib cages often need to be drawn and redrawn several times to get their flow just right. Instead of erasing, we just lay a fresh sheet of tracing paper over the previous layers, tape it in place, and retrace the design, refining it a stage each time. When we’re at a stage when everything’s worked out and it just needs a final cleanup, we slip a sheet of hecto paper under it and trace it with a sharp pen or mechanical pencil, making the final refinements in the process. If the drawing is larger than the hecto sheet, we just move the sheet around under the drawing as we go. It’s best to trace with a hard surface underneath, like a piece of glass. This requires less hand pressure and allows for more sublety.
We can also hand trace an inkjet print, like we did with (Fig. 5.3.J). This makes it easier to make a stencil based on the natural textures and shaded areas of a reference image. We are able to customize it into our own language for easy readability when working; this is less of an option when running a black and white Photoshop image through a hecto machine. This method is limited, though, by the flexibility of the typing paper, which doesn't stick to the skin nicely the way that stencil paper or thin tracing paper do, making it only appropriate for the flatter body parts.

We apply hectograph stencils by using a tacky, alcohol-soluable film on the skin to temporarily glue the hectograph side of the paper to the skin. If we do it just right, when we peel it up we'll have a sharp, durable stencil.

Many tattooists use Speed Stick or similar deodorant products to apply stencils. I was taught using Speed Stick, and earned funny looks at the drugstore when I purchased a dozen at a time. Speed Stick makes for a durable stencil, but has a few disadvantages that have kept me from using it for the past 7 or 8 years. One is that it's not very sanitary, unless we only use each one once, which seems wasteful. It's also questionable as to whether it helps the healing process to have these additional chemicals driven into the skin. Speed Stick stencils also tend to blur with time, unless we're really good about blotting the excess and keeping it dry. But my biggest problem with Speed Stick is that it kept ruining my paper stencils.

What happens is that the first time we apply the stencil, the paper gets covered with deodorant. This isn't a problem if it goes on right the first time, since we're just going to throw it away or offer it to our client for their scrapbook. But if we need to erase it and try again, we won't be able to test-position it without leaving ghost images in unwanted places on the skin. Since many larger designs need a few attempts to get them right, this can be quite an inconvenience.

A fellow tattooist recommended Dr Bronner's Peppermint Soap, which we were already using in the household for other things. A 30% soap/70% water mix seems to do the job. We keep our diluted soap in an autoclavable squeeze bottle, (Fig. 6.1.B). This makes it easily accessible.

Before gluing our stencil down, we first need to get its position right. We have the option of smearing a film of the soap into the general area, holding the stencil above it, and dive-bombing it into place, hoping to get the position right.
by sheer good luck. Often we won't get the position exactly right this way even after 4 or 5 tries, and we end up compromising and tattooing it that way.

I recommend taping the stencil in place with the skin dry, then gluing it down with soap. Depending on the size and position of the stencil we can do this either in one shot or in two. A one-shot stencil is always ideal, but usually is only appropriate for small pieces.

We start with the area shaved, including surrounding areas, just to make sure nothing gets in the way. We then clean the area with isopropyl alcohol and swab it dry, giving it a few extra moments to air-dry completely.

While it's drying, we prepare the stencil by cutting off all extra paper, and then cutting between design elements anywhere it might give us better flexibility (Fig. 6.1.C). We tear off several 4” pieces of masking or surgical tape and stick them somewhere they’re available, like our client’s chin.

We then hold the stencil in place over the body part. If we’ve done our homework and drawn the piece using a tracing and possibly a photo of the body part, then it should fit pretty much just right. Once we find a position we’re happy with, we tape it securely in place with those short lengths of tape.

For a one-shot stencil, we tape it so that it swings like a hinged door (Fig. 6.1.D). We do this with our client standing in a neutral position, as if they’re waiting for the bus. It's customary to warn them ahead of time that turning their head in the middle of the process can cause a blurry stencil; anyone who’s ever been on their end of this process can imagine how hard it would be to not look.
We then fold a paper towel in quarters and squirt some of that soap onto the corner of it, wetting about a quarter to a third (Fig. 6.1.E). We carefully wet down the area of skin with this soap, (Fig. 6.1.F), trying to get it as even and tacky as possible without any wet puddles, which blur the stencil. When we're happy with the film, we carefully smooth down the stencil with our open palms, smoothing in a direction away from the tape hinges (Fig. 6.1.G).

Before we peel it back up, we check the extremities of the design to make sure they're stuck down well. Sometimes, with larger designs, these areas may be dry by the time we smooth down that part of the stencil, even though there was soap there to begin with. If this happens, we carefully peel back that part of the stencil until we reach the area where it did transfer the right way. We then gently apply soap to the skin and smooth the extremity back down.

For larger or more complex designs, we do two-shot (or three or four-shot) stencils. With the client standing in the Bus position, we tape the stencil down in such a way that we can swing up one side of the stencil at a time, as if there's a hinge
in the middle (Fig. 6.1.H). We want to tape it in such a way that it hinges the most easily; in some cases this will be across the body part, in other cases up and down it.

We then hinge back half of the stencil and wet down the skin area with soap (Fig 6.1.I). After smoothing this side down (Fig. 6.1.J), we remove the pieces of tape. If the stencil is on stiff paper, we move the pieces of tape over to the half that we’ve already stenciled, sticking them down firmly (Fig. 6.1.K). Fresh tape may be needed.
We then swing up the other half of the paper to the point where we expose about 1/4" of the stenciled part. The next step is to wet down the skin for the other half of the stencil, taking care not to blur the 1/4" fringe of stencil that we gently overlap a small amount of soap onto (Fig. 6.1.L). Finally, we smooth down the second half (Fig. 6.1.M).

After peeling the stencil back up, we first check its position on the body, then look over to make sure it's all there. If we need to move it or do it again for any reason, we clean it off with alcohol; try applying some and letting it sit for a few moments before wiping it back off. This short pause gives it time to dissolve.

If we're mostly happy with it, we clean it up with Sharpie pens, darkening the parts that are too light and finishing off anything that didn't transfer, checking the drawing to make sure we get it right. We sometimes combine hectograph stencils with marker drawing, in order to get the advantages of both transfer methods.
Freehanding is a term which has been glorified to a certain extent, with not always the best results. Inexperienced tattooists see an impressive piece in a magazine with the word ‘freehand’ underneath it, then start ‘freehanding’ on clients just so they can put it on their business card. It’s a cool word and it sounds impressive, but when we do it right, freehanding can be as much work, if not more, than a hectograph stencil.

Most freehand designs will benefit from having a sketchbook drawing of the design prepared first. If possible, we do the sketchbook drawings with a photo of the client’s body part, or with the client right in front of us. This way we’re sure to make a sketch that will be an appropriate fit. If we don’t have a photo available, we can try sketching the body part, then seeing how the design will flow inside that part (Fig. 6.1.N). Ideally, we can sketch on prints of a photo of the body part, like we did with (Fig. 5.3.N-5.3.S).

With our sketchbook drawings ready and the client shaved and swabbed, we begin the layout with yellow Sharpie, like we did with (Fig. 4.3.N). It’s good to do this part with the client standing in the Bus position. Since the freehand process will take a while, possibly hours, it’s best to just mark out the basic flow with them standing, then to let them relax in a comfortable position while we take our time fleshing it out with orange, green, purple, black- as many stages of value as we need. Usually yellow, orange and purple will suffice.

Any time we need to erase, we use alcohol, as we do with the hecto stencils. If we need to edit small parts, we can fold a paper towel in quarters, wrap it over our fingertip, wet it with alcohol, and use it as an eraser.

I continue to fantasize about non-toxic alcohol soluable full-color inkjet stencils, but for the time being, the combination of hectograph stenciling and freehanding seems to provide the freedom and the precision to do just about any kind of design. There are no doubt countless other Photoshop features for making better and better stencil-ready black and white images. And of course, we can always evolve with our use of markers on skin. There’s no reason not to consider the design transfer part of the tattoo process as not only essential, but an art form in its own right.
6.2) Needle Groups

Just like the brushes that a painter chooses for their projects, the types of needle groups we use will determine many qualities of our work such as sharpness, softness and richness. We have the option of setting up as many machines as we want, and some tattooists will use as many as five or six different needle groups in a given project. This approach will give a piece more variety of texture, surface quality and detail.

The traditional approach is to use two setups, a 'liner' and a 'shader'. Using a loose five and a seven magnum, we can actually accomplish pretty much everything we've discussed so far, such as bloodlining, greylining, building edges and shading and coloring all different scales of forms and details. Some pieces, though, can benefit from also having a smaller scale of detail, or finer greylines. These pieces usually need a three, a five and a seven magnum.

Usually, these are the only needle groups I use. I find that more choices just complicates the process, and that these three setups can do the jobs of most other groups. This decision was made after trying singles, flats and large rounds as well. However, I occasionally break this tendency; getting too habit-bound might create unnecessary limitations, especially considering the great variety of choices that we have.

---

**Fig. 6.2.A**

*Singles* (Fig. 6.2.A) are one of the trickiest types of needle to work with. If they're not made just right, used in the right kind of tube with the right amount of rubber band tension, it's hard to get them to do anything for us at all. More than any other needle group, the single is prone to dropouts and blowouts. It's a needle group that really takes a lot of experience to get good results with; as a result, there are very few truly good single-needle artists.

**Fig. 6.2.B**

*A three-needle* group (Fig. 6.2.B) will usually do the job of the single, if it's tight enough and the stretch is good enough. We can get pretty tight with a three, but we still want it to poke three holes, not one nasty one. I keep tight threes and loose threes available, depending on the scale of the piece I'm doing. A three-needle line is far more reliable than a single, and when done with a greywash, can serve the same purpose as a single needle line.
I've seen artists use four-needle groups (Fig. 6.2.C), which I suppose would be a good compromise between a three and a five. I find that the three and five are similar enough to each other that I don't find myself wishing I had fours, but no doubt if I had them, I'd enjoy using them and my work would look different in some subtle way because of it.

The five round is an important fundamental needle group (Fig. 6.2.D). A medium-sized piece can easily be lined, shaded, detailed and colored with this group alone. A tight five will make small details, but puts in way less ink per stroke than a looser five. This group can be used for lines or sharp edges, with tight repeated oval-shaped movements or short skating movements, or can be used for soft, feathered gradations, using big, loose light ovals.

Any odd number of needles five or more can be made into a magnum. A magnum is a flat group with two rows of needles, an upper row with a smaller, even number of needles and a lower row with a larger, odd number of needles. There are two kinds of magnums: stacked magnums and spread magnums. A stacked mag is two flat groups soldered on top of each other, making for close spacing (Fig. 6.2.E). I personally have no experience with stacked magnums, so I can't really say anything useful about them except that they'd be more work to make than spread mags. I suspect that they might be hard on the skin.

A spread magnum starts as one flat group with an odd number of needles (5, 7, 9, 11, etc) tacked together at the blunt end, but with the solder only drawn up a quarter inch or so. Then we weave the edge of a razor blade back and forth between the points, making two rows (Fig. 6.2.F). We can vary the spread of these rows by pushing the edge deeper or pulling it back closer to the points. When we have the spread that we want, we draw the solder up to about 1/4" short of the points, which freezes them into this configuration. Any less than a quarter inch, though, might impede ink flow.
For most needle groups, it's good to bring the solder to about 1/4" - 3/8" short of the points. This will keep the needle group rigid and reliable while still allowing for plenty of capillary ink flow action. Some tattooists like to make some or all of their magnums much more flexible than that, so they only bring the solder up about halfway. This is enough to keep the points in approximately a magnum formation, while still allowing for plenty of flexibility.

These folks find that this arrangement is more like a paintbrush. Superstition? Would this decrease the amount of precision possible? Hard to say. I've used five rounds made this way for coloring and liked them quite a bit, although I would have been hesitant to use them for making lines or precise edges.

In all my experience, the spread magnum seems to be the best middle ground between sharpness and looseness, denseness and softness, precision and the ability to really pack it in. Some tattooists work only with the magnum and use it for every part of the tattoo process, getting fine definition along with solid coverage and different levels of focus. It is a truly versatile tool.

A five magnum (Fig. 6.2.G) is great for getting a variety of color effects in small shapes. It can also be used for lines with varying thickness, or detailing small areas of a larger piece. It has a different look and feel from the five round.

A seven magnum (Fig. 6.2.H) seems to be the most versatile size of all magnums. It can get into very tight areas, but is still capable of moving through large, even fields in a short time. If you only ever work with one size of magnum, use a seven.

Larger magnums (Fig. 6.2.I) will cover more area and possibly make it easier to create soft gradations and fog effects. We see this look especially in some French tattooing, and is especially good for atmospheres. A larger magnum will require more spring tension and more power that a smaller magnum, so it may mean having additional machines in our arsenal.
It's possible to make a tattoo look flat when we rely too heavily on big magnums. It's also possible to make a piece look noodly if we rely too much on small groups in a large piece, although a seven mag can be used for all kinds of smooth fields and long gradations. This is definitely my own superstition, but I believe that we should have a full spectrum of sizes; this means that if we're using a five round and an eleven mag, we'd also want a seven mag. This would give us easy use of the full focal range and the range of detail size.

It's important to use tubes that fit our magnums relatively snugly. Not so snug that it binds in the tube, but enough that there's no room for it to flop around from side to side. It's very hard to get any kind of precision when our tubes are too wide. But when they're just right, we can get just as much precision with the magnum as we can with a tight three.

Fig. 6.2.J

We do this by tilting the machine and hitting the skin at an angle (Fig. 6.2.J). We can then tilt the whole operation ninety degrees, so that the bottom face of the tube tip is perpendicular to the skin, with the needles pointing forward in the direction we're moving (Fig. 6.2.K). We can actually create lines this way, although with slightly less precision, flexibility and sharpness than a three or five.

I was first taught to tattoo using six flats (Fig. 6.2.L) for my shading and color. Although not much different from a seven magnum in terms of how many holes we're poking, there's a world of difference in how they handle. Since the flat is almost like a little blade, it 'cuts' the color in, making for a choppy look. It's common for tattoos done with flats to have all kinds of little square corner-marks strewn throughout their gradations.

Fig. 6.2.M

A flat can be spread with a razor into an arrangement where the holes are further apart (fig. 6.2.M), making it a better group for layering color. Unfortunately, when any type of needle group is spread out this way, the needles at the corners of the group end up entering the skin turned somewhat sideways, chopping large slits instead of small round holes. This can cause trauma to the skin.
I've also used larger rounds (Fig. 6.2.N) with limited success. Like a big multi-needle magnum, a large round needs more tension and power than a five round. I found that, in general, the larger rounds created softer edges, almost like using spraypaint. This makes them less appropriate for bold lines than building them up with a smaller group. I noticed this difference even between five rounds and seven rounds, which already start to get too soft at the edges.

Doing good color work with large rounds is obviously possible, since there are some top-notch tattooists using seven, eight and fourteen rounds. But I found that, compared to a magnum, it can be more difficult to get the soft gradations and even fields with the big rounds.

This is partially because the big rounds are packed so densely, and the needles in the center of the group are bound to be going over skin that's already been hit by the outer rows of needles. Because of this, it's easy to create uneven fields of color or even damage someone's skin with a big round.

Somewhere out there is someone who does fantastic work using big rounds, and thinks magnums are difficult to use. I guess it's all a matter of what we're used to. However, the fact remains that the majority of excellent tattooists I'm acquainted with use magnums for most of their projects.

I won't go into any detail about the more exotic groups, such as hollow-tipped elevens or fifty-needle bullet groups or round-cornered magnums. I can't even imagine how to make any of these groups, so I couldn't presume to say anything helpful about them except that, like the stacked mag, they'd involve more work, and we'd like to reserve our energy for the tattooing process as much as possible.

The fact is, there are people doing beautiful work using all kinds of different needles. Many of them arrived at their choices after experimenting with many different needle groups and developing a preference. Many, though, found something adequate near the beginning of their career, became comfortable with it, and built upon it, for better or for worse. Kind of like marrying our high school sweetie.

However, no one will divorce us for trying out different needles. It's easy to become comfortable with anything that seems to do the job; it's even easy to become complacent with the pitfalls of our tried-and-true habits, since accepting those pitfalls may seem like less work than learning entirely new ways of doing things.
New needle groups require new rhythms. The hand will flow differently with a larger magnum than it will with a seven. We feel this while making those tight little ovals when we color. We may also need a different amount of spring tension, more or fewer rubber bands, bigger or smaller coils. When we audition a new needle group, we need to try it with a variety of machines under different circumstances, such as grey shading, color fields or sharp white highlights.

The thing that will affect it more than any of these factors, however, is our own rhythm; this is something we'll only find after a certain amount of experience. It's easy to dismiss something if it doesn't work for us initially. It's totally natural to say to ourselves, "Hey, I know that I can tattoo, and this tattoo isn't going in the way I'm used to- it must be the new needle group!"

This happened to me when I tried out a nine mag for the first time. It was a large piece with big fields of color, so a nine made plenty of sense. But it was a struggle in the beginning; not that it wasn't going in, but it certainly wasn't making things go faster. I kept playing with the power and trying to compensate with the way that I moved. Quite unexpectedly, in around the third hour, it clicked, and I began to really experience the benefits of using a nine magnum.

If we're patient while trying out something new, we may discover something exciting. This new discovery might make new effects possible, or could make tattooing go faster and easier. Not that I'm preaching the easy path here, but the more technical struggle we eliminate, the more we can focus on the art.

When we drive a needle into the skin, we're not just poking a hole; we're also pushing in color. To better understand the relationship between the needles and the skin, try to visualize a needle poking into the skin in slow-motion. The skin parts around the point and spreads to admit the oncoming needle. The skin is elastic, though, and the hole is pulling inward on itself, trying to close, creating friction against the needle. This tightness will limit how much pigment actually makes it into the skin; most will just pool on the surface.

The actual points of the needles can make as much of a difference in the way color goes in as the color itself. Two popular point types are tapered points and straight-milled points (Fig. 6.2.O). Both types are available to tattooists and both seem to put the color in, but most artists seem to prefer the straight-milled points, including myself. Apparently the ridge where the straight shaft ends and the taper begins helps to push some of the color in.
Needle gauge will also make a big difference. "The smaller, the better" could be an easy assumption to make, and there has been a certain amount of romanticism about super-fine entomologist’s pins, or ‘bug pins’. However, it’s easy to visualize how this would actually mean less color making it into the skin. This can be helpful and appropriate in some cases, such as superfine grey washes or single needle work, but I can’t speak from personal experience here.

It seems that most tattooists prefer 00 gauge needles for most general purposes. This includes myself and most everyone that I know. There is a quick guide to needle distributors in Appendix A.

For coloring, I’ve had excellent luck with carbon-tipped needles. These needles have more texture in their points than plain stainless needles, making them super handy for driving in mass quantities of pigment. I wouldn’t dismiss this as superstition, either, since many folks I know have had a similar experience.

The conservative part of me is cautious about carbon needles in groups that I might do lines with, since they may cause blowouts to happen more easily. I’ve had five rounds made with both types of needle, but the jury is still out. For now, though, I wholeheartedly recommend making your mags with them.

Carbon needles require an extra step of care. Unlike stainless needles, they can rust, so we need to handle them more carefully. When we remove the ungrouped needles from their paper envelopes, we should use tweezers, since the oils from our fingertips can oxidize the rest of the contents of the pack if we don’t use them all immediately. Then, when we’re done tacking them on the bar, we need to dip their points to prevent oxidization.

We can use many different agents for this: Vaseline, glycerine, mineral oil, even cooking oil. Basically, anything which will keep air off the metal; if oxygen can’t reach it, it can’t rust. We need to dip our needles as soon as we’re finished with them, regardless of if we plan to ‘clave them right away or not.

It’s normal for an occasional carbon needle to go bad, despite being dipped. For me, it’s about one in twenty-five, if even that, but at first it was more. Most carbon needles will leave a tiny brown stain on your paper towel if you clean their points with alcohol, which is normal; you’ll know a bad point when you see it through the eye loupe.

If this seems like an added set of complications, I want to assure you that it’s very worth it. The difference between carbon and stainless is like night and day. Picture stabbing a loaf of bread with a knife soaked in hot butter; the butter would mostly pool.
on top of the crust. That’s stainless. Now picture doing the same thing, except with a circular file soaked in butter instead of the knife. You get the idea.

Another benefit of using carbon is that they’re much easier to solder together than stainless. A small benefit, but this stuff adds up.

6.3) Machine Setup

All tattoo machines are not created equal. It’s a natural enough assumption to start an apprentice tattooist out with a pair of base-line, entry-level catalogue tattoo machines, probably for $125-$150 apiece. That’s how I started, and that’s probably how most tattooists begin (not counting experiments with hand-poking, cassette motor machines, etc). It seems to make sense to begin this way, especially considering all the other costs involved in getting started.

After the first year and a half or so of working with these base-line catalogue irons, I began buying some nicer machines. The difference was like night and day! My lines, which had always healed light or dropped out, began coming out crisp and dark on the first shot. Color flew in and healed richer and brighter. Where I was used to a light, sickly rattling drone, I was now hearing and feeling a smooth, confident hum.

I’ve also found that machines made from better parts and materials will stay in tune better and hold up to wear and tear better than cheap machines do. And, for the most part, we’re still only in the $200-$325 range.

It’s true that a good tattooist can fidget with almost any machine to the point where it will work well enough that they can tattoo with it. There’s no reason not to find some way to get those cheap machines to hum nicely. But the fact remains that the materials the frame and coils are made of will make a big impression on the performance, and some commercial machines are not only made of cheap materials, but are also engineered badly.

It’s good to fidget with old machines, strip them down and put them back together, change the springs and the points and all that. It’s nice to have cheap machines just to tinker with; some manufacturers even have inexpensive kits just for this purpose. If you’re apprenticing with someone experienced, chances are they have all sorts of old machine parts laying around that they might hand over to you for the purpose of experimentation. But ultimately, when it comes to applying our art to skin, we don’t want anything to compromise what we’re doing. We want good, reliable workhorse machines that we can always count on.
Part of becoming a tattooist is learning to feel the nipple on the armature bar for the right kind of hum. Ideally, we do this with a tube and needle in place. We hold our machine backwards, as shown (Fig. 6.3.A). We dip the needle in water to lubricate it in the tube; it will run much differently dry.

With the machine running, we place the pad of our thumb lightly on the needle bar, so lightly as to barely slow it at all, with the nipple striking it and bouncing off it on each inward stroke (Fig. 6.3.B). The strength of the nipple striking our thumb repeatedly should be much greater than the pressure we're exerting on the needle bar. If the machine is running right and we use just the right amount of pressure, the machine will slow down the same amount that it would if the needle were striking the skin.

With the tip of our thumb, we'll feel the smoothness and strength of the stroke. This is a good way to hold our machines while tuning them or adjusting their power. If we always hold our machines the same way and use the same amount of pressure on the armature bar with our thumbs when tuning them or adjusting them, we'll have a reliable way of evaluating how a machine is running.
When we’re at conventions visiting enterprising machine builders in their hotel rooms and checking out their wares, we can’t always have a needle, tube and cup of water to evaluate it. Instead, we hold the machine by its tube vise and feel the nipple with the thumb on our other hand (Fig. 6.3.C). By holding the tube vise only, we minimize how much we dampen the machine’s vibration with our hand.

With some experience, we learn to find that magic hum that we prefer, and to tweak it by turning the point in or out, playing with the power, adding and subtracting rubber O-rings and that kind of thing. We can learn more about machine tuning by attending one of the better tattoo conventions and enrolling in machine building and tuning workshops with some of the world’s top tattoo machine builders.

In Chapter 2.6 we talked in some detail about tuning the machine to run in such a way that we can work with it like a pencil. This involves a long stroke and soft spring tension, usually running the machine at low power.

We adjust the stroke by widening the gap between the spring and the point, usually by loosening a lock screw and turning the point screw counterclockwise (Fig. 6.3.D). We open it to about the thickness of a U.S. Nickel, then tighten the lock screw.
Ideally, the back spring should have just enough tension on it so that the front spring just barely touches the contact point. This allows the coils to pull the armature bar down with a minimum of charge built up, making for a faster, softer stroke. For driving larger needle groups, we put on additional tension, which requires more power to pull the armature down, making for a more powerful 'slap'.

I believe that we should use the least amount of spring tension that we can get away with. This lets us work an area longer, spending more time making a line perfect, layering the color more for a more painterly look. It gives us more control over how the color goes in with the least amount of trauma to the skin, making it especially helpful when building up lines. And if we ever just want to cruise through a large area, we can always turn up the power.

To add tension to the back spring, we first loosen the screw or Allen bolt that holds it in place, then swing it out, away from the contact point (Fig. 6.3.E). Then we pull up on it, gently adding a small amount of tension at a time (Fig. 6.3.F). Each time, we swing the bar back into place, tighten the screw, and see if it needs more; if it does, we repeat the process.
We can add tension to a spring, but we can’t really subtract it. If we bend the metal one way and then the other, we create a subtle crease which quickly deteriorates the strength of the metal when we run the machine, causing the spring to break. By adding the tension a tiny amount at a time and testing it each time, we can find the right tension without having to bend the spring back and forth.

Many of the better machines will come set up pretty much just as I’ve described (For a few machine recommendations and referrals, see Appendix A). Still, it’s good to carefully play with our machines now and then to see what they can do. Even a quarter turn on the contact screw can make the difference between good and perfect. Without too much trial and error, we should be able to find out what ‘perfect’ means, and keep our machines relatively close to that.

The rest is up to us, and to our technique.

6.4) Rubber Bands

How smooth our machine runs can also be affected by our rubber bands. Usually we need two or more rubber bands to keep our needles from bouncing around. The larger the needle group, and consequently the more power, the more rubber bands we usually need to keep them consistently riding the back of the tube. At the same time, we need to be careful to use as few rubber bands as we can, since too many will cause the machine to have to work harder, costing us smoothness.

With a little trial-and-error, we eventually figure out how many rubber bands we need for each job. I’ve found that normally two is sufficient when I’m using a three, which is usually on a lightweight Mickey Sharpz Microdial. When I use a five, two will often work, but sometimes I need three. With a seven mag, three is often sufficient, but there are times when I need four.

When setting up a magnum, I’ll use four rubber bands. Three are placed in the normal spot, holding back the needle bar, while the fourth is kept in reserve behind the contact screw, placed in such a way as not to interfere with the movement of the front spring. If I begin tattooing and the needles are skipping around, I can snap that rubber band into place without stopping, taking the bag off the machine, unplugging, etcetera. I use this same strategy when setting up a five, but with one less rubber band.
The rubber bands should be spaced slightly apart from each other on the needle bar. If they're tangled together (Fig. 6.4.A), this will slow the machine down or cause it to run unevenly. It also seems helpful to have them angled slightly towards the contact screw (Fig. 6.4.B), which seems to give the stroke of the machine a little extra snap.

Sometimes the rubber bands will re-arrange themselves over the course of a tattoo. It is occasionally necessary to 'tweak' them, making sure that they aren't tangled up and giving them that slight angle. To accommodate this tweaking, it's nice to use loose, flexible baggies, since the stiffer bags which are often marketed for covering tattoo machines make it very hard to do anything at all with the rubber bands. This may cause us to neglect the need.

Admittedly, rubber bands are one of the least exciting things about the tattoo process, but they can have a dramatic impact on how the machine runs, and therefore how the finished tattoo looks.
6.5) The Stretch

Throughout our apprenticeships, we get to hear the person we’re learning from admonish us for our stretching methods again and again. Shut Up, we think to ourselves, I’m Trying To Tattoo. The whole stretching thing can seem like a real inconvenience, and we can’t wait till the boss decides we know what we’re doing and leaves us alone so we can crank up our machines and get on with the business at hand.

For the most part, we develop enough sense for our stretch so we can get by. Usually we can notice the considerable difference between trying to work without a good stretch and tattooing with one, so we incorporate the stretch into our work habits. Eventually, we stop having to think about it, and we can get on with our work.

If this were really the case, I wouldn’t even bother with writing this chapter. However, the stretch is such an important and integral part of the tattoo process that, even after twelve years of tattooing, I still need to remain constantly aware of the status of my stretch.

Now this isn’t just a simple matter of good-stretch-means-good-tattoo, bad-stretch-means-tattoo-fall-out, although that is partly true. One of the most important features of the stretching process is in the fact that our stretching hand can feel the vibration of the needle striking the skin, allowing us to monitor the quality of the strike of the needle, how fast, how hard or soft. It is one of the most important keys to having control over the medium.

If our stretch is good, we will be able to feel the needle’s vibration as it strikes the skin. The tighter we stretch, the more we will feel the vibration. Sometimes we will think we have a good stretch but we aren’t feeling that vibration; this is a sign to reposition and try a different stretch. If we aren’t feeling that vibration, we can’t really be sure of what the needle is doing. It may be bouncing off, or we may be burying it to the bone. What we feel with our tattooing hand is just too far removed from the actual penetration of the needle to rely on; we really need to feel it with our stretching hand.

This will affect how fast we can work, how much it will hurt, how it will heal, how sharp our lines are and just about everything else. No matter how experienced we are, we can never afford to take the stretch for granted.
So what makes for a good stretch, anyway? We'll start by eliminating bad stretches. For starters, let's try to avoid using the brute force method whenever possible. We may need to really lean into someone to get a good stretch on the back of the tricep or certain parts of the abdomen and thighs, but for the most part, we can solve this problem by getting the client into a better position. Secondly, let's do our best to avoid using the old-timer 'Iron Fist' limb-bruiser method, where we reach behind the limb and pull with our thumb and fingers (Fig. 6.5.A). This method will not only hurt and create bruises, but makes for an inconsistent stretch.

Ideally, what we want is a three-point stretch. We get this by pulling outward from the area we're working in three directions using our thumb, fingers, and the heel of our tattooing hand (Fig. 6.5.B). This method will stretch the area tighter and more uniformly than most other methods. We do this by first placing our thumb and fingers where we want them, and begin stretching. Next, we plant the heel of our tattooing hand firmly on the skin, slightly closer to the spot we're about to tattoo than we actually want it. We then rock the heel of the hand outward, stretching the skin in a third direction (Fig. 6.5.C).

This will give us a tight spot about the size of a silver dollar, which means that we need to constantly adjust and re-stretch as we progress around the tattoo. Instead of seeking ways that will stretch a larger area, which always compromises the quality of the stretch, we try to get into a good habit of re-positioning and re-stretching quickly and efficiently. After a while, we stop even noticing we're doing it; all we pay attention to is the vibration that the stretching hand is reporting back to us.
When a good three-point stretch is either not possible or not adequate, we can supplement it by either positioning the client better or having them actually help with the stretching. The need for a third hand is rare, but especially with some heavier folks it can be helpful to have them lend a hand. For instance, if we are doing a chest panel, we can have them pull at one end of the chest, adding tension to the whole area. We then supplement this with our own three-point stretch, giving us outstanding skin tension (Fig. 6.5.D).

The position that our client is in can make a huge difference to the stretch. A good example of this is the lower back. We may assume that it would be best to lay them face-down on a massage table to work this area, but in reality, this causes the skin of the lower back to compress, making our job harder. Of course we can work on them in this position, and in some cases it might be preferable. But if we have them straddle a chair and bend forward, we'll see the stencil on their lower back almost double in size. This gives us an idea of how much that can help the stretch.

A comfortable way to set them up for this is to use a tall chair (so we can get at their lower back without sitting on the floor) and give them a stool or crate to place their feet on. Sometimes, an armrest with a pillow is nice to help them relax (Fig. 6.5.E). This position can actually be quite comfortable for relatively long periods, provided we get it right.
If we’re working the back of someone’s tricep near the armpit, we usually run into a challenging stretch situation. We can make this easier on ourselves by having them reach across their chest and grabbing their other shoulder (Fig. 6.5.F). This tightens the whole area.

We can get a good stretch on even the most stubborn parts of the body if we use the right position for both our clients and ourselves. We can make it even easier by first making sure that we don’t have petroleum jelly smeared all over the areas we’re trying to grab for the stretch. This may be slightly less comfortable for them, but we can’t be expected to get a grip on things if they’re sliding around in our hands. Usually it’s good to keep a really light coat of lube on the whole thing, almost dry, except for stenciled areas we haven’t reached yet; we then use more generous amounts in the area we’re tattooing and any light colors near it that we want to protect.

Sometimes our stretching will threaten the well-being of parts of our stencil or freehand drawing. We can accommodate this by placing a paper towel over that area, then stretching with that paper towel (Fig. 6.5.G). This can even help us to get a better grip. We have to make sure that the paper towel is clean and dry, or else it may make the situation worse. We also want to make sure it’s folded neatly in half or in quarters, since a scrunched towel will tend to wipe off parts of our stencil.

I could go into such maniacal detail on The Perfect Stretch that you’d all fall asleep; it’s not exactly a subject that most tattooists find particularly exciting. Three or four pages is enough. If we’re conscious of our stretch, we’ll do better tattoos. Everyone knows that. More importantly, though, is our ability to feel the needles with our stretching hand. If we pay attention to that vibration, we can control how the color goes in. Pretty boring, but super important.
6.6) Tightening and Softening

We've gone into some detail already about using the five round and other smaller needle groups for more than just lining. We've demonstrated the process of switching back and forth between machines to get a variety of different effects. I'd like to take this opportunity to elaborate a little on this subject.

In the most basic kind of tattooing, we start with a 'liner' group for the outline, then finish off the tattoo with a larger group for the shading and the coloring. This is such an accepted standard that many quite sophisticated designs are still tattooed in this manner. With these kinds of pieces, it's normal to see a ragged fringe of skin between the outline and where the shading begins (Fig. 6.6.A), since this is preferable to going over the line with the shading.

If we slow down and take our time, we can fill in this fringe using our magnums, working with the machine at an angle and doing our best not to chop up areas we've already filled in black. This can be a tricky, finicky job to do with a magnum, and many tattooists skip it.

It takes very little extra time, though, to switch back to a smaller needle group and use it to fill in that gap. Not only does a three or five round fill the gap easier, but it allows us to really sharpen and smooth out the edge of the line. It's simply a better tool for the job than a larger group.

During this stage, we not only fill in unwanted gaps between lines and shaded areas, but we work on detail, adjust arcs and edges and refine anything that needs refinement. This stage can actually be one of the most fun parts of a tattoo, and doesn't have to take much time at all.

I'll switch between machines many times in the course of a tattoo to make the most of the strengths of each type of setup. If I'm doing a full-color piece with a five round and a seven mag, I'll often follow an itinerary something like this:

1.) Using the five round, rough in the outline and edges of the design. Much, if not most of the piece is greylined or bloodlined.

2.) Using the mag, rough in black shading and some color such as deep and medium purple and blue. Often I'll lay down quite a bit of color before brushing over parts of it with black. With deep cool colors, staining is barely an issue at all.
3.) Switching back to the five round, build up lines where line weight is desired, sharpen edges and arcs, develop detail using black, deep and medium cools.

4.) Switching to the mag, rough in all medium and light colors, especially warms, except for pure yellow and white.

5.) Back to the five; sharpen and develop medium and light colors.

6.) Back to the magnum. This time, pack in the yellow and large white highlights.

7.) Switch back to the five. Tighten yellow; use round needle group to bring it sharply against edges and into details, saturating areas too small to really work with a big group. Rinse really well, tighten white highlights, use white for texture and detail; skim over big white highlights done earlier with the mag, make sure of saturation and evenness. Done.

This is the most basic machine alternation I'll normally use; it's a good all-purpose method for a full-color tattoo. If it's a larger piece, I may skim over the basic stencil, then work small areas to completion, each time running through steps 2-7.

This can add up to a lot of switching. A third or more needle groups can complicate the process even more (I enjoy using a three to finish off my white highlights after doing them with larger groups, for instance). We can make this easier on ourselves by using a power unit with three different machine settings (see Appendix A). Normally, this kind of power unit will have a switch with three settings for Machine 1, Machine 2 and Machine 3. When we begin working (for instance, roughing in the line with a three) we have the unit set on Machine 1, and we adjust the power accordingly. When we switch to a five, we set it on Machine 2 before adjusting the power; likewise for the magnum and Machine 3.

Now, if we switch back to our three, instead of grabbing the rheostat knob and slowly finding exactly the right amount of power, we switch back to Machine 1. Miraculously, the unit will be set for wherever it was when we were last using that machine setting. Basically, it has a 'memory' for three machines. This saves us a lot of fiddling and will encourage more freedom when it comes to switching back and forth between our setups.

A lot of the tightening process is based on those pencil-like hand movements we discussed earlier. We use these movements to refine lines and edges, as we did in Chapter 2.6. Using these same hand movements, we can accomplish any effect we want.
If we want a clear, sharp edge on an area that we've first outlined and then roughed in with a magnum, we first have to fill the gap between the shading and the line (Fig. 6.6.B). Using a five round, we begin by running along this gap in short overlapping ovals (Fig. 6.6.C). Next, we skate along the outer edge in short, smooth strokes to make it as clean as possible and refine any arcs that need it (Fig. 6.6.D). Finally, we use bigger overlapping ovals to merge the sharp, dense edge with the area already colored with a magnum (Fig. 6.6.E). This method is very similar to the tightening techniques shown in Chapter 2.6.

In (Fig. 6.6.F), the design is drawn on with Sharpie pens, first using yellow and then a darker color. Then, in (Fig. 6.6.G), we've roughed in the basic line with a five and shaded black with a magnum. You can clearly see that ragged gap we were discussing earlier, and how that gap would be easy for us to accept if we wanted. The normal imperfections in the lines are also visible.

Next, in (Fig. 6.6.H), we've tightened the piece with the five. This takes maybe 20 minutes or so. During this process, we are able to sharpen and darken all edges, perfect our arcs, then add depth to the organic textural detail. This process is repeated with the deep and medium colors (Fig. 6.6.I). Finally, we lay in the yellows and whites, and sharpen the white highlights with the five (Fig. 6.6.J, 6.6.K). The resulting look is clean and smooth.
Sometimes we'll desire the opposite of sharpening, and want to create soft edges. We especially run into this with smoke and atmospheric effects.

Usually, if we're going to have negative-space smoke passing in front of a design, we'll first bloodline the basic flow of the smoke, then pull the background color up to that bloodline, leaving the flow of skin blank. If we let the color soften and drop out as we approach the bloodline, the smoke will look softer and more transparent than if we bring the color right up against the bloodline, which can make the smoke look kind of 'cut out'.

If we begin by letting the shading and color drop out as we approach the bloodline, we can improve the smoothness and softness of the effect by brushing over the bloodline area with big, loose ovals, using a soft atmospheric color such as lavender or slate blue (Fig. 6.6.L). This color should be just a hair deeper in value than the skin tone itself.

Next, we use a richer color, such as medium purple, to make a transition between this light color and the background. We dip back and forth between the medium and light colors to make the gradation between the background and the negative space as smooth and soft as possible (Fig. 6.6.M). This is a good opportunity to use color to reinforce the movement of the negative space and make it fluid.

Fig. 6.6.L  Fig. 6.6.M

Sometimes the soft gradation effects are delicate enough or specific enough where it helps to use the five round for a quick once-over when we're done with the
magnum. Using low power and loose, light movements, we can fine-tune any aspect of our gradations we want. The five can be used to create quite delicate effects, if we tune it soft and use just the right touch.

Tightening and softening techniques are very similar to techniques and hand movements we use when painting. By using our tattoo equipment in the same manner as paintbrushes, we can make our work look like it was painted on skin.

6.7) Comfort Pointers

The comfort of the client is often not really discussed in a basic tattoo apprenticeship. In your everyday street shop situation, most of the tattoos are done and out the door before the client’s comfort really becomes an issue. For that matter, neither does ours. When we do quick tattoos, the pain of the needle is more than enough to take our clients’ minds off of their slightly uncomfortable position.

When we do larger custom work, though, body position can become a real important factor. If someone we’re tattooing is uncomfortable enough, it can actually aggrivate the pain of the needle, making them twitchy and restless. Even if we don’t care at all about their suffering and we just want them to sit still so we can work, that can be too much to ask of someone who’s sufficiently uncomfortable.

In an ideal situation, the client is adjusted and propped up in a way that is comfortable and will remain so for as long as we need, in a position where we can work in an ideal posture. If they can relax, we can work more efficiently and get more into what we’re doing.

We have many different types of chairs and tables for the purpose of client positioning: basic office chairs, which raise and lower, giving us flexibility; barber chairs, which can be quite comfy for some positions, but totally unappropriate for others, and they’re too heavy to move; massage tables, some with face cradles, for bodywork where it’s more comfortable to lay flat; slantboards, when a forty-five degree angle is preferable, especially for lower backs or chest panels; and a whole array of different armrests, leg rests, foot rests, stools and complex multi-adjustable Swiss Army table/chair/body accomodation things.

Personally, I’ve worked very little with barber chairs. I’ll admit that they’re great for comfort, but their weight and inflexibility have always kept me from actually purchas-
For years, tattooists have played around with different lidocaine or xylocaine types of numbing creams on their tattoo work. These different concoctions had a limited amount of success; even though they didn't make the pain go away, they gave a small amount of relief, which can be all that's needed to get a client through the last painful part of a session. Recently, a number of new products have popped into the tattoo marketplace that are quite a bit more effective.

Some of these substances, such as Prepcaine and Ela-Max, are meant for pre-numbing the area. We do this by smearing on a generous thick coat over the area and then covering it with plastic wrap for an hour or so. The skin will then be almost totally numb for about half an hour, and will regain sensation gradually after that, returning to normal after an hour or so. This can be helpful in a small area, or if we just want to skim quickly over a larger area to poke enough holes that we can switch to other types of numbing agents. If we need to lay a complex stencil over an area we've just pre-numbed, we may use up most of the effects of the substance during the stenciling process. People sometimes remark that the pain comes back with a vengeance.

Other substances are useful on areas where we've already broken the skin. One popular product is called Bactine, which can be found at almost any drug store. It is a watery consistency, and we can use it the way we'd use the water on our paper towels. Apparently if we use enough of it, the area gets quite numb, and so far there haven't been any reports I know of where it's affected the healing.

One of the most popular numbing products on the market is called Sustaine. This is a tetracaine-lidocaine-epinephrine cocktail suspended in glycerine. If we work an area sufficiently and apply this stuff, let it sit a few minutes and then wipe it off, the area will be almost totally numb. Spots like the armpit or the ditch of the elbow get so numb that people start laughing, unable to believe it. It basically feels like someone is holding thick leather over your skin and tattooing the leather. No kidding.

Sustaine lasts about two hours and can be reapplied. If we break the skin using a prenumbing gel and then switch to this other type of product, in theory we could do a totally painless tattoo.

There's a catch, of course. The epinephrine causes the capillaries to freeze and constrict, stopping blood flow. This can be a plus at the time, but it appears to affect the healing in an adverse way. In addition, the glycerine base fills up the pores and softens the skin in a weird way, making it feel cold and jellylike.

To make the most of our numbing gels, we want to keep our number of applications to a minimum, using it only on areas where we're actually about to work, not on
the whole tattoo. After letting it sit for a few minutes, we want to make sure we've wiped it off as thoroughly as we can before we start tattooing again. That means fresh wet rag, wipe thoroughly, toss rag; second fresh wet rag, wipe again. Maybe repeat a third time. You know, thorough.

If we do this, we can keep the ill side-effects of these products to a minimum. I must say, though, that even taking these precautions, it's still not unusual to have a rough heal after using Sustaine. When I say rough, I am referring to thick oatmeal-cookie scabs, oozing pits and trenches, that kind of thing. For this reason, I don't use it on overseas clients or other folks I might not be able to hook up with again for a touchup.

Several companies are marketing numbing solutions which are basically just lidocaine in alcohol. Some even recommend dropping a small amount in our inks. I tend to be suspicious of this approach, although I can't give any good reasons for this. I would suggest, though, that we could use a small spray bottle to apply this substance over already-open skin. It may give us numbing effects without the disadvantages of the glycerine or the epinephrine, although the effects would be much shorter-lived than the Sustaine.

Not all tattoos need to be numbed. When I first started having access to these substances, I was very enthusiastic and used them for every tattoo. Now that the novelty has worn off, though, I've found myself being more conservative about their use, especially in light of several reports of rough healing. They can be very handy indeed for those tough spots or protracted sessions, and I always like to have a bottle of numbing gel handy just in case. But if I can get away with it, I'll skip the use of these products and let the body's natural processes deal with the pain. After all, we can bend over backwards for our clients, but we don't want to spoil them now, do we?

---

**Part VI Review Questions**

1.) What would be a good reason to hand trace a stencil?

2.) What is a major disadvantage to using a stencil made on inkjet paper? What are some advantages?

3.) Under what circumstances do we use a one-shot stencil? How about a two-shot stencil?

4.) Why do we use tape when applying a stencil?

5.) What is an advantage of using soap instead of Speed Stick for applying stencils?
6.) What is the difference between a flat and a magnum? What makes a magnum preferable?

7.) What is the difference between a stacked magnum and a spread magnum? Why is the spread magnum possibly better?

8.) How are spread magnums made?

9.) What is the main advantage of using carbon needles? What are some disadvantages?

10.) What part of a machine do we feel when judging how it's running? How do we hold the machine while doing this, and why?

11.) How do we add tension to a spring? Why don't we want to subtract tension?

12.) What happens when the rubber bands are tangled, instead of being arranged neatly?

13.) What do we feel with our stretching hand? Why is this so important?

14.) How do we create a three-point stretch?

15.) What are some ways of supplementing our stretch?

16.) How can we protect our stencil when we have to place our greasy fingers all over it to get a good stretch?

17.) How can we make it easier to switch back and forth between machines?

18.) What are some advantages to switching back and forth between machines numerous times during the course of a tattoo?

19.) Why would we want to spend extra time tightening a tattoo when we can get away without doing it?

20.) When would we want to soften an edge? How do we do this?

21.) What are some advantages and disadvantages of using a barber chair? How about an office chair?

22.) Can you think of ways of improving your shop setup for better comfort and lighting?

23.) What are some good types of lamps to use? What kind of bulbs? Do you know of any others?

24.) What part of the tattoo process is often the most painful? What can we do about it?

25.) What are some advantages to using squeeze bottles instead of spray bottles?

26.) What are some advantages to working small areas of a design to completion? What are the advantages of working the piece as a whole?
27.) What are some other ways you can think of to make a client more comfortable?

28.) Is it ethically permissible to let a client take prescription drugs for a tattoo?

29.) What is a good over-the-counter anti-inflammatory agent?

30.) What are some advantages and disadvantages of using topical numbing gels?

31.) How can we minimize the negative side effects of these topical medications?
ing one. I had some experience with slantboards in the street shop era of my career, using a board I had built according to old-time tattoo shop formula. This device made things easier for me, but required more effort on the part of the client. I even had a guy fall off the thing, which made me nervous about using it again.

Mostly, I've used a combination of office chairs, armrests and massage tables for just about every job. They provide for just about every body position and are flexible and re-arrangeable. The one thing they don't provide is a headrest, so that the client can lay their head back and relax completely. Sometimes we'll use one of the armrests for this purpose, and tape a pillow to it (Fig. 6.7.A).

I keep three armrests available for all different tasks. Some arm positions work best with two armrests, one for the forearm and one for the upper arm, especially in positions where they're laying down (Fig. 6.7.B). The best armrests have heavy bases and are adjustable not only in height but in angle as well (Fig. 6.7.C). My favorite has a 12"x6"x1" hunk of plate steel as a base-it would take a nuclear blast to knock that sucker down. Unfortunately, the fellow that made it is no longer in the business. Hopefully someone out there is selling a good one; let me know and I'll list it in the next edition of this book.

Once we've got them positioned ideally, we need to get the lighting just right. The best kind of lighting will give us the most light.
with the least shadows, while not blinding the client. We can accomplish this the most easily with a good swing-arm lamp with a hood (Fig. 6.7.D). Usually, these clamp onto the edge of the table or slide into a hole predrilled for them. Some come with heavy bases, which is helpful at conventions where the tables usually aren't well suited for those clamps. Some manufacturers are selling lamps that have a flexible snake neck instead of the traditional jointed neck, which gives us way more flexibility (Fig. 6.7.E).

Standard incandescent bulbs affect how we see our color, making everything more yellow, while those compact fluorescent bulbs that screw into standard sockets are often too white, making things look flat. At some stores and through online retailers of health products such as Real Goods, we can purchase full-spectrum bulbs which create a satisfying natural light. These bulbs are more expensive, but they last a long time and will actually improve the quality of our work by helping us to see our color like it really is.

We want to position our lamp so that it's right above where we're working, so our hands don't cast shadows (Fig. 6.7.F). We can take advantage of the hood on the lamp to direct the light away from our client's eyes, so we won't blind them. This small detail can actually make a big difference in overall comfort; even with everything else perfect, it's hard for them to get relaxed when they feel like they're about to get interrogated.

All these details about light and position may seem very basic. Well, it is pretty basic stuff. So basic that if we compromise it in any way, it can affect even the most minuscule aspects of what we do. With our lighting and position optimal, we can really concentrate on our work, sometimes forgetting that we're even working on a person. That's a sure sign that we've really 'gotten into' our work.
There are many other small things we can do that will affect the client’s comfort. One of the most important is in our handling of them. If our manner of holding their body part is jerky and abrupt, it may feel to them like we’re in a hurry, or that we’re impatient with having to work on them. This can make it almost impossible for them to get comfortable. Their body part, especially after we’ve poked enough holes to get it really raw, needs to be handled like fine china. Not only will this make them more physically comfortable, but it will make them feel more important.

Probably the biggest and most potentially painful aspects of the handling of our clients is the wiping process. It’s normal to hear them say, “Towards the end, the wiping got worse than the tattooing.” It doesn’t feel good at all to have a scrunchy paper towel dragged across raw flesh. Fortunately, there are things we can do about it.

For starters, we need to use petroleum jelly or A&D ointment for lubrication. Most of us were taught this in our apprenticeships, but some folks are actually taught to work without lube. Believe it or not, I’ve actually met a couple of these poor, confused folks. Although the lubrication can make the body part slippery and hard to work with, we won’t have this experience if we only apply it where we need it. In the meantime, it has so many good benefits that these small inconveniences are insignificant by comparison.

We always want to have a thin layer in the area that we’re working. Not so much that we’re picking up gobs of it on our tube tip; we want just enough to form a barrier between the skin and the air. This will keep the pools of ink that flow out of the end of our tube from sinking deep into the pores and not wiping off easily. Instead, the only pigment that makes it through is that which is delivered by the needle.

With a thin layer of lube, the spilled and smeared ink that’s a normal part of the process will wipe up in one gentle pass of the paper towel instead of requiring painful scrubbing. It also prevents the lighter colors you may have already put in from getting stained.

Fresh tattoos seem to sting less when there’s a coat of lubrication on them. It’s not unusual for clients to actually request it, although most tattoo clients are too nervous and intimidated to speak up on behalf of their own comfort. We can’t always have lube on everything, since it becomes hard to stretch, but we can certainly use it on areas we’re not presently working on that we don’t need to grab for stretching purposes. Not only will this make the area more comfy, but it will also prevent it from scabbing up and getting hard to clean, which is also very much in everyone’s favor.
Wiping is best handled with a clean, folded wet paper towel. We fold instead of scrunch, since a scrunched towel has many folds and corners to dig into the skin. It's probably best to fold the towel in quarters, giving us a square about 5" on a side. Then we use our autoclavable squeeze bottle to soak a corner of it, about 1/4 to 1/3 of the area (Fig. 6.7.G). By wetting a corner instead of the center, we get more control over how the wet part glides across the skin than if it were surrounded by dry towel. With it prepared this way, we then drag it lightly across the area in a smooth, gentle movement. A single pass should be enough to pick up most stray color.

Once we make that first pass, that part of the towel becomes useless. If we try to wipe with it again, we re-introduce the mess that we've just cleaned up. Instead, we either toss the towel (if it's maxed out) or we re-fold it so that a new clean area is showing, wet that part, and then wipe. A single towel is usually good for 3 or 4 of these cycles.

I normally don't use soap when I wipe. The soap makes the color come up slightly easier, but can sting and leave a film that then dries up. I've found that a clean, wet paper towel is more than adequate almost all of the time. The extra sting that the soap provides can end up being one of those many things that stack up to make a session uncomfortable.

When I first started using those autoclavable Nalgene bottles, I found that squeezing them made my hand sore, and so I was reluctant to use them. Many other artists have had this same experience. This problem can be quickly and easily rectified by snipping off the end of the nozzle with a pair of scissors (Fig. 6.7.H). The more we snip off, the easier the water comes out. If we snip off too much, though, water starts squirting out at times we don't want it to, such as when we put the bottle down on the table.

These bottles have become popular recently largely as a result of organizations like the A.P.T. declaring that they are cleaner to use. That's enough of a reason in itself. The fringe benefit that I wasn't expecting, though, is another comfort factor. Using a spray bottle on someone is not always pleasant for them; often the spray feels cold and sudden, making them cringe and sort of back away. By instead using the squeeze bottles, we spare them this unpleasantness.
It's common knowledge that some parts hurt more than others. In a single small tattoo, we may pass over some areas which are excruciating and others which are barely felt at all. The deltoid is a good example of this; the outermost part is well-worn, thick, leathery and padded, while the front gets frighteningly close to the armpit and the top passes over a little bump of bone that can really light things up.

Normally, as long as we're not deliberately trying to hurt our clients, we start out tattooing in the less painful areas and let them get adjusted before moving on to those more painful spots. We can take this a step further. Once we've gotten the basic stencil committed to the skin, we can work the tattoo in areas, taking each area all the way to completion. Once the client gets used to getting that small area worked on, it becomes easier to sit, possibly even somewhat numb.

There certainly are advantages to working the whole tattoo at once. We can think in a more singular mode, considering the whole design at once instead of concentrating on small areas while still making these parts read as one. We do less rinsing and changing colors, since we work all the way through the design with each color before rinsing and switching to the next. Each process we end up doing only once, instead of for each different area. The entire procedure ends up being simpler and more straightforward this way.

On a large piece, though, it can hurt quite a bit to have the needle skipping around like that, leaving an area just long enough for it to start healing before going back into it.

A good way to decide how many areas to work to completion is to estimate how long the piece should take, then figure out how many breaks we think we'll want during that time. If we think we'll take three breaks, then we divide the piece into four basic parts and work each of them to completion. This way, we don't end up going back into a raw area after a break, which is one of the most dreaded things for a tattoo client to have to go through.

When a client is sitting for a long session, there will be a period when their pain tolerance is at its peak and they seem to be sitting the best. This is the best time to finish those tender areas. If we avoid these spots because the client flinches every time we approach them, then before we know it, it's the end of the session, they're worn out with no pain tolerance left, and we still have those tricky spots left. Best to get them over and done with earlier in the session.
For some pieces, working an area to completion and then moving on to the next can pose an unacceptable staining risk for the yellows and whites. We can avoid this by finishing everything but the yellows and whites in each section, then going over the whole piece and doing the highlights.

This makes staining less of a risk, but that last blast of color can be quite painful, especially in places we haven’t been to in several hours. We may find ourselves having to rush this step.

A good compromise exists. We can work an area to completion, doing everything but the yellows and whites. Then, we do the highlights throughout this section, but not in the last inch or so closest to the next area we’ll be working. That way, we won’t have vulnerable light-colored areas next to places we haven’t even started the black shading in yet. Then, when we’re done with the darker colors in the next section and doing the yellows and whites in it, we also finish this small strip of the first area where we held back on the lightest colors.

We can achieve a lot in the comfort department by positioning ourselves and our clients the right way, handling them smoothly and wiping gently, and of course working the areas strategically. These measures can add up to a very comfortable tattoo experience for both parties involved. That is, unless the atmosphere of the workspace is distracting and unpleasant.

When we’re working, it’s normal enough to get so into what we’re doing that we stop noticing the room around us. For the person tattooing, that process is the most interesting thing going on in the room. For the client, though, things can get boring pretty fast. Some enjoy watching, but inevitably get sore necks. Others can’t watch at all, and crave some type of distraction to help transport them away from the pain.

It’s up to us to decide how involved we want to get with this aspect of their comfort, but remember that what they’re stuck looking at will be a large part of their experience while getting tattooed. If our walls are decorated with leering faces and other unpleasant imagery, that will have a lot to do with how they feel during the tattoo. Unless you’re specializing in that kind of imagery, this can take away from the experience.

Although we want to keep our workspaces clean and orderly, it can be nice to have a couple of walls near the work station with some kind of eye candy for them to fall into. This can be paintings or drawings of ours, framed things we’ve collected
from friends, colorful postcards, hologram stickers, art prints, assemblages of interesting stuff, mirrors... You name it, as long as the overall environment casts a spell that's pleasant to be under.

Some tattooists like to work with a TV or VCR running. If the material in question is something of interest to the client, this can be enough of a distraction to make them almost forget they're getting tattooed. I've been tattooed a few times with good movies and colorful computer graphic videos playing, and the time just flew right by. Music videos or tattoo videos can also serve the purpose. I've found, though, that movies with a lot of long action, fists-flying-guns-shooting-stuff-blowing-up-everywhere sort of stuff, tend to make clients restless if these scenes go on for too long. I think that the combination of all that booming and the sting of the needle makes for a pretty annoying cocktail.

Sometimes they will like the idea of visual distraction but have trouble staying focused on a plot. We can play videos of fractals, crazy computer graphics or even Japanese animation, and then play whatever music we want over that. People seem to really like this combo.

I'm often suprised at how clueless some tattooists are as to their clients' taste in music. Now I don't necessarily believe that we should have to listen to Yanni if our client is a Yanni fan, but we may want to consider playing something other than Slayer for these folks. There's always going to be some compromise, where both parties can feel comfortable. If our clients feel like we're taking their needs into consideration, they will tip us and return for more work.

Over the last five or six years, I've found myself to be less and less patient about music with lyrics. I suppose this has something to do with already having enough going on in my head; why would I want some dude yelling at me about his love life problems or his issues with society when I'm trying to concentrate?

This is a personal taste thing of course, but I've definitely found (and many tattooists I know are discovering this as well) that there is a lot of good music out there without any words at all. This can range from intricate guitar work to expansive ambient soundscapes to rhythmic thundering dance music, depending on the mood and the energy level we want. Many tattoo clients have been quite open to this instrumental music, and have found that it's easier to relax and drift off without having the yelling dude in the airwaves. For some musical suggestions, see Appendix B.

The atmosphere we choose is not just for comfort and convenience; it's also an expression of our personal artistic energy. It's an opportunity not just to get the client to relax, but for them witness an installation of music and imagery that can be an art
form in itself. In the memories of our clients, this part of the experience can last as long as the tattoo.

No discussion of client comfort would be complete without some mention of the pharmaceutical substances that a client can use to ease their pain. These include both over-the-counter and prescription drugs, both in pill form and topical numbing gels.

The most basic and accessible way to take the edge off a tattoo is ibuprofen. This substance reduces swelling and dulls some of the irritation. Some folks find that it gives them an upset stomach, so it's best to use moderation at first. An effective dose for getting tattooed is 600-1000 milligrams, depending on body size. We can follow that up with another 200 or 400 mg every couple of hours. Some clients of mine sit for miraculously long sessions with nothing more than ibuprofen.

Some clients will have some kind of opiate painkiller left over from a dentist's appointment or a broken arm. Some will even endure extra pain by not taking the pills after their root canal, just so they'll have them for their tattoo appointments. Now I'm not a doctor, so I can't legally prescribe medication, but I will say that these types of drugs, when used carefully and in moderation, can make a considerable difference in the pain, while not affecting the healing in any measurable way.

Occasionally I'll have a client who actually asks their doctor for a small prescription, specifically for the purpose of getting tattooed. There's no law against asking, and a tattoo is certainly a legitimate form of pain. What I would definitely not recommend is trying to get these pills on the street. If we can't get them from our doctor or from a sympathetic relative, it's just not worth it.

Ever hear that old bit of urban folklore about not mixing alcohol and pills, or you'll die? Well, it's true. In fact, there was just recently a fatality at a convention when a collector got through a painful foot tattoo by the grace of his pill bottle, then celebrated a little too much afterwards. He simply didn't wake up in the morning. I'm not including this sad story in the book just to take the fun out of it, but as long as we're talking about drugs, I thought it was important to mention that. Some folks will look for excuses to get extravagant with substances, and it's our responsibility not to facilitate that while we're tattooing.
Part VII

Processes

Now that we’ve spoken in such detail about all of these points, let’s see how we’ll apply them in some practical tattooing situations. For simplicity’s sake, we’ll start with a black and grey piece, then explore some fancier color pieces, including both abstract and representational imagery. We’ll try to touch on all of the major design points, such as contrast, dynamic range, pos/neg relationships, priority and reserve. We’ll also go into how we handled each piece technically, which setups we used, what kind of stencil, and the basic order of events.

Of course, we can only pick up so much from looking at still photos and reading written descriptions. Nothing can compare to actually watching, so I encourage you to watch other more experienced artists as much as possible. Conventions are a good place for this, but we can also align ourselves with local tattooists whose work we admire, and find time to drop by and watch. Questions may arise, and the person who is working may be ready to answer them, but even just watching the process for long enough will normally answer our questions for us.

I can’t emphasize enough how much we have to gain by spending time drawing. If we want to really fine-tune the look of our work, nothing beats working on your designs in colored pencil. I believe that anything that we can draw in colored pencil, we can make it look at least as good on skin. Regardless of how sophisticated our design might be, if we can make it look good as a colored pencil drawing, we can make it work as a tattoo. Even with a challenging project using a reference photo, if we do a colored pencil rendering first, we know that we can tattoo it, and have an idea of how to go about it. That pencil rendering is a kind of proof of our hand’s ability to express the vision.

Many well-known experienced tattooists will simply draw the design on or finish a simple line drawing prior to making a stencil. An artist at this level may simply not have the time to do colored pencil renderings of each design; besides, they know their subject matter well enough that a pencil rendering is unnecessary, since they already have a clear plan.
However, most of the best of these artists had a period earlier in their careers where they did dozens or even hundreds of colored pencil renderings of tattoo designs, t-shirt images, promotional fliers, and even personal visions that they hoped to be able to tattoo on someone someday. It is during this period of intensive drawing that an artist will establish the core of their style and identify where they truly want to go with it.

Once we have a clearer idea of what we’re doing, we can get away with less preliminary work before we tattoo. Sometimes, though, we may be trying a new approach or possibly working with an unfamiliar subject matter. At times like these, it’s good to prepare ourselves.

A simple way of doing this is to make copies of the line drawing at a reduced size, then do the color renderings on these copies. When we do them smaller, we not only finish them quicker but we will tend to use clearer overall positive/negative logic than we might if the drawing were larger, since it’s too small for us to get hung up on detail.

Because we’re able to do these studies quickly, we may even be tempted to do a few variations on a color scheme. Almost inevitably, the second or third color study will make better sense graphically than the first. Ever been two thirds of the way through a tattoo and suddenly realized that you should have handled a certain detail much differently than you did? Well, these kind of studies will prevent this type of minor disaster.

For the most complex designs, it’s good to do a value study before moving on to the color study. This consists of a simple shaded pencil rendering on one of those reduced-size copies of the line drawing. Since we’re working with regular erasable pencil, we can easily try many minor variations of pos/neg relationships in a design. Some complex designs will require quite a bit of erasing and reshading differently before we land on the best answer to the problem. And remember, each time we erase is one more serious mistake we may have made while doing the tattoo if we hadn’t done the value study first.

With a good value study, we have all of our pos/neg relationships established and we can easily figure out the coloring. Often, the value study is more than enough information for us to start the tattoo (not that I’d ever discourage doing color drawings!)

Anyway, with all of this in mind, let’s step into the studio and do some tattoos.
7.1) A Black and Grey Design

For this first piece, we begin with a small shaded sketchbook drawing followed by a full-size line drawing and stencil. Since the design has a variety of different details and a certain need for precision, we set up a three, five round and seven mag.

Using the five, we bloodline the swirls of negative space smoke coming from the hands and wrapping around the top of the crown, then the rays radiating from the crown’s point (Fig. 7.1.A). We then blot the tube tip on a dry part of a paper towel, run it for a moment to make sure it’s dry, then dip in straight black, run it for a short burst, blot it, dip in straight black again and run it again. This ensures that the water from bloodlining won’t be diluting the black we’re about to put in. After doing this, we rough in the outline of the hands, then the peripheral line of the crown.

We switch to the three, bloodline the starburst underneath the crown; then we greyline the sunflower pattern behind this burst, some detail in the hands, and some detail in the crown. Finally, we work some of the smaller details of the crown in black. By working from bloodline to wash to straight black, it’s easier to insure that there isn’t any pigment in the tube when we’re bloodlining, which could give us an unwanted ghost line when the piece is healed.

We then switch back to the five and build the peripheral line of the crown. We make it bold and clear, which helps us in the case of a complex design like this by
assigning clear priority to the crown. We also strengthen the edges around the hands and shade out from them a short way with loose strokes.

Switching to the mag, we use black and the full range of grey washes to shade the hands and the sunflower design (Fig. 7.1.B). We blend the shading around the hands easily into the small bit of shading we started with the five, making for a clean gradation from the edge outward. We make the shading darkest immediately under the edge of the crown, and fade this shading to a lighter tone gradually as we get closer to the hands. By making it darkest just under the crown’s edge, we lift that edge out, giving it dimension, without creating an unnecessary large dark area.

We then switch to the three and tighten the shading in the sunflower pattern, using mostly grey washes of 60% and less, but using black more and more as we approach the underside of the crown (Fig. 7.1.C). We also refine the hand and add a light stippling texture in the smoke, then use small amounts of shading around the starburst in the middle to make it more distinct, without going too dark behind it.

We could do this whole area with a five, but the three makes the details in the hands sharper and allows us more precision when we refine the arcs and points in the sunflower pattern. Plus, when we’re dealing with a small area like this, using the three won’t necessarily take us longer than doing the same thing with a five. If we’re trying to use a large needle group in a small area, we can end up spending more time trying to maneuver that big thing around in tight spaces, like backing up a moving van into a narrow alley. With the three, we can move quickly and confidently without worrying about going over a line or making a sharp point too round and fuzzy.
Finished with all black and grey in that area, we move to the top of the tattoo and switch back to the mag. We use light washes under 40% and light, looping strokes to create the soft edges for the smoke, then smaller looping strokes to fill the areas in between, going as dark as 60% in select places (Fig. 7.1.D). We then switch to the five and use these same values of wash to strengthen the edges of the rays and bring them forward from the smoke (Fig. 7.1.E). This process takes only moments, but makes a world of difference.

We save the crown for last; partly to help optimize the neg on pos relationship it has with the background, and partly because it was the most fun part of the tattoo, and it's sometimes good to play 'delayed gratification' games with ourselves, so we've got more to look forward to.

We begin in the crown with the magnum, using mostly greys lighter than 40%, but going much darker towards the outer edges of it, giving it more curvature (Fig. 7.1.F). Where these bands of reflective shading pass over any of the curvy filigree work on the crown, we leave a short break in the shading, making the filigree appear to be raised off the surface of the crown.
We then switch back to the five and tighten the reflective shading, concentrating on reinforcing the raised look of the curvy ornament by clarifying those short breaks in the shading. For the tightening stage we use much of the range of grey, but we reserve true black for key points (Fig. 7.1.G).

Finally, in (Fig. 7.1.H), we apply the white. Since we have many different elements we're trying to keep from running together, we reserve the white just for the crown, the hands and the starbursts, using only key points of white in the hands and none at all in the smoke or the sunflower pattern. This kind of radial pattern would ordinarily look nice with bright white highlights in its points, but in this case it would cancel out the white in the starburst and the crown.

We work in large areas of white with the magnum in the crown and the burst at the top, then we follow up with the five round to refine these large highlights and give shimmering details to the reflections and beaded designs.

As with all grey wash designs, we need to be prepared to see the piece lighten and soften by 30-40% in the healing and settling process. If it looks perfect when it's fresh, it will probably look a bit too light when it's healed. This means we want it to appear too dark when it's fresh, figuring it will look just right when it's settled. Learning just the right amount of overcompensation is a matter of experience; we can help this process by taking fresh and healed photos of our work whenever possible. By viewing these photos side-by-side, we can get a better idea of exactly how the healing process will affect our work, and learn to compensate for it.

7.2) A Simple Color Piece

Our next tattoo is a relatively simple color tattoo, performed at a convention in about 3 1/2 hours. This is on an inner forearm, which is a great place to work for its paleness, hairlessness, visibility and comfortable positionability. As with the black and grey piece, this begins as a small shaded sketchbook drawing, then graduates up to a full-sized line drawing and stencil. Once again we use our three-five-seven mag trio of machines.

We begin by roughing in the outline and committing the stencil to skin (Fig. 7.2.A). We do all the details with the three, greylining the stars in the background and using black for the vents and other small details. Then, using the five, we do the peripheral line in black, the flames in red, and the dome window reflections in purple.
Still working with the five, we build up the rocket's peripheral line to a good uniform weight, refining the arcs as we go (Fig. 7.2.B). Then, switching to the three, we build up the pointy fin-spike things and the rings surrounding them. The black in these lines will be the only black in the entire piece.

Next, working with the magnum, we lay in the dark and medium purples, creating a shimmering metallic effect (Fig. 7.2.C). Notice how we've left a narrow break in the color along each seam. These seams are a good example of how we can use contour lines to show the shape of an object.

Still working with the magnum, we lay in the deep, medium and light blues in the background, dipping back and forth between three values of blue in our palette (Fig. 7.2.D). Notice how there's a hint of a ragged edge of skin between the outline and the blue background.
We then rinse out the blue and continue with the magnum, now working the magentas in the windows, body, and around the fire (Fig. 7.2.E). Magenta, pink or even a medium magenta-pink, make a good transition color from cool colors to warm colors.

If we do a blue or purple background and fade it into an orange glow around the foreground color, we'll get a muddy brown where the orange and blue overlap. That's because any colors that are opposite of each other on the color wheel will naturally cancel each other out and create a brown or grey. We can avoid this problem by using a transition color between them. On the color wheel, a transition color is somewhere between the two other colors, which helps to keep the opposing hues from mixing directly. When the blue mixes with the pink, we get lavender or purple, which is still nice and bright. This purple fades into an electric pink, which then fades into orange. Where the orange and pink overlap, we get a rich salmon color. Nowhere do we end up with unwanted browns.
In the case of this rocket, we use magenta as a transition color between the blue background and the red edge of the flame. Blue and red will mix into purple, in theory, but it’s usually not a very vivid purple in the case of bright, warm red tattoo pigments and vivid blues; it often makes for a slightly brownish purple. Instead, we use magenta to make this transition appear brighter and more colorful.

Continuing with the magnum, we lay in our primary reds (Fig. 7.2.F). We bring red up against all the red lines of the flames, hiding the lines and creating neg on pos layers of flames. We use more red in the hull of the ship, continuing the transition from purple to magenta to red.

Our next step is to switch to the five round and begin tightening (Fig. 7.2.G). We bring the deep and medium blues of the background up to the thick peripheral lines and up against the greylined stars; we smooth out the shimmering color effects in the hull and reinforce the breaks in the color at the seams; we sharpen the color in the reflections in the dome windows, and then bring the red corona around the flames right up to the red lines, cleaning and sharpening the arcs as we go, defining the little neg-on-pos spark things and making the different layers of the flames distinct from each other.
The tightening stage, although taking only fifteen or twenty minutes total, ends up being not only one of the most fun stages in this tattoo, but also an important part of the flow and readability of the piece. By smoothing out the shimmering arcs of color and making the seams more readable, we strengthen the entire piece, very likely giving it better longevity as well.

With the tightening done, we switch back to the magnum and lay in the deep and medium orange (Fig. 7.2.H). This makes for a nice gradation in the flames and continues the spectrum of color in the hull from purple to magenta to red, now to orange.

Still using the magnum, we fill in the yellow in the flames and hull and put in a couple of long, smooth curving white highlights along the metallic sides of the ship (Fig. 7.2.I). We leave the stars in the background fleshtone, giving the white in the ship that much more priority.

Even though the hull of the ship has a nice range of color from purple to magenta to red to orange to yellow to white, we use no blue in it. That we’ve reserved for the background only, the way we reserved white (along with many other colors) for the foreground. The almost-full range of colors in the rocket gives it a color range of about 75, plus a full 100 points of value contrast, considering the black outlines and the white highlights. With the tight details and vents done with a three, we can give it another 75 points for sharpness, totalling 250.

The background, on the other hand, has almost no range in color (about 10 points), less value range than the rocket (65 points, if we factor in the skin tones) and much less sharpness, due to the patchy blurriness- even counting the stars, we’ll only give it 25 points. This totals 100, separating the foreground and background by 150 points on the dynamic range scale.

7.3) The Seahorse

In this next tattoo, we’ll use many of the same ideas we touched on with the rocket tattoo, but with some differences. In this case, we’re dealing with an odd space on the lower calf and ankle, where we’ve got a lot of bumpy anatomy to contend with.
To take advantage of this, we place the coily tail of the seahorse right on the anklebone, making it pop out and incorporating the bump of the bone into the design. We’re using an S-curving background of blue and negative space, where part of the curve overlaps the seahorse, pulling it inside the leg and giving the whole environment more of a sense of space.

For this tattoo, we begin with a sketchbook study and then a full-sized drawing. This time, though, we’ve shaded the watery background in the stencil, making it easy to read the seahorse’s clear neg on pos relationship. With this stencil in place, we greyline the inner details and ridges with a three, then switch to a five round and cruise through the peripheral line (Fig. 7.3.A). Still using the five, we build up the peripheral line to a nice consistent weight and sharpen the details in the face (Fig. 7.3.B). We also use this opportunity to do the black shading in the eyes.

Our next move is to lay in all the blues in the background (Fig. 7.3.C). We use the whole range of blues for this, concentrating the deepest blues closest to the seahorse in order to strengthen its neg on pos relationship. We easily follow the shaded stencil as we lay in the first pass of medium blues, dipping back and forth between light blue, medium blue, dark blue and water in order to get the whole range of values and the greatest sense of softness. We also brush a small amount of blue along the bloodlines for the watery negative space which passes in front of the seahorse.

Still working with the magnum, we rinse out the blues thoroughly and lay in the medium warms in the seahorse, in this case the pinks and lime greens (Fig. 7.3.D). Both of these are thin, easy-to-use Starbrite colors; this process takes only a few minutes. Before we switch to the five, we rinse; this prevents us from having to deal with dried pigment later on, when we need this machine again. This is a good habit to get in whenever we’re working.
Next, we switch to the five and begin tightening (Fig. 7.3.E). We use pink and a custom mix of medium magenta to sharpen and refine the ridges in the body. Notice how these ridges describe the form of the seahorse the same way they do in the rocket; they are another example of contour lines.

We also sharpen details in the face and fins, using dark red, purple, deep green and magenta. We tighten the background color against the seahorse’s peripheral line and the bubbles, then we color in the eyes.

Switching back to the mag, we lay down the bright oranges and yellow-greens (Fig. 7.3.F). Using the magnum, this takes three or four minutes, but deals with some of the most important color in the piece. Since orange is opposite of blue on the color wheel, it is the best candidate for a dominant color in this seahorse. The lime green fins are different from the orange, but still contain enough yellow to read as part of the foreground, especially with the large field of blue contrasting both the oranges and the greens.

Still using the magnum, we rinse out and begin laying down the yellow (Fig. 7.3.G). We work slowly and saturate the whole body, using small, even, overlapping oval-shaped strokes. We end up working the yellow through most of the foreground, blending with both the oranges and the greens.

When we’re satisfied with the yellow saturation with the magnum, we switch to the five and proceed to pull the yellow through all of the tight corners and nooks and crannies that the magnum couldn’t reach easily. This makes the piece look brighter in general. We then add yellow and orange in the edges of the bubbles facing the seahorse; this not only appears as a colorful reflection of the seahorse in the bubbles, but helps to break the monotony of the large field of blue.
Finally, we rinse thoroughly and start with the white highlights (Fig. 7.3.H). We begin by placing them on the raised part of each ridge, giving the piece more dimension. These highlights are mixed with existing yellow, and will not heal as true white. We also pack white in along the spines of the fins, the ridges of the back, the reflections in the bubbles, and anywhere else in the foreground that looks like it could use it. The highlights in the face are particularly fun, making the eye shimmer and the mucous in the cheek veins glisten.

There are many white highlights in the piece, but the only clear concentrations of true white are in the eyes. Since the eyes also have the greatest concentrations of
black in the whole piece, they have the most value contrast, and easily jump forward. They also have a fairly strong color contrast, using a range from purple to orange. All eye features are as sharp as they can be made; including these three factors, their dynamic range is around 275. The shiny, textured veins around them bring them additional attention.

The body has only slightly less range of color and contrast, but a fair amount less sharpness than the eyes, totalling about 225. This is still a good deal more than the monochromatic, soft-focus water, which totals 100 at most. Thus, we have a descending order of dynamic range, with the eyes being the most important, and the water, although being a very important design element, commanding the least amount of priority.

7.4) A Complex Scene: The Sandbox
Although this next piece isn’t any larger than the seahorse, it is demanding in a whole different way: it is a scene, with a foreground, middleground and background. It has a number of different interacting elements which all must make sense together, and it has an atmospheric background with a strong light source, which plays light over every object in the scene: the boy, the sandbox, the sand, shovel and pail, the hills and the clouds.

We choose a dramatic perspective for this piece. Not only does this make for a more dynamic piece and add drama to the mood, it also makes it easier to tattoo and a better fit on the arm, since it’s not so straight and boxy as a more straightforward view. In the stencil, we include many of the basic shadows, including shadows cast by the boy, the pail and the clouds in the sky; by having them in the stencil, we don’t have to eyeball them later.

We begin by roughing in the grass, flowers and hair with the three, plus some details in the pail, shovel and shirt. We then proceed with the five round, outlining the larger shapes on the boy and the sandbox. We build up and sharpen the important
peripheral lines (Fig. 7.4.A). We also exaggerate the weight of the line on the closest corner of the sandbox as a way of emphasizing its perspective.

Next, we switch to the seven mag and shade the blacks in the shadows of the figure, the pail and the sandbox (Fig. 7.4.B). We also add a black shadow under the sandbox, but we use no black in the background hills, giving them less contrast so that they'll drop back. Notice how the shadows of the boy and the pail 'skip' upward as they pass from the surface of the sand to the edge of the box. The amount of 'skip' shows the difference in height between the sand and the edge.

Still using the mag, we lay in all the medium and cool colors (Fig. 7.4.C). This includes the green in the hills and the purples in the cloudscape. We also use yellow ochres and browns to develop the boy's hair and skin and give color to the sand.

We then switch to the five round and tighten the black in the boy's hair and clothing, then sharpen the shadows between the blades of grass in the foreground (Fig. 7.4.D). We then rinse and begin tightening with color; first in the boy, pail and sand-
box, then in the hills, using a whole range of greens and building up the gradation, giving the top edge of the sandbox a clear neg on pos relationship, then fading up to light green as we approach the spot where the sunset will be.

Switching back to the magnum, we proceed to lay in the warm colors in the sunset sky, beginning with pink as a transition color from the purple, then orange and yellow (Fig. 7.4.E). We also pack in yellow at the top of the hills facing the sunset, then dip in white and work the boy's face and arms with a yellow/white mix. We use this blend in areas of the sand and sandbox also.

This last step is the quickest and most fun of all, but makes a significant difference in the finished look of the piece. We switch back to the five, rinse thoroughly, and finish the highlights along the front of the boy's face and body, making him stand out clearly against the purple sky (Fig. 7.4.F). We also use white to color the sun, accent the shovel, pail and sandbox, and sharpen the bottoms of certain key clouds. In less than five minutes worth of work, these highlights bring the whole thing together.

Part of the language of this design is in how everything points towards the sun: the light rays, the lighting on the clouds, the shadows in the sandbox and the boy's gaze. This is one way that we unify the elements in the design and keep it from becoming chaotic. Also notice how the priority line around the boy's face makes him stand out boldly from the sky and from the light three needle lines of the distant grassy hill.

Light and shadow on the boy are alternating in a clear, readable pos/neg/pos rhythm. We reserve true black and true white for the foreground objects, particularly the boy, making him stand out the most. In combination with the bold peripheral line, this gives him top priority. We give the head much more range in value than the area behind it. The shirt, which has to stand out against numerous background objects, is given not only the fullest color/contrast dynamic range of the piece, but also the only significant area of true blue in the entire design.

The thin edge of light along his face and arms show what direction the sunlight is coming from; the large shaded areas of cool colors in his head, back and shorts contrast the highlit edge, making it appear bright and giving him dimension and solidity.
7.5) A Complex Abstract Tattoo

Let's go back to a favorite subject of mine, the floating geometric 'Lightform' in an organic environment. As we discussed before, this is a graphically strong subject in that it uses the dynamic range in many ways: value contrast, color contrast, focus and out-of-focus, contrast of texture and contrast of subject matter. With this type of tattoo design, the organic environment is laid out to make the most of that particular body part, and the orb is placed in a central location where it can light up the design in some optimal way.

In this case, the organic stuff follows a dynamic S-curving 3DF8 motion, showing an inner space and an outer surface. We hang the lightform right where it can dominate the center of the design while a thick foreground shape passes in front of it, doing some dynamic things with value.

As usual, we begin this design as a small shaded study in a sketchbook. We do this sketch with the client standing there holding their arm up; we quickly sketch out the shape of the arm, trying to get its proportions accurate. This helps us to draw the design to fit the body part better, and is the next best thing to using a digital camera and printer, which won't always be available.

With the arm sketch complete, the client relaxes and we work out a satisfactory undersized study. When we feel we've answered all of our basic questions about the composition, we move on to a full-sized drawing, using an accurate tracing to get the fit right.

We begin the full-sized drawing by laying out the basic S-curves of the organic stuff, both foreground and background, using our small thumbnail sketch as a guide. With these lines in place, we draw in a rough circle where the orb will be. Since it's better to work out complex geometric designs under more controlled circumstances, we go no further with adding detail to the orb and concentrate on getting the organic stuff laid out nicely.

When that's about 75% done, we turn our attention back to the orb. We begin by tracing the rough circle we marked into our drawing onto a separate sheet of tracing paper. This gives us the right size to work with. We then either lay out a mandala using the basic Snowflake method (see Appendix C) or we start with a basic geometric form, such as a cube or a pyramid, and build it from there. This design is based on a dodecahedron, a solid made of twelve pentagons (Fig. 7.5.A). We also
have the option of creating the lightform using the computer, as we discussed in earlier chapters.

When we’re happy with our orb, we position it under our master drawing where we’ve got that circle roughed in. We check at this time to see if the orb needs to be any smaller or larger, and we reduce or expand it as necessary using whatever technology we have at hand. We then tape it in place under the master drawing, erase the rough circle, and trace the orb into our drawing, leaving out the parts that pass behind foreground organic stuff.

With this done, we fine-tune the drawing, adjusting the organic stuff in any way we need to make it accommodate the lightform better. We then add rays of light radiating from the orb, especially its points, to increase the sense of luminosity. Next, we add simple pos/neg shading to the organic stuff using a dark, dull graphite pencil.

We then run the drawing through a copy machine, making sure everything is even and dark, then through a hecto machine. The resulting stencil is a combination of lines and shaded areas, easy to read, showing all of the basic pos/neg relationships of the organic stuff (Fig. 7.5.B). At the bottom and in other areas where the stencil doesn’t fit optimally, we erase and adjust the layout of the foreground stuff using alcohol and Sharpie pens.

Our first step to applying the tattoo is to fire up the five round and lay in the heavy priority lines of the foreground stuff (Fig. 7.5.C). Since it’s organic, we skip the first quick pass and put the lines in using small overlapping ovals, building them as we go. When we’re done, we go back and skim along the edges where we need to, making sure the lines are sharp and clear.

Switching to the seven mag, we then cruise through all of the shaded areas indicated in the stencil (Fig. 7.5.D). We go darkest where the organic stuff passes over the glowing orb, giving it maximum contrast there. We don’t use much black, since we’ll still be developing the shapes with a full range of blues and greens. When we’re done with the black shading, we switch to a three and line the orb in Starbrite pink, keeping the power low (Fig. 7.5.E). We also quickly bloodline the rays.
Our next step is to switch to the mag and add all of the deep and medium cools in the organic stuff (Fig. 7.5.F). Some background shapes are done only with the mag, keeping them out of focus and making them drop back. We use magenta as a transition color from the deep purples of the background to the glow around the lightform. We also use pink to define and soften the edges of the light rays, dipping in water to make softer gradations.

We follow this up with a quick tightening pass with the five round, where we sharpen detail in the black and deep colors, bring lighter blues up into the lower edges of the foreground shapes, and bring the pink up against the outer edge of the lightform.
Switching back to the mag, we add bright yellow-greens and yellows to the organic stuff, then rough in the orange shading in the orb's facets (Fig. 7.5.G).

Time for more tightening, this time with the three. We use light and medium orange to sharpen the edges of the facets in the lightform, then add small touches of red along any edges which need extra emphasis, especially the outer edge (Fig. 7.5.H). We try to keep the value range within the orb at 65% or less.

Switching back to the mag, we pack in all of the Starbrite yellow in the orb (Fig. 7.5.I). We run the machine softly, concentrating on each spot in order to get the best saturation we can while still leaving some empty spots for white highlights.

Next, we switch back to the five and run through all of the organic stuff with yellow, adding to its sense of texture and making it brighter in general. We also use it to increase the yellow saturation in the orb, getting into the tight spaces we couldn't easily reach with the mag. We then rinse down thoroughly, switch to white, and
run through the yellow regions of the organic stuff, adding little bumpy highlights here and there to give it more texture and bring it into focus. These highlights won’t be true white, since they’re mixed with the yellow underneath them; this allows us to reserve true white for the orb. We’ve also reserved the whole family of reds and oranges for the orb and black, blue and green for the organic stuff. This more than compensates for the fact that both elements share yellow, which is necessary to show the light source/lit up object relationship.

We continue with the five round, rinsing to make sure we have true white and continuing with the white highlights in the orb. We use the five to block in the larger areas of white, working slowly and getting as much saturation as we can.

Finally, we switch to the three, rinse thoroughly, and finish the white highlights in the lightform (Fig. 7.5.J). I especially enjoy using a three for white highlights; it gives us a great deal of control and precision, and makes it easier to get our highlights crisp and sharp. We use it in the orb to bring the highlights that we started with the five right up against the inner edges of the intricate shapes this orb is made of.

We take extra care to make sure that the points are all consistent with each other, since these are the shape’s most prominent features. If we get them right, the viewer won’t notice any small inconsistencies in the inner parts of the shape.

When we’re satisfied with the white highlights, we rinse out the white from the tube and continue with the three, this time using yellow again. We run quickly through the yellows in the orb, getting them as bright as we can without poking too many extra holes. Since each pass we’ve done in the process of tattooing has been nice and gentle, chances are we still have the leeway to make this final pass with yellow.

This is pure superstition, but I’ve found that yellow seems to appear brighter if we run through it quickly a second time, after we do our white highlights. This may be since the first pass of yellow ends up getting dulled slightly by the neutrality of the white (especially in designs where the white gradates into the yellow, like this one!) This may also be since the yellow has had a chance to bleed out for a few minutes while we’re doing the white highlights, which makes it easier to see holidays and inconsistencies in the color. At any rate, a quick second pass seems to brighten the yellow, without any real risk of staining the white.

This tattoo is done in two sessions, taking a total of eight hours. The first five-hour pass is adequate to call the piece finished, while the subsequent three hours gives us a chance to make the greens and oranges richer, refine the structure of the lightform and make another pass over the yellows and whites. This additional pass is a real bonus which adds extra life to the piece.
7.6) A Mental Checklist

While working, we don’t actually keep a checklist taped up nearby to make sure we’ve addressed our pos/neg relationships, all aspects of the dynamic range, used enough reserve, and so on. Many of these things will happen more or less automatically as we learn to create successful tattoo designs. At the same time, though, we don’t want these concerns to fall into the background and be neglected. So, while designing a tattoo, it’s good for us to occasionally back off and take a reality check. We look at the partly finished design on our drawing board, and ask ourselves:

1.) Does it fit the body right? Does it flow nicely?

2.) Which objects have the most priority, and which have the least? What graphic tools am I using to establish this order of priority?

3.) Am I creating a balance between dark and light, warm and cool, focus and out-of-focus?

4.) Are areas of detail balanced out by smooth, open areas?

5.) Are there enough large, open areas of dark and light that the piece will read clearly from a distance?

6.) Are all of my pos/neg relationships clear?

7.) How will the design break off into the open skin around it? Will this look attractive from a distance?

8.) How and where will I use lines, and of what weight? How about greylines and bloodlines?

9.) What means will I use to stencil the piece? Should this be an all-line stencil, or would a gradated or pos/neg stencil be more appropriate for part or all of it? Should it be drawn on, in part or in full?

10.) Most importantly, do I have a complete plan, from start to finish, before I even touch the skin?

Once we begin actually tattooing the piece, we have a different set of questions to occasionally ask ourselves. Once in a while, if we just mentally back off and look at the whole piece, then ask ourselves these questions, we can stay on top of things.
and make a better tattoo.

1.) How is my stretch? Can I feel the strike of the needle with my stretching hand?

2.) How is my visibility situation? Is enough needle visible? Is the machine spraying? What about light- is my hand casting a shadow on the piece?

3.) Am I making sure to address the larger forms of the piece, and not getting bogged down in detail that might clutter or hide these larger forms?

4.) Am I using a thin coat of lubricant on the area I’m working? Are other areas of the piece where I’m done for the time being lubed, to prevent scabbing? Are nearby light-colored areas protected from staining with lubricant?

5.) How’s my stretch?

6.) Am I using reserve where needed? What have I chosen in advance to reserve for the foreground? How about the background?

7.) How is my machine running? If it’s bogging down, will a quick dip in the rinse cup help? How about power- is it just right? Have I felt the armature bar lately? If it’s rough, could the rubber bands need tweaking?

8.) Is the ink flowing well from the tube? If not, is the tube tip trenched? Could there be lint stuck between the needles, or glued to the shaft?

9.) How’s my stretch?

10.) Am I sticking to the plan? Is the execution living up to the vision? If I’m making any changes in the plan as I go, are they for the better?

Whether it be in the design part of the process or in the execution, if we make a habit of occasionally checking in with ourselves and making sure we’re applying all of our skills, we stand a much better chance of consistently turning out the best work we can.

These are only model questions. You may already have ideas for questions that weren’t mentioned here. With time, you’ll develop your own customized mental checklist that will keep you out of trouble, help you find the most efficient way of doing things, and produce the best tattoos you’re capable of.
Part VII Review Questions

1.) What is the advantage of doing a value study before doing a color study? What kinds of tattooing situations might this be the most helpful in?

2.) When switching from a greywash to straight black, what precaution can we take to assure that the black isn’t diluted by water in the tube tip?

3.) How can we compensate for the natural fading that happens in the healing process, especially with grey washes?

4.) What’s a good transition color between purple and orange? How about pink and green?

5.) If we use a full range of colors in a foreground shape, how much range should we use in the background? How can we determine what background colors to use?

6.) What are some ways of strengthening the pos/neg relationship between a foreground object and the background? How do we technically go about doing this?

7.) What is a good approach to designing a tattoo for a bony and irregular body part?

8.) How can we use line quality to make part of a shape appear to stick into the foreground?

9.) What are some ways of using dynamic range to our advantage in a complex scene?

10.) What is a good drawing strategy for incorporating something complex into a larger drawing? Can you think of any others?
Part IX

Frequently Asked Questions

This book exists solely because of the demand for it. I have been encouraging internet Q&A, and plan on having an ongoing discussion posted at our site, www.hyperspacestudios.com. This section includes a short sampling of some recent questions and answers. If you see any especially interesting or pertinent information discussed at the site, please feel free to print it and include it as part of this book. And don’t be a stranger— we’re all quite interested in hearing your questions too.

Q. Photos

I’ve always had the crappiest time getting good photos of my work. The lighting in the shop doesn’t seem to lend itself well to photography, so I use a flash diffused with a bit of tissue which seems to work half the time.

I think the problem is my old camera and I was curious what kind you use, since your photos always seem to work out so well.

A.

Fact is, my photos don’t always work out well— I just only use the ones that do. I have done many major tattoos that I never could get good documentation of.

A lot of it has to do with lighting. Outdoor daytime photos are always preferable, but not always possible. When it’s overcast outside you should get good results if the sun is behind you and a dark area, such as a shaded doorway, is behind the tattoo; this area will appear as mostly black in the photo. If it’s sunny outside, have your client step into the shade of a building, with the tattoo just out of the range of the direct sunlight. This gives it the most possible ambient light without dealing with the glare of direct light. Then, for good measure, shoot a few out in direct light, although the ones shot in the shade are usually much clearer.

When I finish a piece in the evening, I try to get the client to return the next day while it’s light out, although I always shoot a few that night, just in case something comes up and they can’t make it. Next- day outdoor shots are the next...
best thing to healed photos.

If I have to shoot indoors, I make sure there are no bright lights shining on the tattoo, which will cause glare, and try to use only ambient light while I am focusing and composing the shot. I also make sure the piece is good and dry, which also reduces glare. I usually shoot some with and some without a piece of paper surgical tape over the flash, sometimes even with two pieces, just to cover all bases.

Part of the secret is to shoot a lot; for some major pieces, I'll use a whole roll, and minor pieces usually get 10 or 12 shots, all from slightly different angles or with variations of lighting and composition. If you shoot enough, you've got a better chance of having a winner.

If your shots are decent but just a little dark or a little washed out, I recommend learning Adobe Photoshop, which is one of the greatest image manipulation tools ever invented. In Photoshop there is a tool called Levels (also known as Color Space Compression) which brings the lights and darks to where you want them without altering the color; also, you can use Color Balance tools to adjust the shot if it turns out too yellow or too blue. As long as we resist the temptation to improve the tattoo, there's nothing wrong with improving the photos.

Oh yeah, almost forgot- I use a Canon Rebel... any of the Canon Eos series are good workhorse cameras. I also use Fuji 200 speed print film.

Q. Using a Manual Camera

I have been taking lousy photos. I've lost so many to "flash burn"... The two pieces of paper tape did the trick by reducing the light, but I still feel the color could be a bit richer. Where do you set your light meter indicator? In the middle of the "optimum" zone or all the way down to let in all the light? I have flourescent bulbs above and have turned off all extra lights pointing towards the client. I have a manual Pentax K-1000. Any more recommendations would be helpful...

A.

I have mixed luck with my photos. My best luck has been recently, using a mostly automatic camera.

Since your camera is manual, I would suggest doing a quick experiment. Try shooting a different roll of film for each of the basic different lighting situations you may shoot in—indoors with the flash, outdoors in bright sunlight, and outdoors on an overcast day. For each roll, try each f-stop, and several different shutter speeds for each f-stop. Write this info on a card that you hold up next to the tattoo that you're photographing, so that this information will be in the print itself. Try shooting
a tattoo on someone you work with—this is for experimental purposes, not documenta-
tion of a piece you'll never see again. When you get your prints back, you will have a
variety of shots of varying qualities, each with all pertinent information on a card right
there in the picture.

Another thing which may help is a polarizing filter. This is an inexpensive ($10-20)
item that screws onto the front of your lens. If you look through your camera at some-
thing with a lot of glare on it and slowly rotate your polarizing filter, at one point in the
rotation the glare will drop down to almost nothing. It manages to do this without
blocking any of the desired light, only that producing the glare.

This is tricky to use with a flash, since you don't see the glare from the flash while
you're looking through the camera; it only appears for an instant. You could do anoth-
er experiment where you shoot a 36-exposure roll of film of a tattoo on a glare-prone
area such as a shoulder. Each shot, rotate the filter another ten degrees. If you wrap
a piece of masking tape around the outside of the lens and make 36 marks, then hold
up a card in each photo with the number of that mark, you will see in the developed
roll exactly which mark the filter was turned to when you got the best results. You can
then make a more permanent mark with enamel on both the lens and the filter, so that
when you're using the flash, you'll know exactly where to turn it.

Q. Pigments

I am using Talenz for black and mostly Unique for my color. I am getting low on
some colors and am asking a couple of artists whose work I respect what they prefer
color-wise. I guess I am trying to figure out if there has been anything come out as
good if not better than Unique yet.

A.

I'm still using Unique for 75% of what I do— I can now see 11-year-old work I did
with it, and it's definitely standing the test of time. They can be reached at 817-276-
9222. However, this hasn't stopped me from playing around with Starbrite colors
(papillon@hwave.com). Many artists are using these colors with good results. The
yellow is particularly spectacular. Try also the bubblegum pink, lime green, orange,
red and yellow ochre. These colors are thinner in consistency than Unique (similar to
black) and can be used more readily for lining or detail work. However, I can't yet
vouch for its longevity- only time can do that.

Q. Needle Groups

Just wanted to ask a question about using different needles. The basics I use are
3,5&7s for lining purposes and 7,11&14 rounds for coloring and shading.
I don’t have much knowledge how to use flats or mags. I have heard of people lining with mags at a slight angle to get extra wide lines, is that possible? I have done all my coloring and shading with rounds. Do mags and flats push the ink in better? Are flats better for shading only or coloring too? Whenever I use a flat or mag do I proceed in a forward brushing motion? I know I can’t go in small circles- that will do some chewin! I learned that when I did some of my first pieces, so I quit using them and went to rounds.

A.

Are you happy with how your coloring looks when you use rounds? Some artists work quite successfully with them. Others have trouble with them, since the needles at the core of the group always have to pass through areas that the needles around the outside of the group have already passed over. Because of this, it can be difficult to achieve solid fields or smooth gradations with a large round.

Flats have their drawbacks too, since the needles are laid out in a straight line, almost like a little razor blade. It can be easy to accidentally leave all kinds of choppy little corner marks in an area that’s supposed to look smooth. It’s also hard to pack in solid black or color with a flat, since the layer of needles is so thin.

I have come to prefer magnums for shading and coloring, since they seem to create a good compromise between rounds and flats. They have the added advantage of having their needles spaced further apart than a round or a flat, which makes it easier to control the layering of color, allowing multiple passes without trauma. I am referring to a spread mag, basically a seven flat with a razor woven between the points before drawing the solder up, as opposed to a stacked mag, essentially a five flat and a four flat stacked on top of each other. Because a stacked mag is more densely packed, it’s easier to cause damage with it.

Using a spread mag, we want to work in overlapping ovals, overlapping forward brush motions and any other motion we want. Overlapping is an important part. A magnum is a versatile tool that can be used for almost any kind of job, including making fat lines, as you mentioned.

The chewing you experienced in those early tattoos may have had to do with the fact that you had so little experience at that time. Maybe the spring tension was way too high and the power cranked to maximum. I would recommend giving them another try.
good, mild soaps for cleaning tattoos. It's good to avoid soaps and lotions that contain lanolin or any perfumes or colors. I usually recommend Betadine H ointment, which is a clear cholesterol-based ointment, great for healing tattoos. Two or three very thin applications per day for three or four days, and very little after that.

If people continue to come back with healing problems, look to see if it's always the same color that it happens to. It could be a bad batch of color, or even a contaminated bottle causing infections. This is not unheard of. Usually, though, scabbing is a result of too much trauma, caused by overworking or running the machines too hard. This is the first thing I'd check.

Q. Needle Points

I have a question about needles. I have for a long time used needles with a long taper point (12/13), and that for everything, lining, shading, coloring...everything. Then I read in a tattoo supply catalogue where you could buy pre-made needles that they used long taper points needles just for the liners, and for the other needles for coloring and shading with they never used needles with a long taper point, and my question is why, I can't understand it.

I have heard that long taper points needles could cut in the skin like a knife when using them. I have never noticed such a thing; for lining they are just perfect in my point of view, simple to solder and the tightening procedure is easy, and they go into the skin really easily. I don't have to use a lot of power or anything like that. So in my point of view they don't cut the skin when lining. I have tried to line with other needles in the same size, but with a "regular" point, I found it very difficult compared to long taper points. First of all, they were very difficult to tighten, and then when I used them I had to use a lot of more power to get a nice line. In my eyes, it seems like the one that messed the skin up was the one with a regular point.

To come to the rest (coloring, shading), I found it much easier to, for example, make a solid tribal with long taper points. Like with the lining, I don't have to use a lot of power and in my eyes they go into the skin much easier than the one with a regular point. It's much easier to do solid black than with a regular point, where I feel like I have to work much harder to get the ink into the skin.

About shading, there I can't find any special difference. It looks like you can come to the same results no matter which kind of needles you use.

I understand that the regular points are more or less a standard amongst most tattoo artists for shading and coloring. So what have I missed? Could you get a better result when using standard points for coloring and shading compared to the long taper points, or will it get a better result over the years when the tattoo gets older, or?
A.

The common experience is that the regular point, which is not only blunter but also has a ridge where the point ends and the straight part of the shaft begins, has better ink-pushing qualities that a tapered point. Naturally, a blunter point requires slightly more power and possibly a small increase in spring tension, but only if your spring tension is already very light (you can feel the tension by pushing the armature bar towards the coils - the stiffer it is, the more tension you've got). This increase in power is what makes this type of needle more effective for putting in color.

You can take this a step further by using carbon-tipped needles, which are slightly textured and very good at pushing the pigment down into the skin. Since they aren't stainless, you have to dip them in mineral oil as soon as you finish soldering them to the bar, to keep them from rusting. Since they put the color in faster and easier than the stainless tapered needles, you don't have to pass over the skin as many times, and healing is often easier.

For fine lines and smooth grey shading, you may have more luck with tapered stainless needles. These needles put in less color, which gives you more control over your gradations. Lines done with these kinds of needles are less likely to blow out than lines done with carbon needles. On the other hand, they may be more prone to dropping out. Everything has its price.

Neither needle type is necessarily more prone to cutting the skin than the other. This is probably more dependent on the type of needle group, whether or not it's too tight, how much power is used, and whether your hand movements overlap in loops or slide back and forth on top of each other.

Any time you're trying a new needle type or group type, give the new setup a few tattoos to sink in before judging it. Any new tool will feel unfamiliar at first, making it hard to make the most of that tool's strong points. If you're going to try different things, try giving each of those things an opportunity to show you what it's capable of.

Q. Fading Color

The biggest source of concern in my tattooing is a tendency for colors to fade very shortly after healing. It's hard to objectively describe what's occurring, but I'll try. Looking at photographs of tattoos in the national magazines is inspiring and a little daunting. What are those folks doing that I'm not? The colors look rich, smooth, and even, with no holidays, and with very impressive gradients blending from one color to another. It looks as though the work was achieved with an airbrush rather than a tattoo machine.
I have been using Starbrite ink from Dermagraphics because artists whose work I admire are said to use it. I have a Mickey Sharpz Iron T-Dial machine, same deal, highly recommended. Also I’m using a double stack 13 needle flat shader, 7 on bottom, 6 on top, my logic being more needles in, more ink in efficiently. I’m trying to lay the ink in thoroughly, slowly, in those little wee circles as I was initially taught. I try not to hammer the skin too hard and find a happy medium where the ink is going in nice and easy without a lot of drippy bleeding.

Sometimes I watch a particular artist at work and I see a good deal of bleeding and blood beaded up and looking a bit drippy on the surface of the skin, to his credit he does seem to have less of a problem with fading than I do. He says he packs the skin pretty aggressively, knowing that most customers’ aftercare practices are remiss, and that fading is almost inevitable due to neglect. Still, I’m a little unsure about a more aggressive pounding of the skin, worried about scarring or making the skin heal a bit lumpy.

A.

Solid colors and smooth gradations are a combination of many elements working together- machines, needles, pigments, hand movements, spring tension, amount of power used and the stretch, just to name a few. Mickey Sharpz machines are solid workhorses and very reliable, but if the gap is too narrow or the spring tension wrong it won’t do the job. Make sure the machine is set up properly to drive a magnum, with a nickel’s worth of gap and just enough tension to pull the front spring against the contact screw.

Use good magnum tubes with a 45 degree bevel. Be sure that the tube tip fits the width of the magnum snugly, but not to the point of binding. If there’s any noticeable side-to-side play, you’ll lose precision. I recommend Papillon tubes, papillon@hwave.com.

The theory that more needles means more color goes in sounds great, but doesn’t necessarily help. When needles are packed too closely together, we have little chance to get an even coat of color in each area before the skin has reached its limit. This will especially hold us back if we’re trying to achieve airbrush-like gradations.

I recommend using spread mags instead of stacked mags, where you make a 7 flat, tack them with solder at the blunt end, and weave a razor between the points of the needles. You then draw the solder up to a quarter inch short of the points, then pull the razor out. With a little practice, you’ll be able to control the amount of spread between the two layers.

The advantage of using a spread magnum is that you can work over an
area several times with different shades of a color, creating smooth gradations. You can also easily saturate the skin with a color on the first pass if a solid field is desired, simply by slowing down and finding the right rhythm. This is easiest if there is plenty of needle hanging out, providing good visibility, and you have a good 3-point stretch (thumb, finger and the heel of your tattooing hand). You should be able to feel the needles striking the skin with your stretching fingers; if not, you don’t have enough of a stretch; the needles won’t penetrate properly and the quality of the color will be affected, especially after healing.

You don’t need to pound the skin. The brutal method will not actually help the look of the tattoo, since it makes it difficult to create subtle effects and could cause a hard heal. Slow down, work in an even rhythm, layer the color until the skin has a nice velvety saturation, and it should heal smoothly. If we saturate gently, the piece should heal easier, and less color should fall out.

Carbon-tipped needles are also helpful, since their textured points push color in better than stainless. The points of these needles need to be protected with mineral oil or petroleum jelly as soon as you’re done soldering them together.

You may enjoy doing some of your richer colors with a thicker, more opaque pigment, such as Unique (817-276-9222). These colors feel more like using oil paint, and may have better opacity because of the larger particles of pigment in them. You can dip your machine back and forth between different inks, even different brands, to get nice in-between colors, which help us to create smoother transitions.

I recommend practicing your coloring and gradations by doing tattoo drawings on either tracing paper or illustration board, using colored pencils (try Berol Prismacolors). The hand movements you’ll use with the colored pencils are very much like those you’ll use with a tattoo machine. This will help you to create a smooth look, which is just as important as good saturation.

Even with a lot of experience, it’s natural for some of the color to fall out. Keep in mind that much of the published work you see isn’t healed. A lot of the bigger healed work is done in multiple sessions, giving the artist a chance to work each area as many times as needed to get it to look right. With some practice, you’ll be able to create smooth gradations and even fields on a first pass. But perfection is another matter entirely.

Q. Healing
What is the best way to heal a tattoo?

I recommend the use of the product called “Tattoo Goo” because it does
seem to make a positive difference in healing speed and color retention. Its main ingredient is olive oil. Have you ever heard of anyone using plain old olive oil to heal a tattoo? I’m curious, but I hesitate to try it out or recommend it. On the other hand I’d like to offer an inexpensive and effective alternative to the petroleum based products, (A&D, Bacitracin, etc.) the buzz is that these formerly tried and true ointments may well be draining color from healing skin.

A.

In my experience, the less we mess with a tattoo, the better it heals. The body is naturally very experienced at healing and can do it with very little help from us.

It has been classically recommended that we use an antibiotic ointment for healing. Many people seem inclined to really gloop the stuff on, which can indeed draw out the color, and creates a sticky surface for foreign matter to attach itself to, largely negating its germ-killing effects.

Antibiotics are really only necessary when there is a risk of infection. If you’re cleaning the tattoo thoroughly with a mild soap a couple times a day until it forms a light layer of scab, it shouldn’t be very infection-prone. If it’s in an area where sweat drains, such as the stomach, the back of the neck or the ankle, it may be good to use an antibiotic such as Betadine H for healing. This ointment is cholesterol-based instead of petroleum-based, making it less sticky and a nicer consistency in general. Apply it in very thin coats and blot off all excess. If your clothing sticks to it, there’s too much.

If you’re not using antibiotic ointment and the tattoo needs moisture, try something really benign like 100% pure cocoa butter. Tattoo Goo might also be good- I have no experience with it, but I’ve heard good things. Apparently it comes in a small round tin, making it easier to carry and making the client more inclined to have it with them and use it.

Q. Sensitive Areas

I wondered if you have any good idea how to handle the skin on those more sensitive areas, i.e. the inside of the elbow joint/lower arm, the shoulder just above the armpit skinfold, the back of the neck/uppermost spine area, …do you know what I mean?

A.

These kind of areas can be especially tricky in tattoos that span over several skin types, where part of the piece is on tough skin and part is on delicate skin. The thing
to do in a case like this is to outline the whole piece, making sure to turn down the machine when working the sensitive zones, and then work the piece to completion or almost-completion in sections, starting with the tender area (just to get it over with).

You’ll want to keep your machines running as lightly as possible in these areas. Since the skin is thinner and softer, it takes less power to put in the color. It’s also easy to scar these areas of blow out lines and edges. Start with your machines running way too slow, and add power gradually until it’s putting the color in. This way, there’s no risk of pounding the skin too hard. Work with the machines in smooth, even overlapping ovals, since the smoothness is easier on the skin and less irritating for the client.

This is way too little power to use in the other, tougher areas of skin. That’s why you want to work these areas separately, since the right amount of power for the tougher parts will be too much for the tender areas, and vice-versa. It’s good to avoid having to constantly re-adjust the power. Plus, the tender zone will feel best in the long run if you get it out of the way early in the session.

More so than with other types of skin, you need to be sure not to enter the skin at too great an angle with your needles. The angle between the skin and the tube should be a minimum of forty-five degrees. Any less, and you risk slicing this delicate skin.

Be sure to use a light layer of petroleum jelly on the area you’re about to work, which makes it easier to clean up excess pigment without having to scrub the skin, which can get quite irritating later in the session. When the sensitive areas are finished and you’re working near them in tougher zones, keep plenty of petroleum jelly on the finished area to protect it from stray gobs of pigment, which would later have to be painfully scrubbed off. You can even cover it with a paper towel while you’re working nearby, eliminating the need to clean it almost entirely.

Q. Working With White

I have noticed that whenever I work with white, regardless of what kind of needle I’m using, I get a grey spot in my ink cap every time I dip. I pack the white in carefully, but it usually seems to heal a little muted, not at all like the brilliant highlights I see in the magazines. How can I get my highlights to look bright and crisp?

A.

There’s basically no such thing as a perfectly clean tube. Even a tube that’s straight out of the package, which was rinsed, cleaned in an ultrasound, scrubbed and autoclaved will have a tiny bit of residual pigment left in it. Usually this doesn’t affect
us, since it’s such a small amount that the colors we’re working with will normally overwhelm it. But white is a different story.

White isn’t actually a color at all, but a neutral colorless pigment. It is mostly translucent, with just enough opacity to lighten the skin a shade or two. If there’s even the slightest amount of residual pigment in the tube, this delicate translucency will be visibly stained, and even the slightest stain will mute the effect of the highlights. Once we put a stained white into the skin, even a later session with perfectly clean white will have only a partial effect on making it right.

While we’re working with white, each time we dip the grey stain will sometimes get darker, and the longer we work with each tubeful of pigment, the more stained the white coming out of it will be.

To avoid this, we rinse in clean water frequently and thoroughly. I like to work with two rinse cups; one of them is the pre-rinse cup, the other one is the after-rinse cup. Using this system, after 4 or 5 hours, the pre-rinse cup will be a dark muddy brown while the other one is still relatively clean. When you’re ready to start the white, if you don’t have a rinse cup of clean or almost-clean water, take a short break and get yourself one.

Rinse the tube thoroughly with the machine running, blot out most of the water on a dry part of a paper towel, then dip in the white ink. Pull the tube tip out of the ink cap, run it for a short burst, and dip again. The machine will probably slow down a bit at this point from the thickness of the pigment, and you’ll sometimes have to turn up the power a small amount to compensate.

Go ahead and work for a few moments. Don’t work until the tube is empty, since the last white pigment to come out will be stained. When you’re ready to dip again, though, rinse first. This will sluice out any of the stained white left in the tube tip before you dip into the clean white. It also will keep the machine from bogging down too much from the thickness of the pigment.

Next, blot the tube tip dry and dip in the ink, run the machine for a short burst, dip again, then proceed to work. Repeat the process each time: Work, rinse, blot dip, work, rinse, blot, dip. The rinse in each cycle ensures that the white will be as pure as possible, with the bonus of helping to keep the machine running smoothly. This is sometimes also a good idea with yellow or light orange, especially if it’s right after working with a dark color using the same tube.

Some artists like to use a thinner consistency of white, which is easier to put in. The conservative part of me is afraid these smaller particles will have less opaci-
ty and reflectivity than the larger flakes found in Unique colors and many more traditional flake powder pigments, although there's no proof of that.

No matter how clean your pigment is, your white highlights won't be very effective unless they're planned properly. Use them strategically, not throughout the whole tattoo, which tends to cancel them out. Sharp-edged highlights tend to appear brighter than soft-edged ones. Areas of dark or medium color around them will make them appear sharper and make them glisten, while placing them in an area of all light colors might make them less effective.

Q. Grey Washes
Since you're in the mood to answer questions, what would you say the best ink/water ratio is for greywash?

A.

That all depends on the effect you're going for. The more water you add, the lighter the wash. Grey wash work usually looks best if we use the full range of contrast, including areas of solid black, greys so light they're barely there, and everything in between. The portrait work of artists such as Jack Rudy, Brian Everett and Tom Renshaw are good examples of the full use of value range. Filip Leu's black and grey work usually incorporates large areas of long gradations from black to skin, using every tone in between, then smaller detailed areas of various values, which is a very effective strategy for differentiating foreground from background.

Since I am rarely asked to do greywash work, I usually mix my washes in the cap for each tattoo. If I did it more frequently, I'd mix bottles of various strengths: one that was 100% black, then a 50%, 25%, 10% and 5%. In the cap, I usually fill one halfway, put about ten drops in another and only two in a third cap, then top them off with water. I also keep a rinse cup of clear water handy.

We can achieve the full range of grey by dipping between the caps. If we dip in the straight black, run the machine, then dip in the 50% cap and then run it, we'll get an approximate 75% wash in our tube tip. At the same time, we'll leave a trace of black in the 50% cap, so it becomes a 51% mix. If we start tattooing and the wash seems a little dark, we can either move to a darker area of the design or we can dip in the rinse cup or a lighter wash to create a lighter value in our tube tip.

We can then dip back and forth as much as we like to get any effect we need. In theory we can accomplish this with just black and a rinse cup, but this process will eventually dilute the black in the cap and limit what we can do. The range of several washes in our ink caps makes it a more convenient and intuitive process.
To keep from getting confused, it's good to always lay our ink caps of washes out in the same order; for example, with straight black at the far right, the next darkest value to the left of it, and so on to the lightest wash on the far left. After all, they look identical in the cap.

For many years I've used Talenz black (inkguana.com) with much success, for solid black, grey washes and color work with black shading (I've even dipped back and forth between Talenz and colored pigments to get muted colors). It seems to last well, as time has attested.

Some folks seem to like using bug pin magnums for grey washes, since they push in less pigment and allow more control. If you choose to use these, you will need a narrower tube tip, since these pins are of a smaller diameter and make for smaller mags. You may actually find that a nine mag of bug pins fits in a tube that normally is used for a seven mag. You may also find that a machine that normally is ideal for driving a seven mag is perfect for a bug pin nine mag, since these smaller, smoother needles produce less resistance. However, they would slow you down enormously for putting in color.
Of The Moog series. Some of this material bridges between the mellow and medium categories.

System Seven also bridge these two categories; my favorite of theirs is a double disk called 777: \textit{Fire and Water}.

In the medium category:

One of my all-time favorite groups to tattoo to is The Orb. Their stuff seems to go over very well in the tattoo environment. I'd especially recommend \textit{Orblivion, Orbus Terratum, UFOrb}, \textit{Live 1993, Adventures Beyond the Ultraworld} and \textit{Pomme Fritz}.

Future Sound of London are an experimental electronic group with punk rock roots. Their music tends to have more variety than most electronic bands. Some favorites are \textit{Lifeforms, ISDN} and \textit{Dead Cities}.

Loop Guru, like FSOL, are primarily collage artists with sound; their music is very creative and unexpected. Some releases of theirs are \textit{Catalogue of Desires, Fountains of Paradise} and \textit{Amrita}.

Banco de Gaia make some very powerful and uplifting music. Although their newest CD, Igizeh, tends a little towards sounding commercial, it's still good, but I'd especially recommend \textit{Last Train to Lhasa, Big Men Cry} and \textit{The Magical Sounds of Banco de Gaia}.

Richie Hawtin (AKA Plastikman) is an experimental musician/DJ with a whole variety of interesting music out. Much of it tends towards the minimalistic, and can be an acquired taste, but it's dynamite stuff. I'd recommend \textit{Live At The Windsor Building, Ontario}.

A lot of electronic music is available on compilations. Here are some to check out: \textit{Hypnotic Records/ The Door of Perception, Caroline Records/ Excursions in Ambience (This is a series of five or six disks, all of them good), Twisted Records/ Eclipse: A Journey of Permanence and Impermanence, Planet Dog Records/ Feed Your Head, and Law and Auder Records/ Further East: Westercisms}, which is an excellent all-around series.

In the High-Energy category:

A lot of this stuff is almost too much for your average tattoo clients. I enjoy this fast stuff when painting, exercising and tattooing people with similar tastes. Because of this, I haven't listed any of it in boldface; if you're inclined towards listening to fast electronic music, you can judge for yourself how well you think it would go over in the tattoo shop.

GoaCore is a whole category of hard techno, fast-paced without any of those 'happy&gay' melodies we associate with some of the cheezier techno. The types of sounds used are coarse and deep, reminiscent of electric guitar. Some folks who like thrash metal actually really enjoy Goa. Hypnotic Records carries a lot of this stuff, such as Goa Spaceship 101 or their double Goa Mix disk. If you enjoy either of these, you'd probably like most GoaCore.

Some other fast electronic recommendations: Euromedia Records/ Tantrance (a double disk), Moonshine records/ HardDesertTrance, and anything by Astral Projection.

Sometimes I get into a totally different mood and feel like listening to classical music. I've gone through periods where I've explored classical music intensively and found that in the midst of a lot of
Appendix D
A Brief Music Playlist

I am including this information with the intention of hopefully opening a few doors. I believe that the music we choose to listen to is not only about who we are and how we feel, but also about what we want and how we'd like to feel. If we are frustrated with life and listen to music about being frustrated, that will only perpetuate that feeling. Almost everything listed here has no lyrics, since the 'yelling dude' is only there to tell us about how HE feels and what HE thinks, which can be limiting to our minds.

Good creative music is that which gets us relaxed without putting us to sleep or gets us energized without throwing us into a rage. It should reward attention without demanding it, and the 'yelling dude' is all about demanding attention. I mean no offense to rock and roll fans here; I am simply offering some alternatives.

Not all good creative music is necessarily appropriate for the tattoo shop environment; some is just too calm and mellow to survive through the buzzing of a machine; some is too varied and goes all over the place stylistically, which can be distracting for the person getting tattooed, and some is just too far-out for the average tattoo client, which can make them uncomfortable. With this in mind, I have marked certain selections in **boldface** which I think are good all-around tattoo shop music. This does not necessarily have any bearing on how high-quality I think each selection is.

Some of the most accessible lyric-free music to offer a rock-and-roll clientele is that which is done with the traditional rock instrumentation, using guitars and such, sometimes with electronic synthesizers thrown in. **Tortoise, Ozric Tentacles** and **Gone** are good examples of singerless bands. Unfortunately, rock bands who have chosen to forego the yelling dude are few and far between.

Much of my favorite creative music is in the **ambient** category; a lot of this is either electronically generated, collaged together cleverly from sampled sound bits, or some combination of the two, often in conjunction with actual instrumentation. This makes for a large category, so I've divided it into three sections: mellow, moderate and fast-paced.

In the mellow category:

Steve Roach- a mixture of percussion instruments and electronic synthesizers, some very open and quiet, some more rythym-oriented. I like to describe his music as 'organic tribal'. He has dozens of releases available. For starters, try out **Suspended Memories Forgotten Gods, Body Electric, The Serpent's Lair, Dreaming: A Retrospective**, Light Fantastic, Halcyon Days, Cavern of Sirens, Vine Bark & Spore. (On a side note, my wife and I have done some cover art for Steve). Look him up at steveroach.com.

Brian Eno has always been an important pioneer in ambient music. Two selections of his I'd recommend are Ambient 4/On Land and The Shutov Assembly.

The Fax label carries lots of good ambient stuff; **Air 1&2, Sad World 1&2**, and any of the Dark Side
(Fig. C12). Because this image contains angled facets with light playing over them, it is possible to give our mandalas extra solidity and dimension (Fig. C13, C14).

This method could be used on all kinds of architecture, such as Gothic, Mayan or Art Deco. The different possibilities are endless. For the especially computer-literate, there is the option of using a 3D modeling program to create a sample of much more exotic architectural elements, then multiply them in a program like Terazzo.

For those folks without computers, there's no reason not to use the snowflake method, and simply trace a section of architecture into our wedge, and then flip and trace it manually. The computer allows for the exploration of more different possibilities, but the hand tracing method could potentially allow for more sublety and control.
The final mandala we choose is one that is clear and readable, with a balance of detail to smoothness, chosen for its tattooability (Fig. C10). Using Photoshop, we use Image>Mode to make a greyscale image, pump up the Levels, and optimize the pos/neg areas using the Dodge and Burn tools, making the image easy to stencil. Since this mandala is going on an asymmetrical body part, we first draw on a foreground framework that fits the flow of the arm, then size the mandala image to an appropriate scale for the opening in that frame before running it through the hecto machine.

The finished tattoo (Fig. C11) is handled by first outlining the foreground framework before stenciling the mandala. This allows us to carefully build up the lines, spending plenty of time with the black without worrying about either wiping off the mandala stencil or risking staining the delicate color work we use to commit the mandala stencil to skin. When we are satisfied with the linework and the black shading we use in the foreground, we take a ten minute break to allow these areas to stop bleeding; we then use the one-shot stencil method to lay down the mandala stencil. We then work through the mandala carefully with the three, five round and seven mag to commit this design to skin, approaching it from a pos/neg standpoint as opposed to a linear standpoint.

We can create 3-dimensional angular faceted mandalas, such as the one we made using the snowflake method, by using these kinds of Photoshop filters on photos of faceted architectural elements, such as this example of Moorish architecture
by making a wedge that’s 30 degrees at its center point, using a protractor to get it accurate. After drawing a wedge-shaped design in this section, the process is essentially the same as it is for the eight-way mandala, except with fewer steps. For ten-way symmetry, the wedge needs to be 18 degrees at the center. Basically, to figure out the angle we need, we take the number 360, divide it by the number of points we want, then divide the final sum by two.

In Chapter 5.3 we discussed the use of a Photoshop filter to create a mandala, as shown in (Fig. 5.3.ZB). These filters can be applied to any image with exciting results.

In (Fig. C9) we have a painting of mine. I chose this image to apply the filter to because it has interesting strong patterns of dark and light, different planes with light playing off them, and a dynamic balance of rough textures contrasted against smooth areas. We use Terrazzo, which gives an option of different numbers of points and styles of symmetry, although it doesn’t have every major configuration. It can be necessary to collect a number of Photoshop filters to have access to all the options we need.

In this case, the program was set to a six-way symmetry, which can be a very attractive arrangement. This program allows us to drag a triangle around in our source image. We can adjust the size of the triangle, but we need to rotate the source image separately in order to tilt the triangle. This triangle represents the wedge-shaped drawing that we did using the snowflake method; the program automatically doubles up our wedge-shaped image, like we did on paper in (Fig. C4), then multiplies it six times, creating a mandala in a preview window. It does this in real time, allowing us to explore countless thousands of combinations in mere moments. This process can be very exciting, especially after the labor-consuming process of the snowflake method.
This process is very similar to the one we used to make simple paper snowflakes as children. The main differences are the requirement for much greater accuracy in the folding, and the fact that we’re creating a line drawing rather than the simple pos/neg design we get by cutting out chunks of paper with scizzors. With our line drawing finished, we need to figure out how to shade the planes and angles in the image, keeping it consistent all the way around (Fig. C7).

The snowflake mandalas we’ve just discussed have an eight-way, or octilateral symmetry. If we fold the paper into eighth instead of sixteenths, we can create a four-way, or quadrilateral symmetry, like in (Fig. C8). Since the wider wedges of quadrilateral symmetry gives us more room to play with than octilateral symmetry, this gives us more room to arrange the planes of the wedge-shaped drawing in such a way to create an illusion of depth and dimension.

Using this paper-folding method, it’s a little trickier to create types of symmetry that aren’t a multiple of four (eight-way, sixteen-way, etc.). To create six-way symmetry, we begin
curves, it's possible to develop a unique language for this. An arrangement of lines that looks disappointingly simplistic in wedge form may very well appear dazzlingly intricate when it's multiplied with itself sixteen times.

Next, we flatten out our folded up wedge as thoroughly as possible, smoothing the creases to the point where the sheet will lay flat on the table. We then tape it in place over our wedge-shaped drawing, carefully aligning the center of the drawing where the compass point was. After carefully tracing it, we untape the small drawing, flip it over, line it up carefully with the tracing we've just made on the larger sheet, then trace it again. We now have one-eighth of our finished mandala (Fig. C4).

We then fold the drawing over on itself, creasing it along the edge of the finished eighth, and retrace it. After unfolding it, we have a finished quarter (Fig. C5). Repeating this again, we end up with a half design; one final repetition gives us a finished mandala (Fig. C6). It is much less time-consuming to do it this way than by tracing that small wedge-shaped drawing sixteen times.
Appendix C
Creating a Geometric Mandala

A *mandala* is a contemplative image used in many spiritual practices and cultures. It normally consists of a round or symmetrical field of imagery with some type of center; on a linguistic level, the center represents divine understanding, the center of the universe, or any type of energetic center; usually the rest of the imagery is designed to guide the viewer into the center. This kind of image will generally have a very positive and uplifting feeling associated with it.

Graphically speaking, mandalas can be very visually striking, which makes them especially appropriate for certain kinds of tattooing. Their distinctive central symmetry can add a lot of power and light to a composition. For this purpose, the kinds of mandalas we'll discuss here are not derived from any specific cultural language, and are instead chosen for their visual power and tattooability.

The most basic type of mandala we'll discuss here is the *snowflake mandala*, such as the one in the background of (Fig. C1). This style of mandala can be easily drawn without a computer. We begin by selecting a sheet of tracing paper slightly larger than the size of mandala we want, then using a compass to establish the snowflake's outermost edge. Next, we fold this sheet in half, with the crease passing as accurately as possible through the circle's center. We then fold it in half three more times, creasing the folds tightly each time, until we have a narrow wedge one-sixteenth of the circle's circumference.

The next step is to lay this wedge on another sheet of tracing paper and trace the shape of the wedge, making sure to keep its proportions as accurate as possible (Fig. C2). Within this wedge-shaped tracing, we then draw one-sixteenth of the mandala (Fig. C3). By experimenting with random combinations of radiating planes, points and

*Fig. C1*
These same lighting variables apply in the case of a more complex object (Fig. B19). Since the process of shading a faceted object correctly sometimes involves a certain amount of trial-and-error, especially at first, I recommend doing a value study in erasable pencil before tattooing such things. While doing this study, we consider the relationship between each adjoining object, ask ourselves which facet is facing more towards the light, and give the edge of that facet a neg on pos relationship with the other facet. If we consider this carefully through the entire object, we can create a convincing sense of solidity and dimensionality, which is a great effect in tattooing, whether it be an architectural object or an abstract one (Fig. B20).
If we bring the pitch back to the edge of the shape like in (Fig. B9) and adjust the rotation so that it strikes two facets equally, we get that white line between them like we did in (Fig. B4), with gentle gradations that support that white line without making the neighboring facets too dark (Fig. B15). If we adjust the pitch and rotation so that the light strikes a number of facets equally, we end up with a few white lines converging on a white point (Fig. B16).

Another factor we can work with is the sharpness of the light source. If we make the light source soft and ambient, we end up with more light striking the facets, and less shadow (Fig. B17). On the other hand, if we make the source sharper and more concentrated, we have fewer brightly lit facets and more shadow (Fig. B18).

Now, with these three variables to play with, visualize this simple gemstone in your mind’s eye with the pitch, rotation and sharpness moving through all different combinations of these variables; watch the light show behind your closed eyelids as the light source moves around, changes color and intensity, first soft, then gradually sharpening. Rotate the object in the virtual space of your imagination as you would rotate a real object in your hands; watch the patterns of light and dark change on the object’s surface, occasionally glinting as a facet momentarily catches the light source head-on. Your brain has the computing capacity of a billion Pentium processors; you easily have the ability to create a crystal-clear visualization of this simple faceted object.
Now let's consider a more complex faceted object. The gemstone in (Fig. B6) has three distinct levels: (1) a flat face, (2) an intermediate angled level, and (3) a third level, which is angled away from the flat face the most (Fig. B7). To account for the lighting on all 3 levels, we must consider the light source's pitch (Fig. B8) as well as its rotation (Fig. B9). Thus, when the light source is striking the edge of the gemstone (Fig. B10) the lightest facet will be in level 3 (Fig. B11). With the pitch closer to the viewer's point of view, the second level ends up having the lightest facet (Fig. B12, B13). If we bring the pitch and rotation straight to the center, so that the viewer's point of view is the light source, the flat face is the lightest facet and the remaining facets are shaded equally and symmetrically (Fig. B14). In all cases where there is one facet catching the most light, that facet will have neg on pos relationships with all of its neighboring facets.
Appendix B
Shading a Faceted Object

When we use a computer to create solid objects in virtual space, the lighting and shadow on the object are simulated using a process called ray tracing, where a light source is mathematically generated and played over the object, creating a convincing illusion of light and shadow. We can use this same process in our own brains to simulate light and shadow on simple objects. This is especially true in the case of faceted objects, which are made of simple planes arranged in clearly understandable relationships with each other.

Let's start with a basic cube, with only three sides visible at any given time (Fig. B1). If the light source is to the upper right of the cube, it's easy to figure out that the top will have the most light hitting it, the right side the second most, and the left side the least (Fig. B2). If this same light source is moved down and to the right to a point where more light is playing over the right side than the top, the relationship of the shaded planes changes (Fig. B3). At one point in its journey from the upper right to the lower right the light will strike the top and right sides equally, creating a thin highlight along the edge between the two planes (Fig. B4).

In order to make the relationships between the adjoining facets crystal clear, we use subtle gradations within each facet that help clarify the pos/neg relationships of each edge. The only pos/pos or neg/neg relationships we allow are in the case of light hitting two adjoining facets equally, as in (Fig. B4), or two facets facing away from a light source equally, as in (Fig. B5).
sonally vouch for. They can be reached at 817-276-9222.

Some newer colors are even brighter and more exciting, although their longevity is not yet as thoroughly proven. One of the most popular of these are Starbrite colors, which are of a watery consistency and really fly in. Tattooists who are accustomed to working with thicker pigments may need to learn a new rhythm to be able to put these colors in smoothly. Starbrite colors can be purchased through Papillon, listed earlier in this appendix, or Dermagraphics, 629 Rt. 9, Unit 7, Lanoka Harbor, NJ 08734, 800-809-8282, dermagraphics.com. Try both resellers for the best prices and availability. Dermagraphics also sell good premade needles.

Mario Barth has recently been selling a promising line of pigments called Intenze colors. He is in the process of trying different thicknesses and color combinations and asking for feedback from artists who use it. I am impressed with the ones I have tried so far. You can reach him at starlighttattoo.com, 201-797-7858, or the Intenze Products line, 201-888-4343.

For black, I use Talenz Drawing Ink, inguana.com.

A good manufacturer of power units is Frank Bianco of Eagle 1 Tattoo Equipment, eagle1tattoo.com, 248-852-1320. This includes models which have multiple switches for more than one setup. These units are well respected and used by many top-name artists.

Sustain, Prepcaïne and other numbing products are available through Face & Body Professionals, 415-884-4654, face-body.com.

A few good general tattoo supply businesses are Lucky's Supplies, (727)531-7709, luckys@tampabay.rr.com; Precision Tattoo Supply, 520-750-1595, presentationtattoo.com; and Eikon Device, 800-427-8198, eikondevice.com. Eikon have performed some interesting experiments with things like needle points and armature bars. They've published reports on these experiments and sell some unique products as a result, such as funny-shaped armature bars. Definitely worth checking out.

Some good reference books to look into are: anything by Burne Hogarth, such as Dynamic Anatomy, Drawing Dynamic Hands, Dynamic Light & Shade, and Dynamic Wrinkles & Drapery; he's done many more besides these, all of them very helpful. Hogarth was truly a great artist and teacher (Watson Guptill Press). Grey's Anatomy is the classic all-around anatomical reference book, thick and authoritative. Jeno Barcsay's Anatomy for the Artist approaches this subject from an artistic point of view, showing body parts in various positions, including tricky foreshortened ones (Barnes & Noble). Joseph Sheppard's Drawing the Living Figure shows many different poses,
sonally vouch for. They can be reached at 817-276-9222.

Some newer colors are even brighter and more exciting, although their longevity is not yet as thoroughly proven. One of the most popular of these are Starbrite colors, which are of a watery consistency and really fly in. Tattooists who are accustomed to working with thicker pigments may need to learn a new rhythm to be able to put these colors in smoothly. Starbrite colors can be purchased through Papillon, listed earlier in this appendix, or Dermographics, 629 Rt. 9, Unit7, Lanoka Harbor, NJ 08734, 800-809-8282, dermographics.com. Try both resellers for the best prices and availability. Dermographics also sell good premade needles.

Mario Barth has recently been selling a promising line of pigments called Intenze colors. He is in the process of trying different thicknesses and color combinations and asking for feedback from artists who use it. I am impressed with the ones I have tried so far. You can reach him at starlighttattoo.com, 201-797-7858, or the Intenze Products line, 201-888-4343.

For black, I use Talenz Drawing Ink, inguana.com.

A good manufacturer of power units is Frank Bianco of Eagle 1 Tattoo Equipment, eagle1tattoo.com, 248-852-1320. This includes models which have multiple switches for more than one setup. These units are well respected and used by many top-name artists.

Sustaine, Prepcaine and other numbing products are available through Face&Body Professionals, 415-884-4654, face-body.com.

A few good general tattoo supply businesses are Lucky's Supplies, (727)531-7709, luckys@tampabay.rr.com; Precision Tattoo Supply, 520-750-1595, precisionsketch.com; and Eikon Device, 800-427-8198, eikondevice.com. Eikon have performed some interesting experiments with things like needle points and armature bars. They've published reports on these experiments and sell some unique products as a result, such as funny-shaped armature bars. Definitely worth checking out.

Some good reference books to look into are: anything by Burne Hogarth, such as Dynamic Anatomy, Drawing Dynamic Hands, Dynamic Light & Shade, and Dynamic Wrinkles & Drapery; he's done many more besides these, all of them very helpful. Hogarth was truly a great artist and teacher (Watson Guptill Press). Grey's Anatomy is the classic all-around anatomical reference book, thick and authoritative. Jeno Barcsay's Anatomy for the Artist approaches this subject from an artistic point of view, showing body parts in various positions, including tricky foreshortened ones (Barnes & Noble). Joseph Sheppard's Drawing the Living Figure shows many different poses,
Appendix A
Some Brand Names

I’d like to begin by saying that this section of the book is totally unsolicited, and that I am listing these products and their contact info for your convenience, not as part of a sales gimmick. I can’t necessarily say that these are the best products out there, since I haven’t tried everything available; indeed, I’m sure this section will expand and change with future editions. For now, though, these are products that I have found to be instrumental in improving the ease and quality of my tattooing.

Machines: For close to a decade I have regularly used Mickey Sharpz irons as my everyday workhorse machines. The ones I recommend the most are the Micro dial for driving a three and the Paul Rogers style for magnums. These are reasonably priced machines in the $2-300 range. In the U.S. you can get them through RJM tattoo machines, PO Box 1414, Redondo Beach CA, 90278; Ph# 310-567-8439, fax 310-374-0152. Their web site is mickeysharpzusa.com. You can also phone Mickey Sharpz Manufacturing in England at 011-44-121-449-3799.

I have recently been very impressed by the Eclipse machine by Jason Guy at Next Generation Tattoo Machines, ngtattoomachines.com. This machine comes in brass, steel or aircraft aluminum. I was formerly of the I-hate-aluminum-machines school, but because of this machine, that situation has changed. I recommend all three types. Mine are set up for driving a five round or five mag. He can also be reached at 909-243-6507.

Tubes: Good tubes are as important as good machines. My favorites recently have been from Papillon Studio Supply and Mfg, papillon@hwave.com, 118 Pearl St, Enfield CT 06082, 860-745-9270. They sell a really nice quality grip, including different sizes of tapered grips. I am especially impressed by their fat tapered grips. The tube and tip are of equally high quality. Round tubes require beveling.

Needles: For many years I have used needles from the Colonial Needle Company. This company does not offer premade needle groups. For threes and five rounds I use the stainless John James Serpentine #12 long tapers; for magnums, the Hemming Phoenix #12 standard taper carbons.

Pigments: For most of my career I have used Unique colors, which are a homogenized blend of large-particle flake powder pigments and small-particle acrylic colors. This combo seems to make for easy-to-apply bright colors whose longevity I can per-
commercial and mainstream classical is a small selection of more intense music that really inspires me. Because this kind of music generally will not have an even rhythm and kind of races all over the place, first fast, then slow, loud then quiet, I tend to avoid playing it in tattoo situations.

My very favorite composer is Dimitri Shostakovich. A good piece to start with by him is Symphony #10 (try to find the version on London Records with Lutoslawski’s Musique Funebre). Like most of his music, this piece is dark, brooding and potent. If you like it, also try out Symphony #4 (RCA records, Leonard Slatkin conducting), #7 (Deutsche Grammaphon records, Leonord Bernstein conducting) and #15 (Erato Records, Kurt Sanderling conducting). When it comes to symphonies and other complex instrumental pieces, the version and conductor can be very important, since some conductors really understand the piece in question, while others just don’t. I also recommend all of Shostakovich’s string quartets, and if you like piano music, his Preludes & Fugues.

Philip Glass is a brilliant conceptual modern composer. Some of you may remember him being parodied in the South Park Christmas episode (the one with Mr. Hanky). Don’t let this fool you, some of his stuff is quite good. My favorite is Itaipu, which is a climactic orchestral & choral piece. He’s also done a very nice contemplative solo piano disk, and written some great quartets- check out The Chronos Quartet Performs Philip Glass. For that matter, check out anything that Chronos has done- they’ve got good taste in their selections. Early Music is a fantastic disk of theirs.

Another contemporary composer worth a listen is Arvo Part. His stuff is very moody and intense, occasionally erupting into brilliant transcendence. My personal favorite is Te Deum.

If anyone is interested in any other musical suggestions, or has any to offer me, go ahead and drop me an email: guy@hyperspacestudios.com.